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USER NON-DISCLOSURE AND LICENSE AGREEMENT

Important:  This Agreement must be read before proceeding with any Northern
Computers, Inc. software. By installing this software you agree to the terms of this
agreement.

Important:  This software is a proprietary product of Northern Computers, Inc. It is
protected by copyright and trade secret laws. It is licensed (NOT SOLD) for use on a
single computer system, and is licensed only on the condition that you agree to this
USER NON-DISCLOSURE AND LICENSE AGREEMENT.

Please Read This Agreement Carefully.

If you do not agree to the terms contained in this agreement, please return the sealed
software envelope UNOPENED to your supplier, along with any associated manuals
and/or other documentation. If you agree to the terms contained in this Agreement,
proceed with the installation and registration of the software by calling 1-888-323-
4576 between 7:00am and 6:00pm (CST).

In consideration of and upon receipt of payment of a license fee by you, Northern
Computers, Inc., grants to you a non-exclusive license to use this software and any
associated manuals and/or other documentation furnished herewith (together referred
to herein as “SOFTWARE”) under the following terms and conditions.

Should you elect not to assume the obligations of this agreement, DO NOT BREAK
THE SEAL ON THE SOFTWARE ENVELOPE. Return the software and any associ-
ated manuals and/or other documentation to the supplier for refund or credit. If you
are unsuccessful in obtaining a refund or credit, please contact Northern Computers,
Inc. at 5007 S. Howell Ave., Milwaukee, WI 53207. NO REFUND OR CREDIT
WILL BE GIVEN ON ANY SOFTWARE PACKAGE ON WHICH THE SOFT-
WARE ENVELOPE SEAL HAS BEEN BROKEN.

You shall not provide or disclose or otherwise make available the SOFTWARE or any
portion thereof in any form to any third party. You shall be obligated to retain in
confidence the SOFTWARE, except for any published user manual(s) you may have
received from Northern Computers, Inc. and except for SOFTWARE information

Navigating this document
Use the Bookmarks on the left or the links in Contents, located at the end of this document, to move to  the desired location. Also note, the Index matches the page numbers in this document. Use  the GO TO feature in the VIEW menu to move quickly to the desired page. 
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which is publicly known, or lawful received from a third party, or known by you prior
to the date you received the SOFTWARE.

You shall not have the right to print, copy or reproduce, in whole or in part, in any
form whatever, the SOFTWARE, except that two copies of the magnetic media may
be made, in machine-readable form, for use by you for backup and/or archiving
purposes on a single computer system. You may not transfer the SOFTWARE elec-
tronically from one computer to another or over a network.

You agree not to decompile, disassemble or otherwise reverse engineer the SOFT-
WARE. You may not modify the programs in any way without the prior written
consent of Northern Computers, Inc.

The manuals and other documentation may not be copied for any purpose. The SOFT-
WARE may be removed from one computer system and transferred to a backup
system, but shall not under any circumstances be used concurrently on more than one
computer system.

You agree to maintain full and complete records of the number and location of any
such copies of the software which have been generated and to reproduce on any such
copies any and all copyright notices and other markings and notices present on the
originals.

From time to time as they become available, Northern Computers, Inc. may notify
you of any enhancements or updates released by Northern Computers, Inc. for SOFT-
WARE licensed hereunder. Any such updates offered would be subject to standard
Northern Computers, Inc. terms and charges if any. ONLY REGISTERED LICENS-
EES WILL BE OFFERED ANY SUCH UPDATES. The license of the SOFTWARE
provided by this Agreement shall not be assignable or otherwise transferable by you,
except that, if you are a legally constituted organization, you may transfer the license
as part of a transfer of your entire business or assets or that portion of your business or
assets to which the license of the SOFTWARE pertains.

NOTICE:  THIS SOFTWARE IS LICENSED (NOT SOLD). IT IS LICENSED TO
LICENSEES, INCLUDING END-USERS, WITHOUT EITHER EXPRESS OR
IMPLIED WARRANTIES OF ANY KIND ON AN “AS IS” BASIS. NORTHERN
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COMPUTERS, INC. MAKES NO EXPRESS OR IMPLIED WARRANTIES TO
LICENSEES, INCLUDING END-USERS, WITH REGARD TO THIS SOFTWARE,
INCLUDING MERCHANTABILITY, FITNESS FOR ANY PURPOSE OR NON-
INFRINGEMENT OF PATENTS, COPYRIGHTS, OR OTHER PROPRIETARY
RIGHTS OF OTHERS. NORTHERN COMPUTERS, INC. SHALL NOT HAVE
ANY LIABILITY OR RESPONSIBILITY TO LICENSEES, INCLUDING END-
USERS, FOR DAMAGES OF ANY KIND, INCLUDING SPECIAL, INDIRECT OR
CONSEQUENTIAL DAMAGES, ARISING OUT OF OR RESULTING FROM ANY
PROGRAM, SERVICES OR MATERIALS MADE AVAILABLE HEREUNDER OR
THE USE OR MODIFICATION THEREOF.

NOTICE:  NORTHERN COMPUTERS INC. MAKES NO CLAIM OR WAR-
RANTY WITH RESPECT TO THE FITNESS OF ANY PRODUCT OR SOFT-
WARE FOR A SPECIFIC APPLICATION AND ASSUMES NO RESPONSIBILITY
FOR INSTALLATION. THIS WARRANTY IS IN LIEU OF ALL OTHER WAR-
RANTIES, EXPRESS OR IMPLIED. NO REPRESENTATIVE OR AGENT OF
NORTHERN COMPUTERS, INC. MAY MAKE ANY OTHER CLAIMS TO THE
FITNESS OF ANY PRODUCT FOR ANY APPLICATION.

SO LONG AS THE SOFTWARE LICENSED HEREUNDER REMAINS A PART
OF NORTHERN SYSTEMS, NORTHERN INTENDS TO ISSUE PERIODIC EN-
HANCEMENTS AND UPDATES WHICH WILL INCLUDE CORRECTIONS OF
PROGRAMMING ERRORS DISCOVERED OR BROUGHT TO NORTHERN’S
ATTENTION. HOWEVER, NORTHERN SHALL NOT BE OBLIGATED TO
ISSUE SUCH ENHANCEMENTS OR UPDATES ON ANY PARTICULAR
SCHEDULE.

NOTICE:  THE SOFTWARE CONTAINED HEREIN IS LICENSED AS A “SER-
VICE ONLY” FOR NO PARTICULAR APPLICATION. IT IS NOT TO BE CON-
SIDERED OR CONSTRUED AS A “GOOD” FOR PRODUCT DEFINITION
WITHIN THE MEANING OF THE UNIFORM COMMERCIAL CODE AND
APPLICABLE STATE LAW. NORTHERN COMPUTERS, INC. MAKES NO
COMMITMENT TO CONTINUE PRODUCING THIS OR ANY OTHER COMPAT-
IBLE SOFTWARE, NOR MAKES ANY COMMITMENT AS TO MARKETING
THE SOFTWARE IN ANY GIVEN TERRITORY.
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NOTICE:  THIS LICENSE AGREEMENT IS FOR THE NORTHERN COMPUT-
ERS, INC. SOFTWARE AND/OR DOCUMENTATION ONLY. THE SOFTWARE
REQUIRES THAT THE USER OBTAIN (EITHER FROM NORTHERN COMPUT-
ERS, INC. OR ANOTHER SUPPLIER) ADDITIONAL SOFTWARE SUCH AS
BUT NOT LIMITED TO OPERATING SYSTEMS AND/OR SYSTEM UTILITIES,
COMPILERS OR COMPUTER LANGUAGES. IT WILL BE THE USERS OBLI-
GATION TO COMPLETE AND REGISTER ANY OTHER SOFTWARE AGREE-
MENTS AS REQUIRED BY THE MANUFACTURER. NORTHERN COMPUT-
ERS, INC. ASSUMES NO RESPONSIBILITY FOR ANY OTHER MANUFAC-
TURERS SOFTWARE.
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WHAT IS ACCESS CONTROL?

Access control is computerized control over entry to
any area that can be secured with a lock and key.  Entry
is only allowed to authorized people at authorized
times.  Control of who is allowed to come and go is
easily maintained.

The weakness of a lock and key security system is the
key. The key is a readily duplicated piece of metal that
gives anyone who holds it access to an area.  The risk of
lost or stolen keys, with the expense of changing locks,
is a costly problem.  Access control is an effective and
affordable solution to this problem.  With access con-
trol, each person receives a card or keycode which
restricts access to authorized areas at authorized times.
A small, programmable control panel allows or denies
access.  If a card is lost or stolen, or if a keycode is no
longer secure, the control panel can be reprogrammed
quickly and easily.

An additional benefit of access control is report capabil-
ity. The system provides reports of all card/keycode
activity, including whether access was granted or
denied, and why. A permanent record of all entries to
an area can be maintained.
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WHAT IS WIN-PAK?

WIN-PAK is state-of-the-art access control software that
takes advantage of the Windows operating environment.
Security professionals can program card information,
create badges, and monitor alarms and cameras with
ease. The interface is intuitive and makes it easy to
manage Northern’s high-tech security hardware.

DATABASE MANAGEMENT
WIN-PAK databases allow you to define timezones,
areas, panels, cards, and other information pertinent to
the site. It is easy to add and modify hardware or cards
so that your access control system can grow with your
company’s needs.

ACCESS CONTROL MANAGEMENT
WIN-PAK’s tabbed screens give security personnel
immediate access to the principle facets of day-to-day
access control management.

The Alarm Monitor screen provides alarm monitoring
capabilities available in four views.

• The History view displays all alarm information
and system communication in a list form as it is
received from the panels.

• The Current view displays incoming alarms
according to a set priority so that high priority
items are easily visible.

• The Monitor view displays a grid of alarm input
points that can be monitored for status changes.
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• The Floor Plan view provides a graphical
representation of locations in alarm with “hot
spot” capabilities for navigating.

The Alarm Info screen provides information on a
particular alarm activity and allows the user to enter
response notes.

The Panel Control screen gives the user complete
control over panels, input points, and output points.

The Muster Report screen aids in emergency situations
when it is important for the operator to know who has
reached muster (safe) areas.

The Camera Control screen gives the user camera
control of an optional CCTV system.

The Card Lookup screen provides the user quick access
to the card database with the ability to search on most
fields, including twenty-five user-defined note fields.

The Mail screen provides the operator at the server with
a chat function to communicate with networked
WIN-PAK workstations.

In addition to real-time printouts of alarms as they
happen (sent to Windows printer spooler – follows the
rules of windows printing…) WIN-PAK gives the user
the ability to generate a wide range of useful reports.
History reports provide alarm logs from any given date,
and database reports provide you with a list of records
in any of WIN-PAK’s databases.

BADGE DESIGN
WIN-PAK comes with a full-featured badge layout
utility. Producing high quality photo ID badges is as
easy as designing the badge, using WIN-PAK to capture
ID photos, and printing. Print onto an access control
card to incorporate two security measures onto one
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card! No program offers more complete access control
than WIN-PAK.

 SERIAL NUMBER NOTE

The WIN-PAK serial number includes the version and issue
number.  The following example will show how to interpret the
serial number:

WP01.15.00.00001-NCI01

WP WIN-PAK product

01 major release (first part of version)

15 release code change (second part of version)

00 compile number (used in development, will
always be 00 in general release versions)

00001 the issue number of this version (evaluation/demo
always use 00000 and are limited in card quantity
and port communication time)

NCI01 version type
NCI01 ...... Domestic upgrade version
NCI02 ...... Domestic full version (standard)
NCI03 ...... Domestic demo version
ADV01 ..... Advanced Systems version
INT01 ....... International version
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HARDWARE/SOFTWARE
REQUIREMENTS

WIN-PAK is designed to run on IBM and IBM-based
personal computers that meet IBM serial communica-
tion specifications. The minimum hardware/software
requirements for WIN-PAK are outlined in the following
sections.

PERSONAL COMPUTER REQUIREMENTS
Northern Computers, Inc. requires an IBM or IBM-
compatible computer. The processor and Random
Access Memory (RAM) requirements depend upon the
size of the system as outlined in the following table:
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* Running database, badging, and report activities from a client instead of the servers will increase system performance.
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DISK DRIVES

WIN-PAK requires a computer with a hard disk drive
(210 MB recommended minimum) and either a 3.5"
high density floppy disk drive or a CD-ROM drive.

A hard disk drive system provides the necessary disk
storage for the WIN-PAK program, database entries, and
history transactions. If you plan on using the badging
component of WIN-PAK or other programs on your PC,
you may want to invest in a larger hard disk drive.

The 3.5" high density floppy disk drive (or CD-ROM
drive) is used for loading the WIN-PAK software.

Because the space on a floppy disk is limited, a tape
drive or other removable medium is recommended for
WIN-PAK backups.

MONITOR

WIN-PAK requires a VGA monitor capable of displaying
256 colors on a 640 x 480 pixel screen.

MOUSE

To fully operate WIN-PAK, a two-button mouse is
required.

SERIAL COMMUNICATION BOARDS

The computer may have up to two serial communica-
tion ports (type 8250 or 16550 IBM asynchronous)
configured as COM 1 and COM 2. COM 1 must be set
for IRQ4 and COM 2 must be set for IRQ3 or use a WIN-
EXP-xx for up to 32 selectable ports.
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SOFTWARE REQUIREMENTS
WIN-PAK requires Microsoft Windows version 3.1 (3.11
for networks) or later. It is NOT intended for use on the
Windows NT platform.

Windows versions prior to Windows ’95 require a disk
operating system (DOS) to provide overall control of
computer hardware and software. Check your Windows
Manual to see which operating system, and which
version, is required to run your version of Windows.

PERIPHERALS

PARALLEL PRINTER

A parallel printer is optional, but is required for most
systems to print system activity, database reports and
history reports. The printer must be an IBM compatible
parallel printer and supported by Windows.

CONVERTERS

A converter serves as an interface between the
computer’s serial communication port and the control
panels. Northern Computers offers two communication
converter options, the C-100-A and the N-485-PCI-2.

C-100-A

The C-100-A allows the computer, using RS-232 proto-
col, to communicate with the control panels in a 20 mA
current loop. A C-100-A Converter is required for each
port in local configurations.

N-485-PCI-2

The N-485-PCI-2 allows the computer, using RS-485
protocol, to communicate with control panels in a RS-

 NOTE
Although WIN-PAK can run
effectively under Windows
’95, it does not take advan-
tage of the 32-bit architecture
of this Windows version.
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485 dropline. The N-485-PCI-2 has an advantage over
the C-100-A in that it can provide a higher degree of
data supervision in the communications line as well as
an increase in system performance.

MODEMS

Modems enable the connection of the computer run-
ning WIN-PAK to control panels at remote locations,
using standard telephone lines. WIN-PAK supports two
modem configurations, as described below:

Leased-line Modems:

The M-300 leased-line modems provide a continuous,
direct connection from the computer to the communica-
tion loop, using a standard leased telephone line,
terminated with an RJ11C modular telephone jack.

Auto-answer/Auto-dial Modems:

The M-200 auto-answer/auto-dial modems (Hayes
compatible) are typically used in dial-up configurations
with the C-100-A1, in which the panels are normally
off-line with the computer and are dialed only when
communication is necessary. The M-200 modem uses a
standard telephone line terminated with an RJ11C
modular telephone jack.

The M-9600-2 is typically used in dial-up configura-
tions with the N-485-HUB-2 for locations that
automatically call to the WIN-PAK computer with
activities.

 NOTE
Telephone lines that have
special features like “call-
waiting” may cause
interference with modem
communications. Disabling
these features or avoiding
these phone lines altogether
is recommended.
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 SCREEN SAVER NOTE

Northern Computers recommends that you refrain from using
screen savers on your WIN-PAK computers in applications
that require you to view incoming activity. They mask the
activity and draw power from your PC’s processor.

If you need to use a screen saver, choose one that blanks out
the screen. The Alarm Monitor will not update while a screen
saver is running, but will be made current when the screen
saver is disabled by keyboard or mouse activity.
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Pre-Installation System
Setup
Installing WIN-PAK
Opening WIN-PAK for the
First Time
Options Setup
Communication Setup
Note Field Setup
Printer Setup 2

QUICK START
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PRE-INSTALLATION
SYSTEM SETUP

Because of the complex computer configuration re-
quired to run WIN-PAK, Northern Computers sells
WIN-PAK as a “turnkey” system. The software and
peripherals are installed and tested on a computer that
meets the required specifications as outlined in the
previous section. The tested PC and software are then
sold as the front end of an electronic access control
system.

If the software has been purchased alone, (without a
Northern Computers, Inc. computer) for installation on
the customer’s own PC, then the purchaser must config-
ure the PC, install a video capture card (if badging), and
install WIN-PAK. Because there are many PC brands
and types available, the user may run into IRQ conflicts
and other hardware issues. To avoid these hassles, we
encourage users to purchase a pre-tested, turnkey
system from Northern Computers.

BEFORE installing WIN-PAK, configure your PC. See
Appendix A for information on configuring your PC to
work with WIN-PAK. Make sure that your files contain
the correct commands.

BEFORE installing WIN-PAK, install your video capture
card or digital camera (if badging). See the manual for
your video peripheral for more information.

After these two steps have been completed, install
WIN-PAK as outlined in the next section of this manual.
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INSTALLING WIN-PAK

1. Insert the WIN-PAK installation disk 1 into your
floppy drive.

2. From the Start button, select Run... from the main
Windows ’95 menu.

3. Type “A:\SETUP” in the Open text box. (where “A”
is your floppy disk drive.) Click OK.

4. A copyright information screen will appear. Click
OK to acknowledge that you understand the
message and agree to the terms. (Clicking Cancel
at any point will abort the installation.) A window
will appear prompting you to select which the
type of installation for this machine.

Select from one of the following types of
installations:

a) Select Stand-Alone if WIN-PAK on the current
machine will NOT be networked with any
other computer.

 CD-ROM
INSTALLATION NOTE

When installing using a CD-
ROM, type “drv:\SETUP”
for step 3, where drv is the
letter of your CD-ROM drive.



20 Win PAK 1.15 User Manual

b) Select Server if WIN-PAK on the current
machine WILL be networked with other
computers and WILL be the machine
responsible for storing all database
information and communicating to the control
panels.

c) Select Client if WIN-PAK on the current
machine WILL be networked with other
computers but WILL NOT be storing the
database information and WILL NOT be
communicating to the control panels.

Click OK to continue.

5. WIN-PAK Install will then ask if the target PC has
a multi-port board installed. Select Yes if it does or
No if it doesn’t. Click OK.

6. WIN-PAK Install will then ask if the target PC will
be connected to remote 485 ACK/NAK dial-in
loops. Select Yes if it will or No if it won’t. See the
sections on Serial Ports Setup and the Areas
Database for more information. Click OK.

7. WIN-PAK Install will then prompt for a video card
type:

 NOTE
For more information on
networking setup, see
Appendices G and H.

 NOTE
Click NO in steps 5 & 6 if
your computer uses a SCSI
board.
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Select the board that the target PC has installed (or
None). Click OK.

8. WIN-PAK Install will prompt for the type of
printer that you will be using to print badges. If
you have one of the special feature printers listed,
then select it. If you have any other printer or will
not be printing badges, then select Other. Click OK
to continue.

9. WIN-PAK Install will prompt for the type of
signature capture pad you will be using to capture
signatures. If you have a PenWare 100 or 2000
signature capture pad, then select Penware 100. If
you will not be capturing signatures, select None.
Click OK to continue.

5. WIN-PAK Install will then prompt for a directory
in which to install WIN-PAK.

 NOTE
Although the directory that
you install WIN-PAK into can
be changed, we highly
recommend keeping the
default of “C:\WINPAK”.
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6. The default directory is the C: drive. To select
another directory to install into, click the drive
drop-down list and select one.

An alternate subdirectory can be selected by
double-clicking on the directory folders. This will
open and close them.

Click OK when the directory you want appears in
the top text box.

7. A registration dialog box will appear with spaces
for you to enter your name and organization. Click
on the spaces to type in them or press Tab to move
between them. Once you have finished filling in
both spaces click OK to proceed.

8. A dialog box will ask you to confirm that the
information you added is correct. If it is, click Yes.
If not, click No to return to the registration
window to modify the information.

9. WIN-PAK Install will ask you if you want to print
alarms from this station.

 NOTE
If this is an upgrade,
WIN-PAK will provide a
message stating that the
directory already exists. A
message will then ask you if
you want to re-create your
databases – SELECT NO if
upgrading!
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Select Yes if you will be printing alarms from this
station or No if you will not.

10. WIN-PAK Install will begin copying files to your
hard drive. It will prompt you to put Installation
Disk #2 into the floppy drive and press the OK
button. Only change the Source Pathname if
different from the default path. WIN-PAK install
will continue copying files to your hard drive.

11. A message will appear notifying you that
WIN-PAK has been successfully installed. Click
OK. You will have a new group window called
Northern Access Control that will contain icons
for the following:

 WIN-PAK PROGRAM

Double-click this icon to access WIN-PAK

 BADGE LAYOUT UTILITY

Double-click this icon to create badge backdrops for
cards (also accessible from within WIN-PAK)

 NOTE
Your installation will require
that the computer be
restarted.
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 WIN-PAK HELP

Double-click this icon to get help on any of
WIN-PAK’s functions. (also accessible from within
WIN-PAK)

 README.HLP

Double-click this icon to read any last minute
release information that may not be included in the
manual.

 PCPAK TO WIN-PAK CONVERSION HELP

Double-click this icon for instructions on how to
convert PCPAK databases to WIN-PAK.

 UN-INSTALL WIN-PAK

Double-click this icon to delete WIN-PAK and any
related files off of your hard drive.
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OPENING WIN-PAK FOR
THE FIRST TIME

Double-clicking the WIN-PAK icon will open the pro-
gram. When you open WIN-PAK for the first time, you
will be given a message that WIN-PAK will create new
databases (only if you didn’t convert from PC-PAK).
Click Yes if this is a new installation. WIN-PAK will
create the databases.

OPTIONS SETUP

1. An Options dialog box with four screens will
appear. Fill in the information on each screen
before clicking OK. These options can be modified
at a later time be selecting Options from the
Setup menu within WIN-PAK.

 NOTE
The History and Scheduler
Databases MUST be re-
indexed when upgrading
systems.
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3. When the Options box opens, the Card screen will
be visible. From this Card screen, select whether
your cards are 5 digits or 12 digits. 12-digit cards
are supported by N-1000 Control Panels with
version 8.xx firmware only. WIN-PAK does not
support 6.03 firmware.

4. Enable Card Limiting if you want to utilize this
feature. Card Limiting is the ability to
automatically limit the usage of cards in a system.
This can be done in one of three ways:

a. Activation & Deactivation by Scheduler
WIN-PAK can permit a card access between
two dates. The activation and deactivation
dates are set for each card in the Card
Database. WIN-PAK checks the card dates by
the schedule defined in the Schedules
database.

b. Expiration by Panel Hardware
A card’s access can also be set to expire on a
date. This is done at the panel level so the
computer doesn’t have to be online to expire
the card. The expiration date for each card is
set in the Card Database and becomes effective
when the card information is uploaded to the
panels. This option is limited to up to 254 days
from the date that it is entered in the Card
Database.

c. Limited Use
A card’s access can also be restricted to a
limited number of uses. Once a card has been
used a set number of times, it becomes invalid.
This number (maximum 254) is set for each
card in the Card Database. Like Expiration by
Panel Hardware, Limited Use is also controlled
at the panel.

 NOTE
The database capacity of the
control panel may be
reduced by up to 50% when
either the Expiration by Panel

Hardware or Limited Use

card limiting option is
selected. See N-1000
programming manual for
details.
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5. Click the Communications tab to configure
communication options for WIN-PAK. From the
Send Command File section, select whether you
want to send command files and switch cameras
upon receiving alarm information or when you
acknowledge alarm information. The “On
Acknowledge” option requires the operator to
acknowledge before sending/switching, while “On
Receive” will act automatically when alarm and
reader conditions are received.

6. From the Clear Alarm State section, select whether
you want operators to be able to clear only normal
states, or both alarm and normal states.

 NOTE
The Communication Setup
will not be available to
WIN-PAK installed on a
network client.
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7. From the Alarm Monitoring section, enable Alarm
Acknowledge if you want to eliminate the need to
Acknowledge lower priority items. If enabled
(indicated by a 3), type in or use the arrow keys to
indicate the lowest priority requiring
acknowledgment. “1” is the highest priority and
“99” is the lowest priority. Alarms, readers, &
cards with this priority or higher (lower number)
AND undefined alarms and cards will need to be
acknowledged. If not enabled, only undefined
alarms and cards will need to be acknowledged.

8. WIN-PAK’s Auto Card Lookup will automatically
display card information including name, card
number, and badge photo (if exists) for cards that
send a status to the Alarm Monitor. To prevent
Auto Card Lookup from displaying every time a
card is presented, a priority threshold can be set
from this screen. Type in (or use the arrow keys to
enter) a number from 0 to 99. All card statuses
with higher priorities (lower numbers) than this
will trigger the Auto Card Lookup. The rest will be
ignored.

 NOTE
Undefined alarms and cards
always have the highest
priority.
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8. Click the Operator tab to configure operator
options for WIN-PAK. From the Operator screen,
enable the Log Actions option if you want history
reports to contain operator actions including alarm
acknowledgment and database modifications.

9. Enable “Lock Out Operator after invalid login” if
you want WIN-PAK to refuse access after a certain
number of invalid attempts to login. Type in the
number of invalid attempts allowed in the first box
and the number of minutes to lock out in the
second box. The arrows will adjust the number
box that has the cursor in it.

10. Click the Muster Report tab to configure muster
reporting options. Check the box labeled Initialize
with History Data to enable priming (see chapter
5). Use the number box to select the number of
hours of history to be considered in the priming
operation. Numbers can either be typed in or
selected with the arrow buttons next to the box.
The maximum number of hours is 99.

11. When your options are set the way that you want
them, click OK from any screen.
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REGISTRATION

When you open WIN-PAK prior to registering, a screen
will appear prompting you to enter the CD Key number.

Enter the CD Key printed on your WIN-PAK Manual
cover in the text spaces provided. Press TAB to move
from one text entry space to the next. When finished,
click OK.

If the CD key you entered is valid, the screen below will
appear.

To register your copy of WIN-PAK, click Yes. The
following screen will appear.
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You will need to call the Northern Computer’s Customer
Service Staff at 1-888-323-4576 to obtain the product
serial number. Enter the serial number in the space
provided, and click Register. The CD Key message will
no longer appear and, as a registered user, you will
receive notification of future WIN-PAK upgrades.

YOUR FIRST LOGIN
12. Under Operator Name: type “system” and under

Password: type “startup” (lowercase) and click
Login.

13. A message will appear recommending that you
change the SYSTEM password immediately. Click
OK.

CHANGING THE SYSTEM PRIVILEGES AND
PASSWORD
WIN-PAK doesn’t give the SYSTEM operator access to
all functions, so you will need to change them manu-
ally:

14. Select Operators... from the Database Menu.

15. Click Edit...

16. You need to change the privileges for SYSTEM so
that you have access to all sections of the program.
To do this you need to scroll down the list of
options and change all of the symbols to open keys
(  ). To do this click:

• • two times on File
• • • three times on Database
• one time on Reports
• one time on Setup
• one time on Alarm Monitor
• one time on Alarm Info

 NOTE
Along with changing the
system privileges and
password, the operator
name can also be changed.

 NOTE
Operator names are not
case sensitive, but
passwords are!
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• one time on Panel Control
• one time on Muster Report
• one time on Camera Control
• one time on Card Lookup
• one time on Mail
• one time on Muster Card Deletion
• one time on Non-Muster Card Deletion
• • two times on Guard Tour View

17. Double check to make sure that all of the symbols
have been changed to keys without the circle and
bar (  ).

18. Click Password... This will open the Set Password
dialog box.

19. Enter a new password in both the Password and
Verify boxes. Make sure that you don’t forget what
it is. Click OK. Click OK again to close Operator
Detail. Click Close to close the Operator Database.

You will now have complete access to the WIN-PAK
program. Re-login using SYSTEM and your new pass-
word. You will have the ability to change WIN-PAK
setup, program databases, and will have access to all
other functions.

LOGGING IN FROM WITHIN WIN-PAK
Operators can log in from within WIN-PAK by selecting
Login from the File menu or by clicking the Login
button (  ) on the toolbar. Either of these actions will
bring up the Login dialog box prompting you for opera-
tor ID and password.
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BUFFER/UNBUFFER PROMPTS
When starting WIN-PAK, a dialog box will prompt the
operator to unbuffer panels. If Yes is selected, all direct
connected panels will be unbuffered and will show up
in the Alarm Monitor Screen. If No is selected, the
panels will continue to buffer transactions.

Similarly, when exiting WIN-PAK, a dialog box will
prompt the operator to buffer panels. If Yes is selected,
all direct connected panels will be instructed to buffer
transactions before WIN-PAK is closed. If No is se-
lected, panels will not buffer transactions and all
incoming alarm and card read data will be lost.

 NOTE
When exiting WIN-PAK for
the first time, a screen will
appear prompting you to
save the control file. Click
OK.
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COMMUNICATION SETUP

It is important to designate Serial Ports for communica-
tion before programming your databases. Serial ports
must be defined so that they can be used in the Areas
Database. The following steps explain the process:

1. From the Setup menu, Select Serial Ports...

The Serial Port Setup dialog box is used to configure
WIN-PAK for your communication hardware. The setup
contains two screens, the first for setting up each port,
and the second for configuring multi-port hardware (if
needed).

Each serial port can be used to communicate to a loop
of panels or a supported CCTV system. Personal com-
puters generally have one or two internal serial ports
that can be used, but additional hardware can be
purchased allowing up to 32 communication ports.
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The first screen is used to enable and configure each
port. Select the port hardware you are using from the
drop-down list. The default is Internal Serial Ports
(COM1 & COM2). If no additional hardware is used for
multi-port capability, leave this default selected. If you
do have multi-port hardware, select the type from the
Serial Ports drop-down list.

The data entry table in this screen will reflect the
selected serial port option. If left at Internal Serial Ports,
two rows are viewable labeled COM 1 and COM 2, but
if a multi-port option is selected, more rows will appear
allowing you to define each port.

For each needed port (row):

1. Enable the ports that you will be using by clicking
the box in the row under Enable. An “X” indicates
that the port has been enabled. These ports will
now be made available to define areas in the Areas
Database.

2. Click the box in the row under Modem if the port
will be used for a remote dial-up location. An “X”
indicates that the modem is enabled.

3. If the port is connected to a modem, select the
baud rate of incoming communication from the
drop-down list (1200, 2400, 4800, or 9600).

4. For each port connected to a modem, a default
initialization command string will appear. It can
be changed by selecting and deleting the default
string and retyping in a new one. Shift-F2 will
allow you to edit instead of re-typing the whole
string. Press Shift-F2 which will highlight the
whole line. Then press the left or right arrow key
so the line appears in yellow. Use the arrow keys
to move to where you need to add or remove
information.

 NOTE
Do not enable a serial port if
you have a serial mouse
attached to it – errors will
occur.
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The following string may work better with modems
sold by Northern Computers (as well as some other
brands):

ATE0V1Q0&C1&WS0=1&D0

NOTE: 0 = zero

5. If the port is connected to a modem, type in the
modem phone number of the port’s modem. This
is the number a remote modem would dial to
connect to WIN-PAK. It is used for 485 ACK/NAK
dial-in loops or areas.

If a multi-port unit has been selected, click on the
Multi-port Hardware tab to open a screen to configure
your hardware to work with your computer.

The settings on this folder are specific to the type of
hardware being used. The default settings in the fields
are for the hardware selected in the Serial Ports screen.
See the hardware’s manual for alternate settings in case

 NOTE
Only change the settings in
the Multi-port Hardware
Screen if your hardware is
not working correctly.
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there is a conflict with other peripherals. If your hard-
ware settings need to be changed:

1. Select an alternate IRQ for the unit from the drop-
down list. This must be the same as what the
hardware is configured for.

2. Select the space next to a port that you want to
change the address to, and type in an alternate
port address.
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NOTE FIELD SETUP

Although note field labels can be defined at any time,
setting them up prior to programming your Card Data-
base can make the task easier. After carefully
considering what data you want to manage on each
card holder (or card) and the entry order, follow these
steps to rename your note fields:

1. Select Note Fields... from the Setup menu.

 NOTE
On badging clients, chang-
ing the names of the Note
Fields will not be reflected in
the Backdrops database until
you exit and restart
WIN-PAK on the client.
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 NOTE
Printer Drivers are added
and configured in the
Control Panel of Windows,
located in the Main Group.
See your Window’s manual
for more information.

2. Click in the space next to a note field that you
want to change and type in a new label. For
example, we could type “Department” next to
Note 1 to change the label from Note 1 to
Department in every area of WIN-PAK that uses
note fields.

It is important to hit Enter or move to a new field
to save the label. Click OK when finished.

PRINTER SETUP

The report printer and the alarm printer are set up
independently. Selecting Print Setup... from the File
menu brings up the following dialog box:

Select the printer that you want to set up and click
Setup. Select Report Printer and click Setup to config-
ure the options for printing reports. You should have at
least generic text installed as a print driver so that the
reports are shown and come up in a letter (81/2" x 11")
format.

Select Alarm Printer and click Setup to configure the
options for printing system alarms. The Alarm Printer
option will open the following dialog box:
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WINDOWS PRINTING (ONE PAGE AT A TIME)

This option should be selected with laser printers. It
holds transaction information until enough transac-
tions are made to fill a page. It then prints the page.
If you want the information printed before the page
is full, you must click the page eject button from the
menu bar. 

DIRECT TO PORT (ONE LINE AT A TIME)

This option can be selected with dot matrix printers
to print transactions in “real time.” Use this feature
for local printing only (not to be used with, or as, a
shared network printer).

NO ALARM PRINTING

Select this option if no alarm printing is required.
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3
CREATING AND

MODIFYING DATABASES

The Database Control
Window
Timezone Database
Areas Database
Panel Database
Schedules Database
Tracking Areas Database
Access Level Database
Card Database
Camera Database
Holidays Database
Monitors Database
Operators Database
Floor Plan Database
Command File Database
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The WIN-PAK access control system is made up of
interconnecting databases that can be accessed by
clicking Database on the menu bar. Although only a
few databases are required for operating a basic system,
up to fifteen databases are possible in advanced sys-
tems that make use of WIN-PAK’s CCTV, floor plan,
muster, and other features. The programming order of
these databases is very important, because almost every
database depends upon the information entered in
other databases. There are five core databases in a
WIN-PAK access control system:

THE TIMEZONE DATABASE
This database defines timezones. Timezones are time
elements used in the system that can be used to deter-
mine when particular actions happen or when certain
cards are allowed access. These elements can be at-
tached to cards, inputs, and outputs in other databases
of WIN-PAK.

THE AREAS DATABASE
This database is used to define the settings for each
communication port used in the system.

THE PANEL DATABASE
The panel database maintains information on access
control panels such as what options are enabled, reader
information, input point and output point information.

THE ACCESS LEVEL DATABASE
Access levels determine where and when access is
allowed to a card holder. An access level consists of a
number of readers that can be accessed, the time access
is permitted, and if configured, the group of relays to be

 NOTE
Creating badge backdrops
requires the Badge Layout
Utility included with
WIN-PAK. Accessing and
using this utility (and
database) is covered in
Chapter 4.
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pulsed. Cards assigned to an access level have access to
the specified readers (doors) at the specified times.

THE CARD DATABASE
The card database maintains information on cards and
card holders including an access level and badge
information.

The following databases are supplementary. Informa-
tion may be required in the supplementary databases
first, however, to provide information when defining
the main databases.

 SCHEDULES DATABASE
The schedules database is used to send commands from
WIN-PAK to the access control system at particular
days and times. The uses for this feature include updat-
ing the panel date and time, dialing up to remote
panels, and activating/deactivating cards. A schedule
can also be set to send a reminder message to the
operator to back up files.

TRACKING AREAS DATABASE
Tracking areas are different from the Areas Database
previously discussed. Tracking areas are used to deter-
mine where personnel are in a facility at a given time
(when a muster report is run).

CAMERA DATABASE
The camera database is used to define video cameras in
a CCTV configuration.

 NOTE
It is important to note that
an operator must be
"permitted" to add, edit, or
delete records in the
databases by being given
the “Edit” (  ) privilege for
a particular database in the
Operator Database.

An operator with a “Look”
(  ) privilege will be
allowed to view records, but
not modify them. Access
will be allowed into the
database, but all editing
buttons will be replaced with
a “View...” button. The
operator will be able to see
all information in the
database, but will not be
able to click OK to save any
changes. Cancel must be
used to exit the database.

An operator with a "None"
(  ) privilege to a database
will not even be allowed to
view records. The database
will not appear in the
Database menu. If the
“None” privilege is assigned
to all databases, the
Database menu will not
appear on the menu bar. See
the section on the Operator
Database for more informa-
tion.
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HOLIDAYS DATABASE
The holiday database is used to define holidays during
the year. The operator will have the option of including
or excluding these holidays when defining a timezone.

MONITORS DATABASE
The monitors database is used to define video monitors
in a CCTV configuration.

OPERATORS DATABASE
The operators database is used to set operator pass-
words and the privileges that each operator has for the
different sections of WIN-PAK.

FLOOR PLAN DATABASE
The floor plan database is used to provide a graphic
representation of the facility. This database is used to
match the graphics with descriptions and define hot
spots that can be used to monitor alarms.

COMMAND FILE DATABASE
The command file database is used to define text files
containing panel commands. These files can be up-
loaded to the panels upon receiving a card/input status.

On the following pages is an illustration of how data-
bases are interconnected and a recommended
programming order.



Operator
Database

WIN-PAK
Setup

Areas
Database

Timezone
Database

Monitors
Database

SECONDARY
DATABASES

Cameras
Database

1 2 3 4

Holiday
Database

MAY
5

Schedules
Database

Step 1
It is important that a “mas-
ter” operator be defined in
the Operator  Database that
has access to all areas in the
WIN-PAK program.

Step 2
Setup  should be done be-
fore the following databases
are defined, as they will af-
fect certain options in the
Area, Panel, and Card Da-
tabases.

The Schedules  Database is
also an important part of the
Setup process. It allows you
to determine:

• when time & date updates will
be sent to the panels,

• what information will be sent
to remote panels and when,

• when to check the activation/
deactivation status of cards.

Step 3
Areas  can be defined from
serial ports made active in
the Serial Ports section of
the Setup menu. These ar-
eas can be local or remote
control panel loops or CCTV
networks.

Step 4
Timezones  simply define
blocks of time. These need
to be added to be included
in the Panel and Access
Level definitions.

• If Holidays  will be treated dif-
ferently, they should be de-
fined in the Holiday Database.
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Database

Access Level
Database
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Card

Database

7

Backdrops
Database

Command File
Database

Guard Tours
Database

Tracking Areas
Database

Floor Plans
Database

Step 6
Access Levels  match read-
ers to timezones and relay
groups. Access levels will be
assigned to cards to decide
which cards have access at
particular readers at particu-
lar times.

Step 5
The Panel Database defines
panel options, readers, input
points, output points, and re-
lay groups.

Depending upon the system,
the following databases may
need to be programmed first:

• If a CCTV system is utilized,
records should be added in the
Camera  and Monitor  data-
bases first.

• If Command Files  that contain
panel programming commands
will be used, program them
first.

Step 7
Cards  are defined in the
card database. This data-
base is where personnel are
assigned to a card number
and cards are assigned to an
access level.

• If badging is going to be done
from WIN-PAK, badge back-
drops  should be designed in
the Badge Layout Utility so
they can be assigned to cards
in this database.

Other Databases
• Alarms can be monitored by

floor plans with hot spots de-
fined in the Floor Plan  data-
base. Floor plans can be
added to this database after
input points are defined in the
Panel Database.

• The Guard Tours  database
can be used to schedule
routes for a guard to present a
particular card at specified
readers.

• The Tracking Areas  Database
is used to define areas that can
be monitored with the Muster
Report screen.
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THE DATABASE
CONTROL WINDOW

All databases in WIN-PAK have the same control
window. This makes the program easier to learn and
use. The elements of the database control window are
described in this section.

DATA LIST
The data list is an onscreen chart of all records entered
into the database. It will vary in information depending
on the database you are looking at but will basically
contain the names of the records and important infor-
mation contained in them. In all databases,
double-clicking on the record is a shortcut for editing
and viewing more detailed information.
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FOLDERS

The Timezone, Guard Tour, Tracking Areas, and Access
Level Data List Records have folders in front of them. If
you click on the folder for a particular record, its
information is displayed as a sublist for viewing.

SEARCH TOOL

This tool is used to find a particular record in larger
databases. Type in the record (or first few characters of
the record) you are looking for and click the Search
button. The record information that you type in the
search box must be the type of information specified in
the Sort Order box. For example, if you want to search
for a particular access level, you should set your sort
order to access level (see below) and then type the
name in this space. Clicking the search button (  )
will then find the first occurrence of a record meeting
the criteria.

SORT ORDER

WIN-PAK offers you more than one sorting option for
each database to make it easier for you to find the
record you are looking for. Simply click the drop-down
list button to view a list of fields, and select the one you
want to sort by. For most databases you have the choice
of sorting by the order records were entered by selecting
“None” or alphabetically by name. This is also the
index that the Search feature uses to find a record.

 NOTE
The Search Tool is NOT case
sensitive.

 NOTE
You cannot use Search if the
Sort Order is set to “None.”
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DATABASE TOOLS

These buttons are used to modify the database.

 ADD BUTTON
Use this button to add a new record to your database. It
will open a window with empty fields that you can
enter new data into.

 EDIT BUTTON
Use this button to edit the currently selected record. It
will open up a window showing you the data for that
record. From this window you can add or delete infor-
mation, or overwrite existing information. Closing the
record will save your changes.

 DELETE BUTTON
Use this button to delete the currently selected record.
As a safeguard against accidental deletion, a dialog box
will appear asking you to confirm your decision to
delete the record. Click OK to confirm.

Sometimes a record cannot be deleted until records
from other databases that it “connects” to are repro-
grammed to cancel references to it. For example, a time
zone record cannot be deleted until all references to it
in the Panel and Access Level databases are removed.
When references to a record are removed, it can be
deleted.

The record will continue to appear in the data list
although it will be “grayed”. New records will not be
able to use it’s key fields (i.e. name or card number)
until the database is packed (see Chapter 7).

 NOTE
You will notice that adding
and modifying databases
are included in the same
section. This is because
modifying information is a
matter of opening the
required tab or dialog box,
adding or deleting informa-
tion, or overwriting
previously entered informa-
tion. When the database is
closed, all of your changes
are saved.

 NOTE
Records that have been
deleted will appear in the
database “grayed out” until
the database is packed. See
Chapter 7 for more informa-
tion on packing.
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 VIEW BUTTON
This button will appear instead of the Add... and Edit...
buttons when the current operator does not have
editing privileges. The operator can use this button to
browse detailed information on the database. Although
an operator can access these screens with View..., and
even appear to change information, none of the changes
can be saved because the OK button is removed. The
operator must Cancel out of the record.

 CLOSE BUTTON
This button closes the current database.

STATUS LINE

The status line located on the tool bar displays what
record number is currently selected and the number of
records currently defined.

The following sections will illustrate how to add and
modify information in each individual database. It is
wise to plan your system carefully on paper before you
begin programming, paying close attention to program-
ming order. Appendix I contains worksheets that you
can use to plan your system.
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 NOTE
Timezones should be
programmed with access
levels, shunted inputs, and
time controlled outputs
(doors) in mind. There must
be at least one timezone
defined before you can enter
panels in the Panel Data-
base.

THE TIMEZONE DATABASE

A timezone is one or more blocks of time used to
determine WHEN an activity will happen or WHEN a
card will be allowed access. A timezone is defined by
blocks of time, each consisting of a starting time, an
ending time, and days of the week. WIN-PAK also
allows the user to determine whether holidays are to be
included in each block of time.

For example, we could define a timezone for 8:00am to
5:00pm, Monday through Friday excluding holidays,
and give it the name “1st Shift”. Then we use the name
of the timezone, 1st Shift, to refer to that period of time
in defining access times, shunt times, etc.

The Timezone Database is accessed by clicking Data-
base on the menu bar, and selecting Timezones.... This
will open the Timezones Database Control Window.

The Data List contains the names of all defined
timezones. Clicking on a timezone folder will show the
blocks of time that it defines. For each block of time you
will notice a Start Time, an End Time, and x’s to indi-
cate which days of the week it includes. You will also
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see an x under “Ho” if holidays are included in the
block.

Under the Data List you will see the sorting order of the
list. By clicking the drop-down list button, you can
select how you want to sort the timezones for viewing.
This database allows you to sort by the order in which
the records were entered (None) or alphabetically by
name.

When sorted by Timezone, a timezone can be searched
for by entering the name in the search box and clicking
the Search button (  ).

ADDING OR EDITING A TIMEZONE
Click Add... to enter a new timezone or Edit... to modify
the currently selected timezone. This will bring up the
Timezone Detail window.
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When you begin entering the details for the timezone, a
message will appear providing the correct syntax for
entering the start and end time:

Click OK after noting the correct syntax for entering
times.

1. Enter the name of the timezone in the text entry
box. The timezone name can be a descriptive
name containing up to twenty characters with any
combination of letters, numbers, or spaces.

2. Enter the Start Time by clicking on the first box
under “Start Time” defaulted at 12:00 am. Type in
the starting time of the block and hit Enter.

3. Use the right arrow key or the mouse to select the
End Time box. Type in the end time of the block
and hit Enter.

4. Use the mouse to select which days the block will
include. Selecting holidays (HO) in the time block
will include all holidays that fall within that block
as defined in the Holiday Database. If left
deselected, the block will exclude holidays.

X’s will mark your selection as shown in the
sample screen shown. Clicking the day again will
deselect it.

This process can be repeated for as many blocks of time
needed to define the timezone.

 NOTE
Zeros should be used for
seconds as seconds are not
programmable.
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DELETING A BLOCK OF TIME

Deselecting all days of the week will effectively “delete”
a block of time.

5. Click OK with the mouse to save the timezone or
Cancel to ignore any changes or additions and
return to the Timezone Database Window.

DELETING A TIMEZONE
1. Select the timezone you want to delete with the

mouse and click the Delete button. If you are sure
you want to delete the timezone, click OK when
the confirmation dialog box prompts you.

The record will continue to appear in the data list
although it will be “grayed”. New records will not be
able to use it’s name until the database is packed (see
Chapter 7).
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THE AREAS DATABASE

An Area is a way of defining a network of hardware that
is wired together and originates from the same commu-
nication port, such as a loop of panels or closed-circuit
TV equipment. There can be one direct connection Area
defined per communication port.

The Areas Database is accessed by clicking Database on
the menu bar, and selecting Areas.... This will open the
Areas Database Control Window.

The Data List contains the names of all defined areas.
The information includes the Area Name, Type, Port,
Baud Rate, and a Remote Site Phone Number (if it is a
remote site).

Under the Data List you will see the sorting order of the
list. By clicking the drop-down list button, you can
select how you want to sort the areas for viewing. This
database allows you to sort by the order in which the
records were entered (None) or alphabetically by name.
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When sorted by Area, an area can be searched for by
entering the name in the search box and clicking the
Search button (  ).

ADDING OR EDITING AN AREA
Click Add... to enter a new area or Edit... to modify the
currently selected area. This will bring up the Area
Detail window.

NAME:
Enter the name of the area in the text entry box. The
area name can be a descriptive name containing up to
twenty characters with any combination of letters,
numbers, or spaces.
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TYPE:
Select a type of configuration for the area from the drop-
down list. The choices are Loop (of panels), Camera
Control, or Unknown. Unknown is for other RS-232
communication or devices. Select the one that describes
the use of the communication port.

STYLE:
Select the style that further describes the configuration
of the area. The drop-down list options are dependent
on the selection made for Type . If the type is Loop,
choose C-100, 485, or 485 ACK-NAK. “485” should be
used for the N-485-PCI and N-485-API (not -2) or 4702
panel. Refer to the WINPAK1.INI file in Appendix D for
special settings with the N-4702.

If the type is Camera Control, choose the brand of CCTV
equipment you are using. The NCI CCTV option will allow
WIN-PAK to communicate with Northern Computers’ PC-
CCTV interface, which is required for some brands.

If the type selected is Unknown, this field will be limited
to Other.

LOCAL/REMOTE

Select either Local or Remote to describe the area.
Local is hardwired or leased line communication, and
remote is dial-up modem communication.

PORT:

Select the communications port for the area from the
drop-down list. This list consists of the serial ports
enabled in your Serial Port Setup (in the Setup menu)
that match your Local/Remote specification above.

 NOTE
The 485 ACK-NAK option is
for use with a new 485
protocol that works with
Northern Computers
products with part numbers
N-485-xxx-2.

 NOTE
Multiple remote areas can
be assigned to the same
port, but only one local area
can be assigned to a port.
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BAUD RATE
Select a baud rate from the drop-down list to match the
communication device hooked up to the defined port.
See your access control panel, 485 interface, or CCTV
manuals for required baud rates.

MODEM SETTINGS
The remaining fields and options are only available
if the area is a remote site and the Type is set to
Loops. They describe the fields necessary for commu-
nicating with a remote site. Some of the options in
this section may be dimmed (can not be edited)
depending upon the equipment that has been selected
in the Style field.

PHONE

Enter the phone number of the REMOTE SITE in the
text entry field. Enter the number as if you were dialing
the number directly using up to 32 characters. A
comma can be used to specify a pause in a dialing
sequence.

SITE ID

This option is only accessible if 485 ACK-NAK was
selected for the area Style . Site ID should be entered
as a  unique code for each remote site. It should have
the following format:

@A[unique 4-digit number],S[unique 4-digit
number]

For example @A0001,S0001 would be area 1, site
1 and @A0002,S0003 would be area 2 site 3.
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SET PASSWORD
If 485 ACK-NAK was selected for the area Style , then
you can specify a unique password. It can be 8 charac-
ters long, and may be  numeric, alpha, or a combination
of both.

ADVANCED...

When Loop is selected as the area Type and Remote is
enabled, then the Advanced... button will be available.
Clicking this button will allow the operator to define
remote area communication options. Most of these
options, however, are only enabled when 485 ACK-NAK
is selected as the area Style.

NUMBER OF REDIAL ATTEMPTS

Enter a specific number (0-50) in the Number of Redial
Attempts  box.  WIN-PAK defaults this number at zero
which will retry one time. Available only when 485 ACK-NAK is

selected as Style .

WAIT TIME BEFORE DISCONNECT

Enter a specific number of SECONDS (1-999) in the
Wait Time Before Disconnect  box.  WIN-PAK defaults
this number at 10. Available only when 485 ACK-NAK is

selected as Style .



62 Win PAK 1.15 User Manual

DIAL COMMAND PREFIX
Specify a Dial Command Prefix. This command should be
“ATDT” in almost all circumstances. Available only when

485 ACK-NAK is selected as Style .

PAUSE BETWEEN CALLS
Enter a specific number of SECONDS (1-999) for Pause
Between Calls .  WIN-PAK defaults this number at 15
seconds. Available only when 485 ACK-NAK is selected as Style .

MODEM INITIALIZE

Enter the remote modem initialize string as
ATEØQØV1&KØ&C1&DØSØ+1&W

This string is made of the following options:

EØ modem command echo disabled
QØ enables modem responses
V1 verbose (text) result codes

&KØ disable local flow control
&C1 cause DCD (carrier detect) to track actual state

of remote modems carrier
&DØ ignore data terminal ready signal from computer

SØ=1 one ring until answer
&W write the active profile as defaults

 Available only when 485 ACK-NAK is selected as Style .

CALL IN OPTION

Specify one of two possible Call in Options : On invalid
transactions (includes buffer full) or Never. Available only

when 485 ACK-NAK is selected as Style .

VERIFY COMMUNICATION
Enable this option to ensure that all panel communication
is supervised. This option is automatically enabled when
485 ACK-NAK is selected as Style and is grayed out so
it can not be turned off.

 NOTE
Northern Computers’
modems include documen-
tation regarding the current
modem initialization strings.
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COMMUNICATIONS

The options in this section can be edited only when
Camera Control  or Unknown  is selected from the
Type drop-down list.  Refer to your CCTV or other
serial device manual for proper settings.

DELETING AN AREA
1. Select the area you want to delete with the mouse

and click the Delete button. If you are sure you
want to delete the area, click OK when the
confirmation dialog box asks you.

The record will continue to appear in the data list
although it will be “grayed”. New records will not be
able to use it’s name until the database is packed (see
Chapter 7).

 NOTE
You will not be able to delete
an area if it is assigned in
another database.
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THE PANEL DATABASE

Panels are an integral part of the access control system.
They control card readers, locks, alarms, and other
inputs and outputs. Although they are programmed
from your WIN-PAK software, they run independently.
They can even buffer transaction information when
your computer is off and unbuffer it to your PC when
you turn it back on. This database lets you assign
parameters that are specific to how each panel should
operate.

The Panel Database can be accessed by selecting the
Panels... option from the Database menu.

The Data List contains the names of all defined panels.
For each panel you will notice a Panel Name, Panel
Number, Type, PROM Version, Digits and whether
Keypads and Groups are enabled. The status of the
panel is also indicated.

Under the Data List you will see the sorting order of the
list. By clicking the drop-down list button, you can
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select how you want to sort the panels for viewing. This
database allows you to sort by the order in which the
records were entered (None) or alphabetically by panel
name.

When sorted by Panel, a panel can be searched for by
entering the name in the search box and clicking the
Search button (  ).

ADDING OR EDITING A PANEL
To add a new panel simply click the Add... button and
fill out the “detail” screens as outlined below. Selecting
a previously defined panel with the mouse and clicking
Edit... allows the user to view or modify it’s informa-
tion.

There is a lot of information kept on each panel.
WIN-PAK organizes this information in five to six
“detail” screens that become accessible when you add
or edit a panel. These screens include information on
the panel, the timezones that it stores, it’s readers, it’s
input and output points, and groups of output points (if
enabled). Clicking on a screen’s tab will bring up that
specific area of information. The OK button appears on
every screen but should only be clicked when data on
all of the screens is configured. Clicking OK saves all
changes and closes the current panel detail window.
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PANEL SCREEN
The first screen of information is labeled “Panels” and
contains the most general panel information. The fields
are described below.

NAME:

Enter a name for the panel in the space provided. It can
consist of twenty characters including letters, numbers,
and spaces.

 NOTE
Although “Name” is the first
field in the Panels screen,
panel “Type” must be
defined first.
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LOOP (AREA):
Use this drop-down list to pick the area that the panel is
in. The areas available in this list are those that are
defined as panel loops in the Areas Database.

ADDRESS:
Use the arrows to assign a unique numerical address to
the panel. This address must match the panel’s address
settings. You can number panels from 1 to 63 for C-100
loops or from 1 to 31 for RS-485 loops. You will get an
error message if this number is the same as a previ-
ously defined panel in the same loop (area) or if the
number is higher than allowed for that loop. This field
cannot be altered after clicking OK to save the panel
data.

TYPE:

Use this drop-down list to define the type of control
panel. This selection will determine which panel options
are definable. This field cannot be altered after moving
from this screen. When “N-4702” is selected as the panel
Type, the area Style must be set as “485.” Refer to the
WINPAK1.INI file in Appendix D for special settings when
using the N-4702.

DIGITS:

The five and twelve digit option is set in the Serial Ports
section of the Setup menu. The 5 or 12 digit selection
there will restrict or allow certain firmware choices, and
limit your card programming between 5 and 12 digits at
the panel level. If 5 digits was chosen in the Setup
menu, this option in the Panel Database cannot be
changed and will appear “grayed out.”

If 12 digits was chosen in the Setup menu, WIN-PAK
allows you to select either 5 or 12 digits at the panel
level for individual panels with firmware version 7.49 and

 NOTE
The 12-digits, Groups, and
Split Timezones options
cannot be used when the
type of panel is the N-4702.

 NOTE
Once an area (loop) is
selected and OK is clicked
to save the panel, you
cannot re-assign another
area (loop) to the panel. The
area itself, however, can still
be edited from the Area
Database.

 NOTE
The 12-digit selection does
not allow site code use.
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up. When 5-digits is selected, card numbers between 1
and 65534 will be accepted. When 12-digits is selected,
a default card format is sent. This default will read, in
order, the first 12 positions of the card, accepting card
numbers from 1 to 999999999999. It may be necessary
to change this format structure for certain applications.
Refer to the panel documentation for more information.

COMMAND FILE:

Use this drop down list to associate a command file with
the panel. The list consists of all command files that
have been defined in the Command File database. The
command file selected will be sent to the panel when it
is initialized. To remove a command file, select “None.”
For more information on command files, see the section
on the Command File database.

VERSION:
Use this drop-down list to select the PROM version of
the panel. This selection will change the number of card
digits that can be recognized by the panel and the
availability of certain hardware options. If unsure of the
version of the panel, check the firmware chip on the
panel’s circuit board.

STATUS (PANEL):
Active
Select Active if the panel is on-line and you are expecting
transactions from it or will be sending commands to it.
WIN-PAK will look for that panel every two minutes.

Inactive
Select Inactive if the panel is installed but communica-
tions are stopped to it for one reason or another. A
temporary file will be created that tracks additions,
modifications, and deletions to the card database. These
changes will be uploaded to the panel when it comes
back on-line.

 NOTE
When “N-4702” is selected
as Type, version should be
set to “Other.”
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Not Present
Select Not Present if the panel has not been installed,
but you anticipate that it will be in the future.

ENABLE OPTIONS SECTION

ANTI-PASSBACK

Anti-passback is used to discourage users from entering
with others without using their own cards. Cards must be
used at a designated “in” reader, then at a designated
“out” reader before the card can be “read in” again. If the
in/out/in pattern is broken, an anti-passback violation
would occur and access would be denied. A reader on
each side of the door is required for this option.

If anti-passback is enabled for any panel in a given area,
then the result is global anti-passback where the card
must be presented at any out reader before it can be
“read in” again without a violation.

FORGIVENESS
This option is used with panels configured with the anti-
passback option. Enabling Forgiveness resets all cards
at midnight so that if a card user leaves the building in
the evening without using the Anti-passback exit reader,
the person would be allowed a “normal” entry the next
morning. Without forgiveness, an anti-passback violation
would occur in this instance. This option is automatically
disabled when Anti-passback is disabled.

FREE EGRESS
Free egress allows for an exit without the use of a card,
usually by the means of a button, motion detector, or
other device. For example, with an N-1000-II, card
reader #1 activates one door, and card reader #2
activates a different door. Inputs #3 and #4 are reserved
for the exit devices for these two doors which release

 NOTE
Readers #1 and #3 are
considered the “in” readers
and Readers #2 and #4 are
considered the “exit”
readers. Readers #3 and
#4 are on the N-1000-IV (X)
only.
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locks just like a valid card read. The table below shows
how inputs are set for different panel versions.

Input to Output interlocks must also be defined for each
door. Input 3’s Alarm Action should be to Pulse  Output
1, and it’s Normal Action should be set to No Action .
Likewise Input 4’s Alarm Action should be to Pulse
Output 2, and it’s Normal Action should be set to No
Action . See Interlocking in the Input Points section for
more information.

tupnI

2074-N
008-N

II-0001-N III-0001-N VI-0001-N

1 etatS1rooD

2 etatS2rooD

3
1rooD
ssergE → 10

mralAlareneG etatS3rooD

4
2rooD
ssergE → 20

mralAlareneG etatS4rooD

5 mralAlareneG ssergE1rooD → 10

6 mralAlareneG ssergE2rooD → 20

7 mralAlareneG mralAlareneG
3rooD
ssergE → 30

8 rewoPyramirP mralAlareneG
4rooD
ssergE → 40

PANEL INPUTS
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SPLIT TIMEZONES
Enabling this option will allow you to associate a different
timezone for each reader in the Access Level database.
This requires that version 8.xx or higher firmware be in
the control panel and selected in the Version field
(above). Without this option enabled, only one timezone
will be associated with every reader on the panel in the
Access Level Database.

KEYPADS
Check this option if matrix style (11-wire) keypads are
used with the panel. If using Wiegand style (5-wire)
keypads, the keypad is treated as a reader and this
option should not  be selected.

PIN NUMBERS

This option can only be used if the Keypad option is
enabled. When this option is  enabled, a keycode must
be entered before  presenting a card to gain access.
This option should remain disabled if the panel is using
keypads without readers.

REVERSE READER LEDS

Check this option to reverse the standard LED operation
of the reader. With this checked, a reader that normally
changes from green to red upon a valid card read, will
change from red to green.

CONTINUOUS CARD READS
When this option is enabled, card readers read cards
continuously, independent of output pulse time. If the
option is not enabled, card readers do not recognize
valid cards while the corresponding output is energized.
For example, without  the Continuous Card Reads
option enabled and output #1 assigned a 10 second
pulse time, a valid card read at reader #1 causes output

 NOTE
When using 12 digit cards
with the NR-1 reader, the
reverse reader LED option
MUST be disabled.

 NOTE
The Split Timezones option
is available only when
version 8.00 or higher
firmware is selected for the
N-1000-II.

N-1000-III/IV panels require
8.2 version firmware which
the panel database will
default to when that panel
type is selected.
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#1 to energize for 10 seconds, during which time the card
reader does not recognize any other valid cards.

GROUPS

When this option is enabled, output relay groups can be
created. Groups allow cards to activate more than one
output relay for applications such as elevator control
(See Appendix C). When the Groups option is used with
Free Egress (“E” option), a valid card read pulses the
defined group at all readers. When the Groups option is
used WITHOUT Free Egress, a valid card read on
Reader 1(3) pulses the group, and a valid card read on
Reader 2(4) pulses Relay 2(4).

SITE CODES SECTION
Enter up to 8 site codes in this section. Site codes are
encoded with a card number on cards to ensure that
cards belong to the facility where access is attempted.
Click any space in the table to enter a site code. The
panel will not check for site codes if nothing is entered in
this table.

HARDWARE OPTIONS SECTION
Select which hardware options you will be configuring
with your panel. These options include add-on boards
which “supervise” by reporting a trouble condition if the
inputs or their wiring are tampered with. Northern
Computer’s AEP-5 is an example of this add-on board.
Select all that apply.

AEP-5 supervised input board (not utilized with the
N-1000-III or N-1000-IV)

ERB solid state relay board for outputs 9-12 (not
utilized with the N-1000-III or N-1000-IV)

AEP-3 8 output relays on a single board (2 pos-
sible)

 NOTE
If Northern’s AEP-3 is
selected, an AEP-3 (second)
option will appear for panels
with two AEP-3 boards.

 NOTE
Groups is automatically
selected if an AEP-3 is
selected from the hardware
options. See the Hardware
Options Section.

 NOTE
When the system is set up
for 12 digits, Site Codes
cannot be entered.
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ADVANCED...
Clicking this button allows the operator to select more
advanced panel options.

MULTIPLE INTERLOCK PROTECTION (MIP)
The Multiple Interlock Protection option requires that all
input points tied to a single output be returned to a
normal state to de-energize the point. Without MIP, only
one input needs to return to the normal state to de-
energize the output.

Click the option to turn it on and off. A bar over the
option with the option name reversed out, as shown in
the screen above, means the option is ON. This option
is defaulted as ON when using firmware 7.46 and newer.

POWER FAIL REROUTE
Enable this option to reroute the Power Fail alarm from
Input 8 to Input 19, which is System Alarm 3 in WIN-
PAK.

 NOTE
Power Fail Reroute will only
apply to N-1000 or N-800
panels using version 8.2
firmware and an AEP-5
board. Input 8 on an AEP-5
board can then be used as a
“wired” input.



DATABASES
Databases 75

SYS ALARMS...

Clicking this button allows the operator to define system
hardware alarms.

HARDWARE ALARMS
Select an alarm from the drop-down list to define. The
information filled in below will define the alarm currently
appearing in this box. Select from the following:

PPPPPanel Communicationsanel Communicationsanel Communicationsanel Communicationsanel Communications in alarm when the panel doesn’t sense
any current (or current below a specific
value) on the receive path of the loop
(specific to panel). This has a default
priority of 1.

AUX PAUX PAUX PAUX PAUX Portortortortort in alarm when the panel senses commu-
nication failure from the auxiliary port. This
has a default priority of 99.

PPPPPanel Primary Panel Primary Panel Primary Panel Primary Panel Primary Powerowerowerowerower in alarm when the control panel loses
primary power. This has a default priority
of 1.

 NOTE
The N-1000-II uses alarm
17 for Communication
Failure, alarm 18 for AUX
Port Failure, and alarm 8 or
19 for Power Failure. (see
Advanced Panel settings)
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Panel ResetPanel ResetPanel ResetPanel ResetPanel Reset in alarm when the panel is resetted. This
alarm cannot be stored in the history
buffer. N-1000-IIs must have 8.2 firmware
selected for the panel to report this alarm.
This has a default priority of 1.

PPPPPoll Responseoll Responseoll Responseoll Responseoll Response in alarm when WIN-PAK does not receive
a response to its poll (M=pn K) to the
panel. Three polling attempts are made. If
WIN-PAK doesn’t receive a response (OK
message) within those three attempts, it
will receive a Poll Response alarm. This
has a default priority of 1.

It is possible to define all of these one at a time. Select
an alarm and define it, then the next, and so on. The
following hardware alarms can also be configured if
you are defining an N-1000-III or N-1000-IV:

TTTTTamper Switchamper Switchamper Switchamper Switchamper Switch in alarm when the enclosure of the panel
is opened. This has a default priority of 1.

Ground FGround FGround FGround FGround Faultaultaultaultault in alarm when an input is shorted to the
Earth Ground. This has a default priority
of 1.

Low VLow VLow VLow VLow Voltageoltageoltageoltageoltage in alarm when the panel’s 12 volt battery
is low. This has a default priority of 1.

External 5 VExternal 5 VExternal 5 VExternal 5 VExternal 5 Voltoltoltoltolt in alarm when an External 5 Volt battery
has shorted. This has a default priority
of 1.

NORMALLY OPEN / NORMALLY CLOSED
The Normally Open / Normally Closed option is available
when defining the Panel Primary Power and Tamper
Switch hardware alarms. Use this option to define the
alarm’s normal status.

ALARM STATE

PRIORITY
Both Alarm and Normal conditions for the selected alarm
can be assigned a priority from 1 to 99. The Current

 NOTE
System Alarm interlocking is
unavailable in this version.
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View in Alarm Monitor allows you to view alarms by an
assigned priority. High priority items will appear at the
top of the list while lower priority items will appear lower
in the list.

Click in the priority box next to the status that you want
to prioritize and type in a number. “1” would be the
highest priority and “99” would be the lowest  priority.

MESSAGE

A descriptive message can be associated with each
alarm status. It will appear in the Alarm Info screen so
that the operator will have additional instructions pertain-
ing to the alarm status. Click in the message box next to
the status that you want to add a message to and type in
a message of up to 80 characters. You must press
Enter  or click on another box before clicking OK to
activate changes.

COMMAND FILE
A command file can be associated with each alarm
status. This file will be sent either when this condition is
received or upon acknowledgment as defined in the
Setup Options. Select the command file from the drop-
down list next to the status that you want to link a
command file to.

PRINT
Enable this option for every status that you want printed
to your alarm log printer.

HIST.
Enable this option for every status that you want kept in
the WIN-PAK history files. This keeps a log of the status
and can be used to generate reports. WIN-PAK defaults
all options to be included in history reports.

 NOTE
The System Alarm message
will appear in the Alarm Info
screen only and will not be
available in History View.
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TIMEZONES SCREEN

Clicking the Timezones tab opens the Timezones
Screen. This screen allows the operator to select which
timezones will be available at the panel.

The screen contains a list of all available timezones.
The user can select from the available timezones and
add them for use with that panel. By clicking on an
available timezone, the timezone is added to the Se-
lected Timezones list. If you click a timezone in the
Selected Timezones list, it is taken off the list and
returned to the Available Timezones list. You cannot
remove a selected timezone if it has been assigned to a
reader or alarm input point.

 NOTE
Up to 63 blocks of time (not
63 timezones) can be used
with each panel. In the
above example, Accounting

uses 3 blocks of time and
Shipping uses 1.
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A maximum of 63 “blocks” of time can be assigned to a
single panel. A block is a line containing a start time,
end time, and days valid. Each timezone may contain
several blocks, so WIN-PAK will warn you when you
exceed the maximum number.

 TIMEZONES BUTTON

This button jumps to the Timezone Database, so if the
operator starts defining a panel and realizes he needs to
define a timezone for it, he can do so without leaving the
Panel Detail. The Available Timezones list will automati-
cally update to include the new timezone. (See the
section on Timezones for more information).
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READERS SCREEN

Clicking the Readers tab opens the Readers Screen
allowing the operator to configure each individual
reader for the panel being defined. The number of
readers available is dependent upon the panel “Type”
selected in the Panels screen.

READER

The reader list contains all readers available for the
panel you are defining. The text entry space at the top of
the list contains the name of the currently selected
reader. All options made in the sections below apply
specifically to this reader.

 NOTE
Information defined in the
Reader Screen applies only
to the selected reader.

 NOTE
If you rename the reader,
continue to include in the
name a reference to the
panel. Readers on different
panels cannot share the
same name.
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Readers are given the default names of the panel and
number of the reader. For example, Panel1 R 2  would
be the default name for the second reader of the panel
named Panel1. Each reader must have a unique name
in the entire system. Therefore, it is good to leave these
names because they are descriptive and unique, but
they can be changed if desired. Simply select the reader
from the list and type in a new name of up to 25 charac-
ters.

ACTIVE

In order to select any options for a reader, it must be
made Active. To do this, select the Active box so that a
“ü” appears in the box. This will also make it available
to the Access Level database.

ADDRESS
This field will automatically display the address of the
reader selected. This is helpful if the reader address is
not contained in it’s name. This field is not changeable.

FLOOR PLAN
Not used at this time.

VIEWING MONITOR
Use this drop-down list to select a viewing monitor to be
associated with this reader. You must have defined
records in the Monitors Database to use this feature.
Use this item together with the Camera to View item
(below) for CCTV supervision of a reader. The selected
monitor will display the camera view below when the
priority of either the card or the reader status exceeds
the Acknowledge threshold.

 NOTE
A camera and monitor can
switch to the view defined in
this screen when a status is
received or upon acknowl-
edgment. Select your
preference from the Options
dialog in the Setup Menu.
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CAMERA TO VIEW
Use this drop-down list to select a camera to be associ-
ated with this reader. You must have defined records in
the Camera Database to use this feature. The selected
camera view will be displayed on the monitor above
when the priority of either the card or the reader status
exceeds the Acknowledge threshold.

The Valid and Invalid Read sections are used to define
how particular card read conditions at the reader level
will be interpreted and acted upon. For each type of
read status there is the option of assigning a priority, a
message, and a command file. Each type of read status
can also be set to print to the alarm log printer and be
included with history information for reporting pur-
poses.

VALID READS
Valid reads are when a card is presented and allowed
access because it is assigned the proper access level.
This will usually return a “normal” condition to WIN-PAK.
The exception is if the card is given a “Trace” status in
the Card Database – it will then return a “trace” condition
when presented.

INVALID READS

Invalid reads are when a card is presented, but not
allowed access. This may be for a variety of reasons,
each of which can be assigned a different set of options:

A “Timezone” condition is sent when the card was used
outside of it’s valid timezone.

A “Not found” condition is sent when the panel does not
recognize the card number. Usually this means the card
is not in the panel or was never validated or given
access to that reader.
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A “PIN” condition is sent when an incorrect PIN number
is entered where card presentation and PIN entry is
required.

A “Site code” condition is sent when a card with an
incorrect site code is presented.

An “Expired” condition is sent when a card is presented
after it’s expiration date or after the allotted number of
uses (as defined in the Card Database and System
Setup).

An “Anti-passback” condition is sent when an anti-
passback violation has occurred in panels with this
option enabled.

Both Valid and Invalid reads can be assigned the fol-
lowing options:

PRIORITY
The condition can be assigned a priority from 1 to 99.
The Current View in Alarm Monitor allows you to view
alarms that meet the alarm acknowledgement threshold
(in the Setup Options), by an assigned priority. High
priority items will appear at the top of the list while lower
priority items will appear lower in the list.

Click in the priority box next to the status that you want
to prioritize and type in a number. “1” would be the
highest priority and “99” would be the lowest  priority.

MESSAGE
A descriptive message can be associated with each
status. It will appear in the Alarm Info View of the Control
Monitor, or in the AutoCard lookup, so that the operator
will have additional information regarding that type of
card read at that reader. Click in the message box next
to the status that you want to add a message to and type
in a message of up to 80 characters.

 NOTE
A similar arrangement can
be found in the Card
Database where the action is
based on the individual card
status. The “reader” or
“card” with the highest
priority will dictate the
message WIN-PAK will give.
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COMMAND FILE
A command file can be associated with each status. This
file will be sent either when this condition is received or
upon acknowledgment as defined in the Setup Options.
Select the command file from the drop-down list next to
the status that you want to link a command file to.

PRINT
Enable this option for every status that you want printed
to the alarm log printer.

HIST.

Enable this option for every status that you want kept in
the WIN-PAK history files. This keeps a log of the status
and can be used to generate reports.

 NOTE
If a command file has also
been selected for a card in
the Card Database, then
both the reader and card
command files will be sent.

The reader command file
has priority and its com-
mand file will be sent first.
Then the cards command
file will be sent.
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INPUT POINTS SCREEN

Clicking the Input Points tab opens the Input Points
screen allowing the operator to define all input points
for the panel. Below is how this tab will look for an N-
1000-III or N-1000-IV panel.

INPUT POINT

The input point list contains all input points available for
the panel you are defining. The text entry space at the
top of the list contains the name of the currently selected
input point. All options made in the sections below apply
specifically to this input point.

 NOTE
If you rename the input
point, continue to include in
the name a reference to the
panel. Input points on
different panels cannot
share the same name.
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Input Points are given the default names of the panel and
number of the input point. For example, Panel2 I 4  would
be the default name for the fourth input point of the panel
named Panel2. It is good to leave these names because
they are descriptive, but they can be changed if desired.
Simply select the input point from the list and type in a
new name of up to 20 characters.

ACTIVE

In order to select any options for an input point, it must
be made Active. To do this, select the Active box so that
a “ü” appears in the box. If “Free Egress” was selected
as an option in the Panel Screen, some input points will
automatically be made active and reserved for these
devices. See Appendix B for more information on
interlocking for a free egress.

ADDRESS
This field will automatically display the address of the
input point selected. This is helpful if the input point
address is not contained in it’s name. This field is not
changeable.

SUPERVISED
Enable the supervised function if the input point is
electrically wired to prevent tampering. This option is
only available when defining an N-1000-III or N-1000-IV
panel.

NORMALLY OPEN / NORMALLY CLOSED
Determined the status of the alarm circuits when in a
“normal” state. This option is only available when
defining an N-1000-III or N-1000-IV panel.

 NOTE
Points that are not active will
respond as if the “Silence
Alarms” (see below) option
was enabled. If you wish to
monitor Primary Power on
an N-1000/N-800 panel with
versions 7.0, 7.3, 7.46,
7.48, 7.49, or 8.0 firmware,
then Input 8 must be made
active.

If using version 8.2 firm-
ware, then check panel’s
Advance setting to see if
input 8 is used for Primary
Power.
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SILENCE ALARMS
Enable this option to turn off alarm point reporting associ-
ated with the input (such as with an egress device).

DEBOUNCE TIME
Debounce Time is the length of time (in seconds) that an
input must be in alarm condition (or returned to normal)
before it is recognized as an alarm (normal). For ex-
ample an input point with the debounce time of 5 must
be in alarm condition for five seconds before it is re-
ported as an alarm. The same is true when returning to
the normal condition. The point would not report as
normal until it was in the normal state for five seconds.
This can be set from 0 to 255 seconds.

SHUNT TIME

Shunt time refers to the amount of time (in seconds) that
the input point is shunted (deactivated) when triggered,
such as upon a valid card read. This can be set from 0
to 63 seconds.

TIMEZONE

Select a timezone from this drop-down list if you would
like the input point to be automatically shunted during a
particular timezone. This list contains only the timezones
in the Selected Timezones list from the Timezones
Screen of this panel.

FLOOR PLAN
Not available at this time.

VIEWING MONITOR
Use this drop-down list to select a viewing monitor to be
associated with this input. You must have defined
records in the Monitor Database to use this feature. Use

 NOTE
A camera and monitor can
switch to the view defined in
this screen when a status is
received or upon acknowl-
edgment. Select your
preference under Send

Command File from the
Options dialog in the
Setup menu.



88 Win PAK 1.15 User Manual

this item together with the Camera to View item (below)
for CCTV supervision of an input. The selected monitor
will display the camera view below when a change of
state occurs at the alarm point.

CAMERA TO VIEW

Use this drop-down list to select a camera to be associ-
ated with this input. You must have defined records in
the Camera Database to use this feature. The selected
camera view will be displayed on the monitor above
when a change of state occurs at the alarm point.

INTERLOCKING
Interlocking, in the case of inputs, is linking the changing
state of the input to either another input, an output, or a
group of outputs. Enable Interlocking for this input by
clicking in the Interlocking box. An “ü” will appear and
the entire section can then be edited.

1. Select whether you want to interlock to an
output (output group) or an input. This will
determine which points and groups are
available in the Point List (below).

2. Select the name of the point from the Point
drop-down list that you want to interlock to.

3. Select how you want the second point to take
action when the initial input goes into alarm
status from the Alarm Action drop-down list.

4. Select how you want the second point to take
action when the initial input goes into normal
status from the Normal Action drop-down box.

See Appendix B for the actions that can be chosen and
more information on interlocking.

 NOTE
Inputs, Outputs, and Groups
must be made “active” to
appear in the drop-down list
for interlocking.

 NOTE
Defaults will be created for
interlocks if the “Free
Egress” option has been
enabled. These fields can be
modified if needed.
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ALARM STATE SECTION

An input point must be in one of four states: Alarm,
Normal, Door Ajar, or Trouble.

Alarm When a device attached to an input point is in
alarm condition.

Normal When a device attached to an input point is in
normal operating condition.

Door Ajar When a door contact is open longer then it’s
shunt time.

Trouble When an alarm circuit is out of specified toler-
ance which may indicate tampering or other
“troubles” with the alarm point.

Each of these states can be assigned a priority, a
message, and a command file as well as be included in
real-time printing and History Reports.

PRIORITY

The state can be assigned a priority from 1 to 99. The
Current View in Alarm Monitor allows you to view alarms
by an assigned priority. The higher the priority the closer
the alarm will appear to the top of the list.

Click in the Priority box next to the status that you want
to prioritize and type in a number. “1” would be consid-
ered a very high priority item and “99” would be
considered a very low priority item.

MESSAGE

A message of up to 80 characters can be defined for
each state. This message will appear in the Alarm Info
screen for the input. Simply click in the Message box
next to the state that you want to link a message to and
type it in.

 NOTE
A priority of 0 is displayed in
the Alarm Monitor when a
new panel is brought on-
line. Once WIN-PAK fully
initializes the panel, the
defined priorities are then
applied.

 NOTE
The Trouble state only
appears in N-1000-II panels
where the AEP-5 is selected
in the Hardware Options of
the Panel Screen. It is
always available when
defining an N-1000-III or N-
1000-IV panel.
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COMMAND FILE
A command file can be associated with each state. This
file will either automatically be sent when this state is
received or upon acknowledgment as defined in the
System Setup options. Select the command file from the
drop-down list next to the status that you want to link a
command file to.

PRINT
Enable this option for every alarm state that you want
printed to the alarm log printer. An “x” shows that it is
enabled.

HIST.

Enable this option for every state that you want kept in
the WIN-PAK history files. This keeps a log of the state’s
occurrences and can be used to generate reports. An “x”
shows that it is enabled.



DATABASES
Databases 91

OUTPUTS POINTS SCREEN

Clicking the Output Points tab opens the Output Points
Screen allowing the operator to define all output points
(groups) for the panel.

OUTPUT POINT

The output point list contains all output points and
groups (previously defined) available for the panel you
are defining. The text entry space at the top of the list
contains the name of the currently selected output point
(group). All options made in the sections below apply
specifically to this output point (group).

 NOTE
An N-4702 panel can only
utilize outputs one and two,
even though WIN-PAK
allows you to program
twelve outputs.

 NOTE
If you rename the output
point, continue to include in
the name a reference to the
panel. Output points on
different panels cannot
share the same name.
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Output points are given the default names of the panel
and number of the output point. For example, Panel4 O
3 would be the default name for the third output point of
the panel named Panel4. Groups are given the default
names of the panel and number of the group. For
example, Panel4 G 1  would be the default name for the
first group of the panel named Panel4. It is good to leave
these names because they are descriptive, but they can
be changed if desired. Simply select the output point
from the list and type in a new name of up to 20 charac-
ters.

Active outputs above 14 are defined by attaching them
to a “group.” The “group” can then be programmed as
an output.

ACTIVE

In order to select any options for an output point, it must
be made Active. To do this, select the Active box so that
an “x” appears in the box. This will ensure that the
output will appear in other components of WIN-PAK (i.e.
Groups, Interlocks, and Panel Control). If “Free Egress”
was selected as an option in the Panel Screen, some
input points will automatically be made active and
reserved for these devices. See Appendix B for more
information on interlocking for a free egress.

PULSE TIME
The Pulse Time is defined as the amount of time an
output pulses when triggered, such as upon a valid card
read. Set this from 0 to 63 seconds.

TIMEZONE
Select a timezone from this drop-down list if you would
like the output point or group to be automatically ener-
gized during a particular timezone. This list contains only
the timezones in the Selected Timezones list from the
Timezones Screen of this panel.



DATABASES
Databases 93

ADDRESS
This field will automatically display the address of the
output point selected. This is helpful if the output point
address is not contained in it’s name. This field is not
changeable. Groups are denoted with a “100” number.
For example, Group 1’s address is “101”.

tuptuO VI-0001-N III-0001-N II-0001-N

10 1rooD 1rooD 1rooD

20 2rooD 2rooD 2rooD

30 3rooD yrailixuA yrailixuA

40 4rooD yrailixuA yrailixuA

50 yrailixuA yrailixuA yrailixuA
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*Not available when an AEP-3 is used.
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INTERLOCKING
Interlocking, in the case of outputs, is linking the chang-
ing state of the output to either another output, an input,
or a group of outputs. Enable Interlocking for this output
by clicking in the Interlocking box. A “ü” will appear and
the entire section can then be edited.

1. Select whether you want to interlock to an
output (output group) or an input. This will
determine which points and groups are
available in the Point List (below). Outputs 17-
32 cannot be interlocked to directly because
they are not physically located on the panel.
However, once that output is in a group, the
group can be interlocked.

2. Select the name of the point from the Point
drop-down list that you want to interlock to.

3. Select how you want the second point to take
action when the initial output goes into an
“on” status from the ON Action drop-down list.

4. Select how you want the second point to take
action when the initial output goes into an
“off” status from the OFF Action drop-down
box.

See Appendix B for the actions that can be chosen and
more information on interlocking.

 NOTE
Inputs, Outputs, and Groups
must be made “active” to
appear in the drop-down list
for interlocking.

 NOTE
Defaults will be created for
interlocks if the “Free
Egress” option has been
enabled. These fields can be
modified if needed.
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GROUPS SCREEN

If the Groups option is enabled in the options section of
the Panels Screen, then clicking the Groups tab will
open the Groups Screen allowing the operator to define
groups of output points.

GROUP

A group is one or more active output points “grouped”
together. The group list contains 32 possible groups
available for the panel you are defining. The text entry
space at the top of the list contains the name of the
currently selected group. The Selected Output Points list
(below) applies specifically to this group.

 NOTE
If you rename the group,
continue to include in the
name a reference to the
panel. Groups on different
panels cannot share the
same name.
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Groups are given the default names of the panel and
number of the group. For example, Panel2 G 7  would be
the default name for the seventh group of the panel
named Panel2. It is good to leave these names because
they are descriptive, but they can be changed if desired.
Simply select the group from the list and type in a new
name.

ACTIVE

In order to select output points for the group, it must be
made Active. To do this, select the Active box so that an
“ü” appears in the box. The group will then appear in
other components of WIN-PAK.

AVAILABLE OUTPUT POINTS AND SELECTED OUT-
PUT POINTS
The list of Available Output Points contains all active
output points defined in the Output Points screen of this
panel. Clicking an output point in this list will add it to the
Selected Output Points list for the selected Group.
Clicking it in the “Selected” list will remove it.

To define the group’s timezone control, pulse times, and
interlocking, return to the Output Points Screen and
select the group from the list of points. The group
number will have an address of 101 or greater.

Select Timezone, Pulse Time, and Interlocking as
outlined in the Output Points Screen section of the
manual.

DELETING A PANEL
1. Select the panel you want to delete with the

mouse and click the Delete button. Verify that you
have taken all the proper steps outlined in the
confirmation box. If you are sure you want to
delete the panel, click OK.

 NOTE
Output points must be made
active in the Output Points
screen before they will be
listed in the Available Output
Points list.
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The record will continue to appear in the data list
although it will be “grayed”. New records will not be
able to use it’s key fields (i.e. name or number) until the
database is packed (see Chapter 7).
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THE SCHEDULES DATABASE

The WIN-PAK Schedules Database can be used to
execute a number of WIN-PAK functions at scheduled
times. The following four functions can be scheduled to
happen at regular intervals:

Panel Time & Date UpdatePanel Time & Date UpdatePanel Time & Date UpdatePanel Time & Date UpdatePanel Time & Date Update
This scheduled event will automatically contact every
direct connected (hardwired) panel and upload your
computers time & date.

Backup ReminderBackup ReminderBackup ReminderBackup ReminderBackup Reminder
This scheduled event will pop up a reminder for you to
back up your WIN-PAK database and history files.

Auto Dial-UpAuto Dial-UpAuto Dial-UpAuto Dial-UpAuto Dial-Up
This scheduled event will automatically contact dial-up
panels. When this is selected, the second tab labeled
Auto Dial-Up becomes available for selecting dial-up
options (see below).

Card Activation & DeactivationCard Activation & DeactivationCard Activation & DeactivationCard Activation & DeactivationCard Activation & Deactivation
This scheduled event will automatically check activa-
tion and deactivation dates for cards and update the
card status accordingly. For this option to work, the
Card Activation & Deactivation by Scheduler option
must be enabled in WIN-PAK Setup and cards must
be assigned activation and deactivation dates.

The Schedules Database can be opened by selecting
Schedules... from the Database menu. Add a sched-
uled function by filling out the fields as described
below.

 NOTE
For remote panels, the cards
will be sent and stored in a
temporary file. When
WIN-PAK see’s the panel(s)
are on-line, either through
auto-dialup from the
scheduler or if the user
connects manually, the
commands in the temporary
file will be sent, updating the
cards if Send Commands

was checked.
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NAME
Type a name for the Schedule in the text entry box.

TYPE
From the dropdown box, select the type of scheduled
event that you want to define. You can select from Panel
Time & Date Update, Backup Reminder, Auto Dial-up, or
Card Activation & Deactivation.

FREQUENCY
From this dropdown box, select how often the scheduled
event should take place. You can select Once, Every
Hour, Every Day, Every Week, Every Two Weeks, Every
Month, or Never.

NEXT DATE/TIME

Enter the next date and time that the event should take
place. The ellipses button will open up a month dialog.
Navigate to the month that you want to start the event
and select the appropriate date.

Use the time text entry boxes to enter the time that you
want the event to happen. The first box is the hours (in
24 hour format) and the second box is minutes. Use the
arrow keys to increment/decrement the numbers by 1.

 NOTE
Windows ‘95 supports
Daylight Savings Time
changes. Set Time & Date
Update to occur one minute
after ‘95 changes the time
and date. Then reset
Frequency and Time to your
normal requirements until
the next DLST time change.
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If Auto Dial-Up is selected from the Type dropdown list,
the second tab labelled Auto Dial-Up will be accessible.
Click on this tab to bring up the Auto Dial-Up screen.

REMOTE AREA
Select the area that you want to dial from this drop-down
list. This list consists of all areas defined in the Areas
Database as “Remote” sites.

UNBUFFER OPTION
Enable this option if you want to unbuffer all panel
transactions from the remote site with the defined
schedule.

SEND COMMANDS OPTION
Sends stored card commands to the remote panels,
such as card additions and deletions, and or cards that
have been activated or de-activated from the Scheduler
Database.

SEND DATE & TIME OPTION

Sends the computer’s date and time to the remote
panels.
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Click OK to save the change or Cancel to quit without
saving the schedule.
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THE GUARD TOURS DATABASE

The WIN-PAK Guard Tours database is used to define
tours that a guard can patrol to help secure a facility.
Defined tours allow the guard a certain amount of time
to present a card to each reader on his route. Early or
late arrivals to a reader produce an alarm message in
WIN-PAK. To open the Guard Tour database, select
Guard Tours... from the Database menu. This will
open up the Guard Tours Data List.

The Guard Tours Data List shows each guard tour
represented with a folder. When the folder is opened
(clicked on), the detailed information on the tour can be
viewed. The detailed information shows the check
point readers (in sequence), with the time allowed to
get there from the previous check point. Tolerances for
early and late arrival are also given.

Under the Data List is the sorting order of the list. By
clicking the drop-down list button, you can select how
you want to sort the guard tours for viewing. This
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database allows you to sort by the order in which the
records were entered (None) or alphabetically by name.

When sorted by Guard Tour, a tour can be searched for
by entering the name in the search box and clicking the
Search button (  ).

ADDING OR EDITING A GUARD TOUR
Click Add... to enter a new guard tour or Edit... to
modify the currently selected guard tour. This will
bring up the Guard Tour Detail window.

GUARD TOUR
Enter the name of the guard tour in the text entry box.
The name can be a descriptive name containing up to
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twenty characters with any combination of letters,
numbers, or spaces.

AVAILABLE CHECK POINTS

This list contains all readers defined and made active in
the Panel Database. Click on the readers in this list that
you want to include in the tour. They will be added to the
Selected Check Points list.

SELECTED CHECK POINTS
This is the list of readers selected to be in the guard tour
from the list of Available Check Points. Readers may be
selected from the list of Available Check Points more
than once. The order of the check points can be
changed by selecting a reader and using the Move Up
and Move Down  buttons at the bottom of the window.
The Move Up  button moves the check point further
ahead in the tour, and the Move Down  button moves it
later in the tour.

To remove a check point, select it and click the Delete
button.

Time

The Time column allows you to enter an amount of time
required to reach each check point. This time would be
from the start of the tour for the first check point, and
from check point to check point for the rest of the tour.
Click on the check point in the Time column and enter
the duration as hours : minutes.

( + ) and ( – )

For the time needed to reach each check point, a
tolerance for late and early arrival can be given. Click on
the check point in the ( + ) column and enter the amount
of time tolerated for late arrival as hours : minutes. Click

 NOTE
Typing a number less than
60 and hitting Enter will be
registered as minutes. For a
longer period of time, type
the number of hours, a
colon (:) and the number of
minutes, and hit Enter.
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on the check point in the ( – ) column and enter the
amount of time tolerated for early arrival as hours :
minutes.

Example

In this screen, the guard has 5 (10-5) to 12 (10+2) minutes
from the start of the guard tour to reach the reader at the
Loading Dock Entrance. The guard then has 10 (15-5) to
17 (15+2) minutes to reach the reader at the Sales Area
Entrance.

CHECK POINT ALARMS
Two check point alarms are possible. An Early Arrival
alarm is sent to WIN-PAK when the card is presented at
a reader before the time allotted. A Late Arrival alarm is
sent when the card is not presented within the time
allotted. Both of these alarms can be assigned a priority,
a message, and a command file as well as be included
in log printing and history reports.

PRIORITY

The alarm can be assigned a priority from 1 to 99. The
Current View in Alarm Monitor allows you to view alarms
by an assigned priority. The higher the priority (lower
number) the closer the alarm will appear to the top of the
list.

Click in the Priority box next to the alarm that you want
to prioritize and type in a number. “1” would be consid-
ered a very high priority item and “99” would be
considered a very low priority item.
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MESSAGE
A message of up to 80 characters can be defined for
each alarm. This message will appear in the Alarm Info
screen for the alarm. Simply click in the Message box
next to the alarm that you want to link a message to and
type it in.

COMMAND FILE
A command file can be associated with each alarm. This
file will either automatically be sent to the panel when
this alarm is received or upon acknowledgment as
defined in the System Setup options. Select the com-
mand file from the drop-down list next to the alarm that
you want to link a command file to.

PRINT

Enable this option for each alarm that you want printed
to the alarm log printer. An “x” shows that it is enabled.

HIST.

Enable this option for each alarm that you want kept in
the WIN-PAK history files. This keeps a log of the
alarm’s occurrences and can be used to generate
reports. An “x” shows that it is enabled.

DELETING A GUARD TOUR
1. Select the guard tour that you want to delete with

the mouse and click the Delete button. If you are
sure you want to delete the guard tour, click OK
when the confirmation box asks you.

 NOTE
You cannot delete a tour that
is currently running.
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THE TRACKING AREAS
DATABASE

Tracking Areas are sections of a facility that are defined
by the readers that allow access to the area. Unlike
Areas that we defined in the Areas Database, Tracking
Areas are not related to the loops that carry communi-
cation through an access control system. They are,
rather, defined by a system administrator to logically
determine the sections of a facility, and are an integral
part of a WIN-PAK function called mustering. Muster-
ing allows the operator to view the cards that have
entered into these defined areas. This is particularly
useful for tracking individuals in emergency situations.

Example

A

B
C

D

1

3
2

4 9

6

5

87

In this diagram, A, B, C, and D are Tracking Areas. If
each area is distinct and not “nested”, (a concept
described later in this chapter), then the area is defined
by the readers that a card must be presented at to gain
access to the area. Readers 1, 4, and 9 allow access to
Tracking Area A. Readers 3 and 6 allow access to
Tracking Area B. Reader 5 allows access to Tracking
Area C and Reader 8 allows access to Tracking Area D.

 NOTE
Tracking Areas can also be
used as a list or grouping of
readers to restrict reporting
information. (as in “History,
Cards” and Attendance
Reports)
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MUSTER SYSTEM PRECAUTIONS
When designing a muster system for use with WIN-PAK,
it is important to keep the following precautions in
mind:

1. Use a separate dropline (COM port) to isolate the
muster readers from the tracking units. A special
line should be run to provide a unique data path
that will still be intact should the wiring from the
main facility get damaged.

2. A “cold restart” of the access control panel could
occur from a serious surge on the power or
communication lines. This can cause corruption of
the panel’s database and time functions. Version
8.01.10 and higher firmware address the time
problem by generating a system alarm 99 (Panel
Database, System Alarms, Panel Reset Alarm) when
the panel experiences a cold restart. WIN-PAK will
then send the current Time and Date to the panel
within 60 seconds of receiving this alarm. The
default time and date after a cold restart is January
1st, Monday at 12:00am. You will be able to see
this time stamp on activities in the History view.
Panel Time is critical to the proper operation of the
Muster function as the most recent event is used to
determine the Tracking/Muster status of a Card
holder. If a card is presented to the Muster reader
and the time and date stamp is earlier than from
another reader location, there will not be a change
of status to the Muster (safe) location.
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3. In the event that the card database is lost or
corrupted at the muster reader, WIN-PAK will
recognize all reader types (Not Found, Time Zone,
Normal, Trace, Pin Violation, and Expired) as
“valid” muster reads (provided that the time is later
than the previous card read as described above).
This function will prevent the need to reload the
cards to a muster panel during a muster event.
Only Valid and Trace card reads will count at a
Tracking reader.

4. The communication loops should be RS-485. WIN-
PAK should have corresponding Areas defined as
RS-485 with ACK-NAK enabled. If using N-485-
API-2s, they must be powered by a battery backed
up power supply (not required for N-1000-III or N-
1000-IV where the 485 is built into the control
panel and is already using the battery backup of
the control panel).

5. An UPS or other backup power source should
power the WIN-PAK computer, N-485-PCI-2 and
other associated communication devices.
Installation of the equipment should be in a
location that is considered “safe” from known
hazards.

6. The muster system should be on-line (not buffered)
to ensure timely and complete information.
Regular checks to insure that the muster system is
functioning properly should be performed as part
of the security routine and should be rigorously
enforced.
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7. As mentioned above, it is critical that the time and
date be correct on card reads at the Muster readers.
If the time and/or date are earlier than that of other
reads in the system they will be ignored. For this
reason, regular checks should be made to see that
all panels are maintaining the correct time and
date. The checklist for actions to be performed at
the computer during the time of the muster should
include several checks to be sure that the muster
reads are coming in from the panel with the correct
time and date. If it is observed that they are not,
officials should order the swiping of cards stopped,
and the time and date should be sent to the panel.
A quick test should then be run and all people who
might have swiped their card during a time when
the time and/or date were incorrect should be
directed to repeat their swipe. Multiple swiping of
the same card at the Muster reader will not
adversely affect the result of the Muster as the
most recent time/date stamp is the one that is
“displayed” in the Muster section. This procedure
should be practiced regularly, so personnel have a
clear familiarity with it. The Scheduler should also
be programmed to update time and date at least
once a day.



DATABASES
Databases 113

The Tracking Areas Database can be accessed by selecting
the Tracking Areas... option from the Database menu.
This will open the Tracking Areas Data List.

The Data List contains the names of all defined tracking
areas and their type. Clicking on a tracking area folder
will show the readers that define it.

Under the Data List you will see the sorting order of the
list. By clicking the drop-down list button, you can
select how you want to sort the tracking areas for
viewing. This database allows you to sort by the order in
which the records were entered (None) or alphabetically
by name.

When sorted by Tracking Area, an area can be searched
for by entering the name in the search box and clicking
the Search button (  ).

ADDING OR EDITING A TRACKING AREA
Click Add... to enter a new tracking area or Edit... to
modify the currently selected tracking area. This will
bring up the Tracking Area Detail window.
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TRACKING AREA

Enter a name for the tracking area in the space pro-
vided. It can consist of twenty characters including
letters, numbers, and spaces.

TYPE

Areas that can be set up fall under one of three categories:
Exit Areas, Tracking Areas, and Muster Areas. Below are a
description of each.

EXIT AREA

When you first view the Tracking Areas Data List you will
notice a predefined area called EXIT. It is defined by a
reader or group of readers that are used to remove card
read records from the tracking and muster areas. The
perception of this “area” is that when a person presents

 NOTE
The Exit area is also used in
the Attendance Report to
indicate an end to a calcula-
tion.
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a card at one of these readers, they have left the areas
of concern (e.g. they have gone home, or to another
facility). They will no longer be tracked in reference to a
possible muster call. This option can be edited to add or
remove readers, but the area itself cannot be deleted.

TRACKING AREA

A tracking area is an area containing readers at which
presented cards are tracked in case of a muster call.
The first time a person presents a card at one of these
readers, the read event for that particular card is re-
corded and may be viewed in the “Non-Muster Card
Transactions” screen. Each time that same card is
presented at one of the readers in that area, the previ-
ous record for that card is replaced by the new record.
The screen will display the most recent records of  card
reads from an individual area or from all areas at one
time. Reports can be generated in the same manner. All
reads from each card will continue to be tracked in a
similar manner until the card is presented at a muster
reader or an exit reader. When a card is presented at a
muster reader, the record of the card is moved to the
Muster Area Screen.  When a card is presented at an
exit area reader, it is removed from the muster system.

MUSTER AREA
Like tracking areas, muster areas are also logical areas,
not defined by the hardwiring of the system.  They
contain readers that will only  be used by card users if
there is a call for muster (in the event of a disaster, for
example). Several different muster areas can be cre-
ated. The Muster Area Card Transaction screen will
display card read events.  A report can be run on cards
presented in an individual muster area or at all muster
areas. In normal conditions there will be no transactions
being recorded in the Muster Area Card Transaction
screen. It will only be used if there is a muster call
(usually in an emergency).

 NOTE
Tracking area definitions can
also be used in Card/History
Reports and Attendance
Reports.
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DEFINING READERS

AVAILABLE READERS

Along the left of the Tracking Areas Detail Window are all
readers that are available to define the area. Click on a
reader to move it to the Selected Readers List.

Readers selected for a muster area will not be available
for any other muster area or a tracking area. Readers
selected for a tracking area will be available for other
tracking areas, but will NOT be available for a muster
area.

SELECTED READERS

As readers are clicked on from the Available Readers
list, they are moved to this list. These are the readers
that define the area. To remove readers from this list,
select them and click the Delete  button.

Click OK to save your changes to the Tracking Area or
Cancel to exit the Tracking Areas Detail screen without
saving your changes.

NESTING  AREAS
The concept of nesting is not unique to the muster
system, but does take on considerable significance
when planning areas for disaster management, and can
change the way muster reports will be run.  When an
area is considered “nested” in another area, its readers
are also part of that other area.  For example, note the
diagram below.
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The first general principle of nesting is that readers used
to enter an area or move about within the area should be
listed under the tracking area in the Tracking Areas
Database.  If we focus on the B and C areas shown
above, we can consider those areas in two ways.

NOT NESTED
If they are not nested, then Readers 3 and 6 would be
listed for Area B in the database because those are the
readers that a card would be presented at to allow
access to Area B. Reader 5 would be listed for Area C.

NESTED
If we consider these same areas to be nested, we would
consider anyone who is in Area C as ALSO in Area B.
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In that case, we list Readers 3, 5, and 6 under Area B and
Reader 5 again under Area C.  There can be many levels of
“nesting”.  There could be another room inside of  Area C,
which would be Nested under both B and C.

The diagram would have the following Tracking Area
definitions when nesting:

Tracking Area A  Readers 1, 3, 4, 5, 6, 8, 9
(Presenting at any of these readers shows the person in
Tracking Area A. Readers 2 and 7 both leave Tracking
Area A.)

Tracking Area B  Readers 3, 5, 6
(reader 4 leaves Tracking Area B)

Tracking Area C  Reader 5
(reader 6 leaves Tracking Area C)

Tracking Area D  Reader 8
(reader 9 leaves Tracking Area D)

Reader E (Exit Reader)
Reader E causes the cardholder information to be
deleted from the non-muster or muster view screens.
The card holder has exited the tracking area.

Reader M (Muster Reader)
Reader M causes card holders to appear in the muster
view screen as per selected filter. It also removes card
holders from the non-muster view.
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THE ACCESS LEVEL DATABASE

Access Levels determine where and when a user’s card
will be valid in the system. An access level represents
the readers that a card user can present cards to and the
time period during which he can present them to gain
access. When a card is defined in the card database, it
is assigned an access level. The ability to assign cards
to a group of doors eliminates the need to program the
card for every reader.

Select Access Levels... from the Database menu to
open the Access Level Data List.

The Access Level Data List shows the Access Level
records that have been defined. Clicking on a record’s
folder shows details of the access level including which
readers and timezones are utilized, and a group name
(if defined). This list is sortable by the order in which
the records were entered (None) or alphabetically by
Access Level Name.
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When sorted by Access Level, an access level can be
searched for by entering the name in the search box and
clicking the Search button (  ).

ADDING OR EDITING AN ACCESS LEVEL
Click Add... to enter a new access level or Edit... to
modify the currently selected access level. This will
bring up the Access Level Detail window.

ACCESS LEVEL
Type in a name for the access level of up to 20 charac-
ters including letters, numbers, and spaces.

AVAILABLE READERS
All of the readers made “active” in the Panel Database
appear in this list. To include the reader in your access
level definition, click on it from this list. A Selected
Reader Definition box will appear:

 NOTE
When an access level has
been changed, the affected
panel should be re-initialized
or the cards manually
updated.
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The reader name will appear at the top of this box. All
timezones defined for this reader’s panel  are listed
under Timezone on the left. All groups defined for this
panel are listed under Group on the right.

TIMEZONE
Select the timezone during which you want a person with
this access level is to have access though this reader.

GROUP
Select the output group that a person with this access
level is to be able to activate. The LAST SELECTED
group for a reader on the same panel will overwrite the
other groups – there cannot be split groups on the same
panel.

Click OK to save or Cancel to return to the Access Level
Detail without saving.

The Reader, Timezone, and Group are now a part of the
Selected Readers list. To remove a reader from the list,
select it and click Delete. To change its timezone or
group, click on Define Selected Reader.

 NOTE
When Split Timezones is
enabled in the panel options
for panels with version 8.xx
or higher firmware, you will
be prompted for a timezone
for each selected reader.

On older version firmware,
the timezone will default to
the same as the previously
selected reader for that
panel.

 NOTE
Free Egress (“E” option) will
determine how the panel
responds to the group. See
your panel documentation
for more information.



122 Win PAK 1.15 User Manual

SAVE AS...

Clicking the Save As... button allows you to save the
current Access Level under a different name. This
allows you to create new Access Levels based on exist-
ing ones with similar attributes.

NEW ACCESS LEVEL NAME

Type in a name for the new access level of up to 20
characters.

Click OK to save the new access level or Cancel to
return to the Access Level Detail without saving.

DELETING AN ACCESS LEVEL
1. Select the access level to be deleted with the

mouse and click the Delete button. If you are sure
you want to delete the access level, click OK when
the confirmation dialog box asks you.

The record will continue to appear in the data list
although it will be “grayed.” New records will not be
able to use it’s name until the database is packed (see
Chapter 7).

 NOTE
An Access Level may not be
deleted if already assigned
to cards.
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THE CARD DATABASE

The card database contains information on all cards/card
users in the system. Selecting Cards... from the Data-
base menu opens the Card Database.

The Card Database shows the user name and card
number of the cards which have been defined. The list
will also have a column of information dedicated to the
index that the cards are sorted by. For example, if cards
are sorted by activation date, the last column on the list
would be activation date.

The Card Database has the largest number of sorting
options of all of the databases. Cards can be sorted by
the order in which they were entered (None), by card
number (Number), by name (Card), by access level (the
order in which the access levels were entered), by
activation/deactivation dates, or by any of the 25 user-
defined note fields. See System Setup for information
on defining note fields.
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A card can be found by (1) selecting the desired field  in
the Sort Order list, (2) typing the criteria in the Search
box, and (3) clicking the Search button (  ).

ADDING OR EDITING A CARD
Click Add... to enter a new card or Edit... to modify the
currently selected card. This will bring up the Card
Detail window. This window contains three screens.
The first screen contains general card information, the
second contains notes, and the third contains badge
information. Clicking OK from any screen closes the
current card and saves your changes. Use the tabs to
move from one screen to another and only click OK
when you are finished.
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CARDS SCREEN

The Cards Screen contains basic information on the card
and cardholder including name, card number, access
level, status, and read information.

NAME
Type in the first name of the card holder in the First text
entry space and the last name of the card holder in the
Last text entry space. Both first and last names can be
up to 20 characters long.
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NUMBER
Type in the card number from the access control card. If
your system uses keypads only (no cards), enter the
keypad number.

STATUS
Select the status of the card from the Status drop-down
list. The card must have one of four statuses: Active,
Trace, Inactive, or Lost or Stolen. When Active or Trace
is selected, access will be allowed as per the access
level. A card with the “Trace” status will return a “Trace”
condition when presented. When Inactive or Lost/Stolen
is selected, the card is no longer valid at any reader in
the system.

PIN NUMBER

This field is used if card users are required to enter a
PIN number with their card. For a 5 digit system, this
can be any 5 digit number between 1 and 65534. If the
system is keypad only, the number MUST be entered
into the Number field above, and can then be treated
as a 12 digit number.

ACCESS LEVEL

Click on the Access Level drop-down list to select which
access level this card will have. This list consists of
access levels previously defined in the Access Level
Database. See Access Level Database for more infor-
mation.

LIMITED USE OPTIONS
Card access can be limited in one of three ways: activa-
tion/deactivation by use of the Scheduler, an expiration
date, or by a limited number of uses. The field(s) visible
for this option in the Card database depend upon the
method selected in setting up WIN-PAK. See Chapter 2

 NOTE
The Expiration Date and
Limited Use options are only
available if enabled in the
Setup Options. See Setup
for more details.

 NOTE
When Card Digits is set to
“5” in the Card Screen of
Setup Options, then the
numbers allowed are 1 –
65534. If it is set to “12” in
the Card Screen, then the
numbers allowed are 1 –
999,999,999,999.
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for an explanation of each option and instructions on
selecting one.

ACTIVATION & DEACTIVATION DATE:

Select “Active” in the Status field.

Use the ellipses buttons to set an Activation date and a
Deactivation date. The ellipses button will bring up a
month calendar. Use the arrow keys to navigate to the
month you want and then select the date. After selecting
both an Activation and Deactivation Date, the result
should appear as below.

Use the Schedules database to check for these dates at
specified times. When a Card Activation & Deactivation
scheduled event is performed, cards with an Activation
date prior to the event will be sent to the panels. Cards
with a Deactivation date prior to the event will be deleted
from the panels and their status will be made “Inactive”
in the card database.

EXPIRATION DATE:
This field is used to define an expiration date that limits
the period of time that a card can gain access. This date
can be up to 254 days from the date that this information
is sent to the panels.

Enter the expiration date of the card by clicking the
ellipses (...). A month calendar will appear of either the
current month or the month of the active expiration date,
if previously defined.

 NOTE
The computer does not have
to be on-line to expire an
existing valid card. The
expiration of the card is
done at the panel level.

 NOTE
Leaving the activation date
blank will upload the card to
the panels in the card’s
access level.
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Use the backward and forward arrows to change the
calendar one month at a time. After you've navigated to
the month of expiration, select the exact date of expira-
tion. The card will cease gaining access after this date.
Click OK to save the date or Cancel  to return to Card
Detail without saving the date.

Leave this blank if no expiration date is required. Click
Cancel  to remove a date.

LIMITED USE

This field is used to define the number of uses at each
panel that a card can gain access.

Enter the number of uses for which the card is valid by
clicking the arrows. The maximum is 254. After the
number of uses has passed, the card will be invalid.

VALID AND INVALID READS

The Valid and Invalid Read sections are used to define
how particular card read conditions will be interpreted
and acted upon. For each type of read status there is the
option of assigning a priority, a message, and a com-
mand file. Each type of read status can also be set to
print to an event logging printer and be included with
history information for reporting purposes.

 NOTE
The Limited Use value will
decrease as the card is
used.
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VALID READS

Valid reads are when a card is presented and allowed
access because it is assigned the proper access level.
This will usually return a “normal” condition to WIN-PAK.
The exception is if the card is given a “Trace” status in
the Card Database – it will then return a “trace” condition
when presented.

INVALID READS
Invalid reads are when a card is presented, but not
allowed access. This may be for a variety of reasons,
each of which can be assigned a different set of options:

A “Timezone” condition is sent when the card was
presented at a reader outside the time permitted by its
access level.

A “Not found” condition is sent when the panel does not
recognize the card number (possibly a card that is not in
the panel).

A “PIN” condition is sent when an incorrect PIN number
is entered at readers where PIN entry is required.

A “Site code” condition is sent when a card with an
incorrect site code is presented.

An “Expired” condition is sent when a card is presented
after it’s expiration date or after the allotted number of
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uses (as defined in the Card Database and System
Setup).

An “Anti-passback” condition is sent when an anti-
passback violation has occurred in panels with this
option enabled.

Both Valid and Invalid reads can be assigned the fol-
lowing options:

PRIORITY

The condition can be assigned a priority from 1 to 99.
The Current View in Alarm Monitor allows you to view
alarms that require acknowledgement by an assigned
priority. High priority items will appear at the top of the
list while lower priority items will appear lower in the list.

Click in the priority box next to the status that you want
to prioritize and type in a number. “1” would be the
highest priority and “99” would be the lowest  priority.

MESSAGE
A descriptive message can be associated with each
status. It will appear in the Alarm Info Screen so that the
operator will know what the invalid reads mean. Click in
the message box next to the status where a message is
required and type in the message of up to 80 characters.

COMMAND FILE
A command file can be associated with each status.
This file will either automatically be sent to the panel
when this state is received or upon acknowledgment as
defined in the System Setup options. Select the com-
mand file from the drop-down list next to the status to
which the command file is to be linked.

 NOTE
A similar arrangement can
be found in the Readers
Screen of the Panel Data-
base where the action is
based on the card read
status itself. The “read”
status or “card” with the
highest priority will dictate
the message WIN-PAK will
give.
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PRINT
Enable this option for every status that is to be printed to
the log activity printer.

HIST.
Enable this option for every status to be kept in the
WIN-PAK history files. This keeps a log of the status’s
use and can be used to generate reports.
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NOTES SCREEN

Click on the Notes tab to open the Notes Screen. Here
user-defined information on the card user can be
entered.

This screen contains a list of 25 note fields. The names
of the fields are on the left. They will contain descrip-
tive names if they have been defined in the Note
Fields... section under the Setup menu. Otherwise
they will be labeled Note 1, Note 2, etc...

To enter a note, click in the box next to the field to be
defined. Enter the information with up to 25 characters
including letters, numbers, and spaces. To save the note
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it is important to either hit Enter or click on another
note before clicking OK or moving to another screen. NOTE

Shift-F2 will allow you to
edit an existing field.
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BADGE SCREEN

Clicking the Badge tab will open the Badge Screen for
managing the badging component of WIN-PAK.

If a photo has been taken for the card user, it will
appear in the Image box. Photos can be incorporated
into badges in several ways. One way is to “capture” a
photo from a source connected to your PC. This may
involve using a video camera with a video capture card
or a TWAIN device such as a digital camera or scanner.
The steps below outline the different methods available
in WIN-PAK for capturing a badge photo.
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CAPTURING A PHOTO WITH A VIDEO CAMERA
AND VIDEO CAPTURE BOARD
The following steps demonstrate how to capture an
image with a video camera and video capture board.
They assume that all equipment has been connected
and configured to work with your computer.

1. Click Photo.

2. If you have a board installed, a window will appear
with live action from your camera. Use this image
to properly frame your photograph.

The dialog box used for capturing the photograph will
appear differently depending upon the video capture
board selected during WIN-PAK setup. Three elements,
Freeze/Unfreeze, Primary/Secondary, and  Compression
are consistent with all capture boards. Options that may
differ for each board are covered in the Video Capture
Boards section that follows. First, the Freeze/Unfreeze,
Primary/Secondary, and  Compression elements are
defined as follows:

FREEZE/UNFREEZE
This button toggles between “freezing” and “unfreezing”
the viewed image. When the desired image is on
screen, click Freeze to keep it onscreen. Click Unfreeze
to switch back to the live camera view.

PRIMARY/SECONDARY
WIN-PAK allows the capture of two photos per subject.
For example, one photo taken from the front of the
subject and one profile. Selection of either the Primary
or Secondary radio button determines which of two
photos you are capturing.

 NOTE
A program called WinImage
will start when you click
Photo. This program is
dynamically linked to WIN-
PAK for the purpose of
capturing photos. It will
close automatically when
the Card Database is closed.

 NOTE
You can also use the space
bar to toggle between Freeze
and Unfreeze.
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COMPRESSION
The image that is “snapped” for a record will be saved to
a JPEG file which uses a compression technology to
decrease the size of the file. If desired, use the arrow
keys to adjust the compression of the saved image. The
lower the number in this box, the more compressed this
file will be. However, images tend to loose some quality
in this process, so you will want to avoid over-compress-
ing. A setting of 100 applies the least amount of
compression and provides the best quality image. A
setting of 30 applies the most compression, but provides
a lesser quality image.

VIDEO CAPTURE BOARD TYPES
The options available for capturing a photo depends on
the system’s video capture card. Following is an expla-
nation of the options available for different hardware.

VIDEOBLASTER

The VideoBlaster video capture card allows only the
standard options of primary/secondary photo and
compression as outlined above.

COMPUTER EYES 1024

With a Computer Eyes 1024 video capture card, clicking
Capture Image from the Badge Screen of the Card
Database opens a window with an Advanced button.
Clicking Advanced expands the windows as shown:

 NOTE
When using a Video Blaster
capture board, the computer
should be set to show 256
colors or less with a screen
resolution of no greater than
800 x 600 pixels.

SPECIAL
HARDWARE
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The user is given the following choice as to how to
preview the live video:

Grayscale: This option shows the video in black
& white and provides the quickest and
smoothest method of previewing your
photo.

256 Color: This option shows the video in color,
but limits the display to 256 colors. It
is the second quickest method of
previewing a photo, but will have a
striped or blotchy effect.

16M Color: This option provides the best preview
but will appear “choppy” because it
takes longer to redraw the electronic
image on the screen.
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When the preview is set at 16M Colors, the picture will
be clear enough to adjust the slides at the right of the
photo to enhance its quality. The effects of these con-
trols are described below:

BRIGHTNESS

This slider lightens or darkens the entire tonal range of
the photo.

CONTRAST
This slider expands or constricts the entire tonal range
of the photo. The difference in highlights and shadows
can be greatly increased or decreased.

SATURATION
This slider controls the vibrancy, or amount of color, in
the photo.

HUE
This slider controls the value of color in the photo.
Adjusting this can correct photos that seem to have
incorrect color.

SAVE SETTINGS

This button saves the position of the sliders so that the
same settings can be used for all of your badges.

INTEGRAL TECHNOLOGIES FLASHPOINT

Clicking Capture Image from the Badge Screen of the
Card Database opens a window with an Advanced
button. Clicking Advanced expands the window as
shown:

SPECIAL
HARDWARE
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You can adjust the slides at the right of the photo to
enhance it’s quality. The effect of each control is de-
scribed below:

BRIGHTNESS
This slider lightens or darkens the entire tonal range of
the photo.

CONTRAST
This slider expands or constricts the entire tonal range
of the photo. The difference in highlights and shadows
can be greatly increased or decreased.
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SATURATION
This slider controls the vibrancy, or amount of color, in the
photo.

HUE
This slider controls the value of color in the photo.
Adjusting this can correct photos that seem to have
incorrect color.

SHARPEN

This slider sharpens blurry images by increasing the
contrast of adjacent pixels. The highest value is 7.

SAVE SETTINGS

This button will save the position of the sliders so that
you can use the same settings for all of your badges.

TWAIN COMPATIBLE INTERFACE

If your system is equipped with a TWAIN Compatible
Interface, you will have the ability to capture photos
and backdrops from other devices such as scanners.
Clicking Capture Image from the Badge Screen of the
Card Database opens a capture dialog.

SPECIAL
HARDWARE
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The FIRST time you capture an image, click the
Source... button. This shows the TWAIN drivers
present on your computer. Choose one and click Select.
The TWAIN interface will use this driver until you
select a different one.

To capture an image, click the Acquire button. This
opens a device dialog box based upon the previously
selected source. See your device manual for informa-
tion on how to use its TWAIN interface.

IMPORT PHOTO
WIN-PAK allows you to import an image in addition to
capturing an image with a video capture card. This is
useful if you already have images of your personnel or

 NOTE
The compression for a
TWAIN device is set at the
maximum (30). If less
compression (more detail)
is required, then compres-
sion can be set manually.
Open the BADGER.INI text
file and enter the following
line under the [Preferences]
section:

JPEG_Compression=nnn

where nnn is the compres-
sion level. 100 is the least
compression, while 30 is
the most.

space
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if you want to retouch images that have been previously
captured. To do this, take the following steps:

1. From the Badge Screen, click Import Photo to open
the Import Photo window.

2. Click Open… to open a dialog box for you to
browse your folders and find your image.

3. Select the file type you are looking for from the
List files of Type drop down list. You can select
from DIB (*.BMP), JPEG (*.JPG or *.JP2), PCX
(*.PCX), Targa (*.TGA), and TIFF (*.TIF) files.

4. Find the directory that your image is in by
selecting the correct drive from the Drives drop
down list and then double clicking on folders to
navigate to the correct directory.

5. Your image should then be in a list under File
Name. Select it and click the OK button to import
it.
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6. The picture will appear with a frame in the center.
Click and drag from within the frame to move it
and use the handles on the sides of the frame to
resize it.

7. Click the Primary option to use this photo in badge
layouts that have a primary photo placeholder or
click the Secondary option to use this photo in
badge layouts that have a photo placeholder for a
secondary picture.

8. When the frame contains what you want in the
picture, click OK.

9. Click the appropriate View button to update the
view of the badge with the new photo.
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CAPTURE SIGNATURE
Having a card backdrop designed with a signature block
is the first step to putting a signature on a card. The
second step is to actually capture the signature. This is
done in WIN-PAK from the Badge Screen of the Card
Database.

As part of the WIN-PAK installation procedure, a
prompt will ask you if you have a signature pad. Click-
ing Yes will add a line to the BADGER.INI file, enabling
the device. If you are adding the pad after WIN-PAK has
been installed, take the following steps to enable signa-
ture capturing for your PC:

After the signature pad is installed,

1. Make sure that WIN-PAK is closed.

2. Using a text editor, add the following line to the
[Preferences] section of BADGER.INI (Located in
the WINDOWS directory:

SigPad=Penware 100

3. Open WIN-PAK

Then for each signature take the following steps:

1. In the Card Database, open the record of the
person that you want to capture the badge for and
click on the Badge tab to open the Badge screen.

2. Click the Signature button.

3. The following dialog box will open and reflect all
activity on the signature pad. Have the badge user
sign their name on the pad. To clear off the name
and start over, press the left button on the
signature pad.

 NOTE
Only one signature can be
imported per card record.
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When the signature looks the way you want it,
press the right button on the signature pad. This
will save the signature and exit to the Badge
screen. The signature will appear in the badge
preview when you click on the View Badge button.

IMPORT SIGNATURE
Signatures do not need to be captured from within WIN-
PAK. They can also be captured using the WinImage
capturing software, saved to a file, and imported into
WIN-PAK at a later time. To import a previously cap-
tured signature, follow the steps below:

1. Click Import Signature. This opens a dialog box
for opening a signature file.
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2. Find the directory that your signature is in by
selecting the correct drive from the Drives drop-
down list and then double clicking on folders to
navigate to the correct directory.

3. The signature should be in the list under File
Name.  The file must have an .SIG extension.
Select it and click the OK button to import it.

ASSIGNING A BADGE LAYOUT
To assign a badge layout to a card, click the Badge
Layout drop-down list and select one. This list will
contain all the layouts defined in the Backdrops Data-
base (see Chapter 4). To see the layout selected, click
View Badge. This option will show the backdrop with
photo, signature, and field information.
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DATACARD IMAGECARD / FARGO OPTIONS

If the DataCard ImageCard or Fargo duplexing printer
(prints both sides) was selected as your badge printer
when installing WIN-PAK, you will have the option of
selecting a front and back badge layout as shown:

Click the appropriate drop-down list button to select a
front and back badge layout. Click the View Front
button to view the front design or the View Back button
to view the back design. Enabling Default Back Layout
will make the current back layout design the default
with all defined badges.

PRINTING A BADGE
Clicking Print allows you to print a badge using the
currently visible record. A dialog box called Print Setup
will open to provide you with options based upon the
printer drivers that have been previously added in
Windows. If you selected the DataCard or Fargo as your
badge printer when installing WIN-PAK you will see a
different dialog box than the one pictured below. See the
section “Printing with a DataCard / Fargo Duplex Printer”
for printing options with those printers.

 NOTE
Printer Drivers are added in
the Control Panel of Win-
dows, located in the Main
Group. See your Windows
manual for more informa-
tion.

SPECIAL
HARDWARE
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PRINTER LAYOUTS
Clicking OK brings up a dialog box to print the badge. A
preview displays how the badge will fit on the card (or
page) using the printer you selected.

CURRENT PRINTER LAYOUTS

Although most badge printers will print well with WIN-
PAK’s default settings, the Page Layout Dialog box
allows you to define different layouts for printing
badges.

Creating a New Layout

1. Click New….
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2. Type in a New Page Layout Name in the dialog box
provided and click OK.

3. Click Edit…. An Edit Page Layout dialog box will
appear.

4. Use the badge settings to determine how many
rows will appear on a page and how high they
should be, and how many columns will appear on
a page and how wide they should be.

5. Use the Left and Top Margin offsets to determine
how far from the left and top of the page that the
first badge shown will print. Click the Center
button if you want the badge (or badge group) to
centered on the page.

 NOTE
Only one layout will print per
page when printing on a
8 1/2” by 11” (or larger)
sheet. If you want to print
more than one per sheet,
you will need to create
multiple layouts – one layout
for each badge position.
Then reinsert the paper to
print again. Repeat until the
desired amount of printing is
accomplished per page.
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6. Click OK to accept the changes or Cancel to return
to the Page Layout dialog box.

MAGNETIC STRIPE OPTIONS

If a printer with magnetic stripe printing capabilities is
being used, WIN-PAK can use the printer to encode the
card. The following outlines the options used in this
procedure.

ENCODE MAG STRIPE

Enable this option to print the magnetic stripe on the
card. To do this, a printer with this capability must be
present, a magnetic stripe must be defined in the badge
layout, and a magnetic stripe card must be used.

ENCODE WITHOUT PRINTING

Enable this option to encode the magnetic stripe without
the other elements of the badge. This option is only
available if the Encode Mag Stripe option is enabled.

MAG STRIPE PRINTER…
This button opens a dialog containing the names of
printers that encode magnetic stripes. Select which
printer you are using and click OK.

Click Print to print the card or Cancel to go back to the
database without printing.
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PRINTING WITH A DATACARD / FARGO
DUPLEX PRINTER

If the DataCard ImageCard II was selected during
installation, a different dialog box will appear, allowing
the operator to select options for printing.

The Fargo Print Option dialog appears slightly different.

PRINTER
Select the DataCard printer that you are using to print
the badge from the drop down list.

PRINT BOTH SIDES
Enable the Print Both Sides option if you will be printing
both a front and a back on the badge. Make sure that
the badge being printed has a backdrop defined for both
sides.

ROTATE BACK SIDE 180°
Enable the Rotate Back Side 180° option if you are
printing on both sides of the card and want the back side
of the card to be printed upside down (180°). This option
is only available if the Print Both Sides option has been
enabled.

SPECIAL
HARDWARE

 NOTE
Verify the printer driver is
setup correctly before
printing.



152 Win PAK 1.15 User Manual

ENCODE MAG STRIPE
Enable the Encode Mag Stripe option if you want to
encode a number onto a badge with a magnetic stripe. A
badge layout with a magnetic stripe code defined must
be selected.

ENCODE WITHOUT PRINTING
Enable the Encode Without Printing option if you want to
encode a number onto a magnetic stripe badge without
printing the layout. The Encode Mag Stripe option must
be enabled to use this option.

DELETING A CARD
1. Select the card you want to delete with the mouse

and click the Delete button. If you are sure you
want to delete the card, click OK when the
confirmation dialog box asks you.

The record will continue to appear in the data list
although it will be “grayed”. New records will not be
able to use it’s key fields (i.e. name or card number)
until the database is packed (see Chapter 7).

 NOTE
An alternative to deleting a
card is to make the card
status “Inactive.” By making
the card inactive, any future
history will have a database
of the person’s name and
other relevant information
for history reporting. If the
card is deleted, there will be
no reportable history on that
holder name.

 NOTE
The magnetic stripe setup
must be assigned to the
layout used for the back side
of the card when duplex
(2-sided) printing.
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THE CAMERA DATABASE

The camera database contains information on CCTV
cameras in the access control system. Selecting Cam-
eras... from the Database menu opens the Camera
Database.

The Camera Database shows the cameras that have
been defined and some basic information on each one,
including the camera’s descriptive name, address, and
the title that will appear on a monitor when using this
camera. This list is sortable by the order in which they
were entered (None) or alphabetically by Camera Name.

When sorted by Camera, a camera can be searched for
by entering the name in the search box and clicking the
Search button (  ).

ADDING OR EDITING A CAMERA RECORD
Click Add... to enter a new camera or Edit... to modify
the currently selected camera. This will bring up the
Camera Detail window.
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CAMERA
Enter a descriptive name for the camera of up to 20
characters including letters, numbers, and spaces.

ADDRESS
Enter a unique numerical address for the camera from 1
to 999. Duplicating the address of a previously defined
camera will display an error message.

TITLE

Enter the text that you want to appear on the screen
when looking at this camera view. The title may contain
up to 20 characters.

Click OK to save your changes or Cancel to return to
the database without saving your changes.

TO DELETE A CAMERA RECORD
1. Select the camera you want to delete with the

mouse and click the Delete button. If you are sure
you want to delete the camera, click OK when the
confirmation dialog box asks you.

The record will continue to appear in the data list
although it will be “grayed”. New records will not be
able to use it’s key fields (i.e. name or number) until the
database is packed (see Chapter 7).

 NOTE
Some camera titling may not
support 20 characters.

 NOTE
Selected CCTV equipment
must be capable of support-
ing titles to use the Camera
Title database field.
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THE HOLIDAYS DATABASE

The holiday database is a set of defined holidays that
are considered when defining timezones. The ability to
define holidays is important if they will need to be
treated differently (i.e. only certain employees will have
access on these days, a particular input won’t be
shunted, or a door will either be open or closed, etc...)
If “Holiday” is enabled in a timezone assigned to a card,
then the person will be allowed access during that
holiday. If “Holiday” is not included in the timezone,
then the card will not have access on that day, etc... (If a
door is programmed to be open during the timezone,
“Holiday” must be enabled for that door to be open
during holidays in the Holiday Database.

Selecting Holidays... from the Database menu will
open the Holiday Data List.

The Holidays Data List shows the holidays that have
been defined and the date they are on. This list is
sortable by the order in which they were entered (None)
or alphabetically by holiday name.
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When sorted by Holiday, a holiday can be searched for
by entering the name in the search box and clicking the
Search button (  ).

ADDING OR EDITING A HOLIDAY
Click Add... to enter a new holiday or Edit... to modify
the currently selected holiday. This will bring up the
Holiday Detail window.

Type in the name of the holiday (up to 20 characters)
that you want to add in the text entry space provided.
Then use the arrow keys to browse by month until you
see the month that the holiday is in. Click the day of
the holiday within the month.

Click OK to save the holiday or Cancel to return to the
database control window without saving the holiday.

DELETING A HOLIDAY
1. Select the holiday you want to delete with the

mouse and click the Delete button. If you are sure
you want to delete the holiday, click OK when the
confirmation dialog box asks you.

The record will continue to appear in the data list
although it will be “grayed”. New records will not be
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able to use it’s name until the database is packed (see
Chapter 7).
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THE MONITORS DATABASE

The monitor database is a set of defined monitors that
are used in the CCTV supervision of a facility. These
monitors can be selected from within the Reader, Input,
and Output screens of the Panel Database to view
particular areas when reader and alarm information is
received. They can also be selected manually from the
Camera Control Screen. Selecting Monitors... from the
Database menu will open the Monitor Data List.

The Monitors Data List shows the monitors that have
been defined and their address. This list is sortable by
the order in which they were entered (None) or alpha-
betically by monitor name.

When sorted by Monitor, a monitor can be searched for
by entering the name in the search box and clicking the
Search button (  ).
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ADDING OR EDITING A MONITOR
Click Add... to enter a new monitor or Edit... to modify
the currently selected monitor. This will bring up the
Monitor Detail window.

Type in the name of the monitor (up to 20 characters)
that you want to add in the text entry space provided.
Then use the arrow keys to enter a monitor address.

Click OK to save the monitor or Cancel to return to the
database control window without saving the monitor.

DELETING A MONITOR
1. Select the monitor you want to delete with the

mouse and click the Delete button. If you are sure
you want to delete the monitor, click OK when the
confirmation dialog box asks you.

The record will continue to appear in the data list
although it will be “grayed”. New records will not be
able to use it’s key fields (i.e. name or number) until the
database is packed (see Chapter 7).
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THE OPERATOR DATABASE

The Operator Database contains information on all
WIN-PAK operators. Selecting Operator... from the
Database menu opens the Operator Database.

The Operator Database shows the system operators that
have been defined. This list is sortable by the order in
which the records were entered (none) or alphabetically
by operator name.

When sorted by Operator, an operator can be searched
for by entering the name in the search box and clicking
the Search button (  ).

ADDING OR EDITING A SYSTEM OPERATOR
Click Add... to enter a new system operator or Edit... to
modify the currently selected system operator. This will
bring up the Operator Detail window.
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OPERATOR
Enter a descriptive operator name consisting of up to 20
characters (letters, numbers, and spaces).

PASSWORD
The Password button opens up a dialog box to enter a
password for the operator you are defining. The pass-
word must be entered by the operator when logging into
WIN-PAK.

Enter the Password in the first space provided. The
password can be up to 8 characters of numbers or
letters. It will show up in the space as all asterisks. The
password is case sensitive – make sure the operator
knows the exact case of his password.
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Enter the password in the Verify space provided using the
correct case. This is to ensure that you entered the
password in the first space the way that you intended to.

Click OK when finished to save the password or Cancel
to exit this dialog without saving the password.

OPERATOR PRIVILEGES

Operator privileges define what kind of control an
operator has over different options of the program. The
Operator Detail window contains a list of the different
options that an operator can be assigned a privilege to.
Use the scroll bar to view the list. Symbols before each
option show the operator’s privilege for that option. The
privileges and their symbols are shown below:

  EDIT PRIVILEGE
An operator with the Edit Privilege for an option has the
ability to add, modify, and delete information.

  NONE PRIVILEGE
An operator with the None Privilege for an option cannot
edit or view the information.

  VIEW PRIVILEGE
An operator with the View Privilege for an option can
view the information, but cannot edit it.

Privileges are grouped into categories for ease of edit-
ing. The categories are operational privileges, database
privileges, report privileges, setup privileges, and main
screen privileges.

 NOTE
Backup & Restore, Archive,
Purge, and Rebuild privi-
leges can not be edited from
a network client.
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OPERATIONAL PRIVILEGES
Operational privileges give the operator control over
system maintenance. These options do not have a View
privilege.

FILE

Clicking the File bar from the list toggles the entire set of
File options between the Edit privilege and the None
privilege.

BACKUP
Clicking the Backup bar from the list toggles this option
between the Edit privilege and the None privilege. The
operator must have the Edit privilege in order to backup
system files. (See Chapter 7)

RESTORE
Clicking the Restore bar from the list toggles this option
between the Edit privilege and the None privilege. The
operator must have the Edit privilege in order to restore
system files. (See Chapter 7)

ARCHIVE
Clicking the Archive bar from the list toggles this option
between the Edit privilege and the None privilege. The
operator must have the Edit privilege in order to archive
history files. (See Chapter 7)

PURGE

Clicking the Purge bar from the list toggles this option
between the Edit privilege and the None privilege. The
operator must have the Edit privilege in order to purge
archived history files. (See Chapter 7)
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REBUILD
Clicking the Rebuild bar from the list toggles this option
between the Edit privilege and the None privilege. The
operator must have the Edit privilege in order to rebuild,
recreate, and pack indexes of the databases. (See
Chapter 7)

PRINT SETUP
Clicking the Print Setup bar from the list toggles this
option between the Edit privilege and the None privilege.
The operator must have the Edit privilege in order to
change printer settings.

EXIT

Clicking the Exit bar from the list toggles this option
between Edit privilege and the None privilege. The
operator must have the Edit privilege in order to correctly
exit WIN-PAK.

DATABASE PRIVILEGES
Database privileges determine the operator's access to
database information. There are fourteen databases that
can be given the Edit, None, or View privilege.

Databases given the Edit privilege can have records
added, edited, and deleted by the operator. Databases
given the None privilege will be inaccessible to the
operator. Databases given the View privilege can be
browsed but not edited by the operator.

All databases can be assigned the same privilege by
clicking on the Database bar or they can be assigned
one at a time by clicking on individual bars.

 WARNING
An operator could potentially
exit WIN-PAK by exiting
Windows or by turning off
the computer.
BOTH ACTIONS CAN
CORRUPT COMPUTER DATA
– WIN-PAK DATABASES
COULD BE AFFECTED!
THESE ACTIONS ARE
STRONGLY DISCOURAGED!

 NOTE  
The View button appears in
databases that an operator
has been given the View
privilege.
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DATABASES
Clicking the Databases bar from the list toggles the entire
set of database options between the Edit, None, and
View privilege.

TIMEZONES
Clicking the Timezones bar from the list toggles the
Timezone database privilege between Edit, None, and
View.

AREAS

Clicking the Areas bar from the list toggles the Area
database privilege between Edit, None, and View.

PANELS

Clicking the Panels bar from the list toggles the Panel
database privilege between Edit, None, and View.

SCHEDULES
Clicking the Schedules bar from the list toggles the
Schedules database privilege between Edit, None, and
View.

GUARD TOURS
Clicking the Guard Tours bar from the list toggles the
Guard Tours database privilege between Edit, None, and
View.

TRACKING AREAS
Clicking the Tracking Areas bar from the list toggles the
Tracking Areas database privilege between Edit, None,
and View.
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ACCESS LEVELS
Clicking the Access Levels bar from the list toggles the
Access Level database prvilege between Edit, None, and
View.

CARDS
Clicking the Cards bar from the list toggles the Card
database prvilege between Edit, None, and View.

CAMERAS

Clicking the Cameras bar from the list toggles the
Camera database privilege between Edit, None, and
View.

HOLIDAYS

Clicking the Holidays bar from the list toggles the
Holiday database privilege between Edit, None, and
View.

MONITORS
Clicking the Monitors bar from the list toggles the
Monitor database privilege between Edit, None, and
View.

OPERATORS
Clicking the Operators bar from the list toggles the
Operator database privilege between Edit, None, and
View. Selecting the Edit privilege gives the operator
access to operator passwords and privileges, and with it
the whole system. MINIMIZE THE USE OF THIS
PRIVILEGE. The View privilege will allow the operator to
see all operator information except passwords.
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FLOOR PLANS
Clicking the Floor Plans bar from the list toggles the
Floor Plan database privilege between Edit, None, and
View.

COMMAND FILES
Clicking the Command Files bar from the list toggles the
Command File database privilege between Edit, None,
and View.

REPORT PRIVILEGES
Report privileges define which reports the operator can
define and print. Because viewing and printing disclose
the same information, the operator can either have
access to the information (Edit) or not (None). View is
not an option.

REPORTS

Clicking the Reports bar from the list toggles the entire
set of report options between the Edit and the None
privilege.

HISTORY REPORTS

Clicking the History Reports bar from the list toggles
between the Edit privilege and the None privilege for
printing reports on system history.

DATABASE REPORTS
Clicking the Database Reports bar from the list toggles
between the Edit privilege and the None privilege for
printing reports on WIN-PAK’s databases.
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ATTENDANCE REPORT
Clicking the Attendance Report bar from the list toggles
between the Edit privilege and the None privilege for
printing attendance reports.

SETUP PRIVILEGES
Setup privileges define which setup parameters the
operator can modify. These arethe commands located in
the Setup menu. They can either be edited (Edit) or not
(None) – there is no View privilege. In a network setup,
these options can only be edited on the network server.

SETUP
Clicking the Setup bar toggles between the Edit and
None privileges for all items located in the Setup Menu.
If all options are set to None, the Setup Menu will be
inaccessible to the operator. These options can not be
edited from a network client.

OPTIONS

Clicking the Options bar toggles between the Edit and
None privileges for items located in the Options section
of the Setup Menu. This allows/disallows the operator to
choose certain card, communications, and operator
options. See System Setup for more information.

NOTE FIELDS

Clicking the Note Fields bar tggles between the Edit and
None privileges for items located in the Note Fields
section of the Setup Menu. This allows/disallows the
operator to redefine the note field labels.

SERIAL PORTS
Clicking the Serial Ports bar toggles between the Edit
and None privileges for items located in the Serial Ports
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section of the Setup Menu. This allows/disallows the
operator to define serial port usage and hardware.

MAIN SCREEN PRIVILEGES
The last twelve bars in the privileges list control access
to the eight main screens that make up the control
center of WIN-PAK. These twelve bars must be set
individually. If the operator is not allowed access to any
of the twelve, then the screens will not appear when the
operator logs in. In other cases the tab may be inacces-
sible when you try to click on it. Of these options, the
Guard Tour View is the only one that allows the View
privilege.

ALARM MONITOR

Clicking the Alarm Monitor bar toggles between the Edit
and None privilege. This allows/disallows the operator
access to the Alarm Monitor Screen.

ALARM INFO
Clicking the Alarm Info bar toggles between the Edit and
None privilege. This allows/disallows the operator
access to the Alarm Info Screen.

PANEL CNTL
Clicking the Panel Cntl bar toggles between the Edit and
None privilege. This allows/disallows the operator
access to the Panel Control Screen.

MUSTER REPORT
Clicking the Muster Report bar toggles between the Edit
and None privilege. This allows/disallows the operator
access to the Muster Report Screen.
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CAMERA CNTL
Clicking the Camera Cntl bar toggles between the Edit
and None privilege. This allows/disallows the operator
access to the Camera Control Screen after Area is
setup and Monitor and Camera Databases are pro-
grammed.

CARD LOOKUP
Clicking the Card Lookup bar toggles between the Edit
and None privilege. This allows/disallows the operator
access to the Card Lookup Screen.

MAIL

Clicking the Mail bar toggles between the Edit and None
privilege. This allows/disallows the operator access to
the Mail Screen in a network system.

MUSTER CARD DELETION

Clicking the Muster Card Deletion bar toggles between
the Edit and None privilege. This allows/disallows the
operator the ability to delete muster cards from the
Muster Report Screen.

NON-MUSTER CARD DELETION
Clicking the Non-Muster Card Deletion bar toggles
between the Edit and None privilege. This allows/
disallows the operator the ability to delete non-muster
cards from the Muster Report Screen.

DISPLAY CARD NUMBERS
Clicking the Display Card Numbers bar toggles between
the Edit and None privilege. The Edit privilege allows the
operator to see card numbers when displayed on the
screens that show them. The None privilege will show
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 NOTE
By deleting an operator, you
will lose reference to that
operator’s activities in the
system when generating a
history report.

Instead, change the
operator’s password and
limit access to File and Exit
only. This will prohibit the
operator from logging on
while maintaining past
activities.

“*****” instead of card numbers on screens that show
them.

DISPLAY PIN NUMBERS

Clicking the Display PIN Numbers bar toggles between
the Edit and None privilege. The Edit privilege allows the
operator to see PIN numbers when displayed on the
screens that show them. The None privilege will show
“*****” instead of PIN numbers on screens that show
them.

GUARD TOUR VIEW
Clicking the Guard Tour View bar toggles between the
Edit, View and None privilege. The Edit privilege allows
the operator to initiate and cancel guard tours. The View
privilege only allows the operator to view a tours pro-
gression. The None privilege prohibits the operator from
viewing or controlling guard tours.

DELETING AN OPERATOR
1. Select the operator you want to delete with the

mouse and click the Delete button. If you are sure
you want to delete the operator, click OK when the
confirmation dialog box asks you.

The record will continue to appear in the data list
although it will be “grayed”. New records will not be
able to use it’s name until the database is packed (see
Chapter

 NOTE
Although card numbers may
be hidden in screens that
normally show them, they
will still be visible in Card
Database reports (if access
to reports is enabled), the
Locate Function (if access
to Card Database is en-
abled), and Attendance
Reports.

 NOTE
Although PIN numbers may
be hidden in screens that
show them, they will still be
visible in Card Database
reports ONLY if access to
reports is enabled.
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THE FLOOR PLAN DATABASE

The floor plan database maintains graphics that can be
associated with particular input points. These graphics
are created in other applications and may be a diagram
of a floor plan, a photo, or any other computer graphic
that can be saved as a Windows Bitmap file (.BMP).
This is an alternative way of monitoring alarm points in
the Alarm Monitor Screen. Operators can view points
by the facility area they are located in.

Selecting Floor Plans... from the Database menu opens
the Floor Plan Database.

The Floor Plan Database displays a list of the floor
plans that have been defined and the graphic floorplan
file name and location. This list is sortable by the order
in which they were entered (None) or alphabetically by
Floor Plan name.

When sorted by Floor Plan, you can search for a floor
plan by entering its name in the search box and clicking
the Search button (  ).

 NOTE
Photos of areas of the
building can be used instead
of floor plans.
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ADDING OR EDITING A FLOOR PLAN RECORD
Click Add... to enter a new floor plan or Edit... to
modify the currently selected floor plan. This will bring
up the Floor Plan Detail window.

The Floor Plan Detail window is used to select a
graphic to use as a floor plan, name it, and assign a “hot
spot” if needed.

FLOOR PLAN
Type in a descriptive name for the floor plan that you will
be selecting. The name can be up to 20 characters
including spaces.
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SELECTING A FLOOR PLAN GRAPHIC

FILE NAME

Type in the name of the graphic that you want to use,
including the path, in the space provided or use the
ellipse button ... to open a file finding dialog box.

The Open dialog box will allow you to select the floor
plan file that you want to associate with the name you
defined.

LIST FILES OF TYPE
The floor plan graphic MUST be in a Windows bitmap
format. This drop-down list allows you to select between
displaying only Windows bitmaps (BMP) or listing all
files. Listing Bitmap files only is preferred because it will
not list files that cannot be used.

DRIVES

Select the correct drive of the graphic you want to open.
“a:” and “b:” are generally floppy disk drives.
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DIRECTORIES
Use the directory tree under Directories to navigate to the
directory of the graphic that you want to open. Double-
clicking on a folder opens it to reveal it’s contents.

FILE NAME
Once you have selected the correct drive and directory,
the list under File Name should contain the name of the
file that you want to open. Scroll the list, if necessary,
until you find the correct file, then select it.

Click OK after you have selected the file that you want
to open or click Cancel to return to the Floor Plan
Detail without opening a graphic.

CREATING A HOT SPOT

The Floor Plan Detail window contains a dialog box
called Hot Spot Detail. A Hot Spot is a defined area on a
floor plan that can provide access to more detailed
information in the form of an alarm input status, a link
to another floor plan, or both. The following sections
explain how to define hot spots for alarm points and
floor plans.

DEFINING ALARM POINT HOT SPOTS
An alarm point hot spot is a defined place on a floor
plan that displays the status of one or more alarm input
points. When a floor plan with this type of hot spot is
viewed in the Floor Plan View of the Alarm Monitor, it
contains an alarm icon where the spot was defined.
This icon tells the status of the alarm by its color and



DATABASES
Databases 177

blinks until the alarm is acknowledged. The following
steps show how to define an alarm point hot spot:

1. With the floor plan open and on the screen, click
on the floor plan where you want the upper-left
corner of the hot spot to be and drag with the
mouse to where you want the lower-right corner of
the hot spot to be. This creates a white box around
the spot.

2. The Hot Spot Detail Window becomes active. Type
in a message for the hot spot in the space provided
(up to 50 characters). This message appears in the
status bar when the cursor is over the spot in the
Floorplan View of the Alarm Monitor.

3. Click Alarm Point.... This opens the Monitor
Points dialog box.

4. Select the desired loop from the Loop drop-down
list or leave the default “All” to select from more
than one loop.

 NOTE
The size of the hot spot will
automatically adjust to the
appropriate size depending
on how many alarm input
points are defined.
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PLANMAIN.BMP

PLANA.BMP

PLANA1.BMP PLANB1.BMP PLANB2.BMP

PLANB.BMP

Link to PLANA1.BMP
Alarms Defined:

PT1

Alarms Defined:
PT1

Alarms Defined:
PT2

Alarms Defined:
PT3 & PT4

Link to PLANB2.BMP
Alarms Defined:

PT3 & PT4

Link to PLANB1.BMP
Alarms Defined:

PT2

Link to PLANB.BMP
Alarms Defined:

PT2, PT3, PT4

Link to PLANA.BMP
Alarms Defined:

PT1

NOTE:
If you right click on the
floor plan view within a
hotspot, (excluding the
first layer) you will
receive a list of the floor
plans that you “traveled
through” to get to it as
shown below. Up to five
can be listed.
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5. Select the desired panel from the Panel drop-down
list or you can select any panel defined in the
Panel database that is located on the selected loop.
Leave the default “All” to select from more than
one panel.

6. Select the desired points from the Available Input
Points list. Selecting the various points puts them
in the Selected Input Points list and adds them to
your hot spot. The alarm input icons appear in the
Floor Plan View of the Alarm Monitor when these
alarms are triggered, based on the Acknowledge
Alarm Threshold set in the Communications
section of the Setup options.

Clicking the points in the Selected Input Points list
“deselects” them and puts them back in the
Available Input Points list.

7. Click OK to exit and save your input point hot
spot information. Then click OK from the Floor
Plan Detail to save the change to your floor plan.

DELETING A HOT SPOT

To delete a hot spot within a floorplan, select the hot
spot with the mouse, and click Delete in the Hot Spot
Detail dialog box. After deleting or removing a hot spot,
packing the Floor Plan Database is required.

FLOOR PLAN LINKED HOT SPOTS

A floor plan linked hot spot is a defined place on a floor
plan that opens another floor plan when clicked on.
When a floor plan with this type of hot spot is viewed
in the Floor Plan View of the Alarm Monitor, the hot
spot will appear as a dashed box where it was defined
unless it is both an alarm point AND floor plan hot

 NOTE
It is not recommended to go
more than five levels deep in
linking floor plans.

 NOTE
If you  need to see the
status of an alarm point
through multiple layers of
linked floor plans, it is
necessary to define the
alarm point in each layer.
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spot; then it will appear as an alarm icon. The following
steps show how to define a floor plan hot spot:

1. With the floor plan open and on screen, click on
the floor plan where you want the upper-left
corner of the hot spot to be and drag with the
mouse to where you want the lower-right corner of
the hot spot to be. This creates a white box around
the spot.

2. The Hot Spot Detail Window becomes active. Type
in a message for the hot spot in the space provided
(up to 50 characters). This message appears in the
status bar when the cursor is over the spot in the
Floor Plan View of the Alarm Monitor.

3. Click Floor Plan Link.... This opens the List dialog
box containing all defined floor plans.

4. Select the floorplan that you want to link to the
hot spot.

 NOTE
In addition to floor plan
diagrams, photographic
images can be used. These
can be scanned and saved
as bitmap files or taken with
a digital camera.
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5. Click OK to save the floor plan link, and OK from
the Floor Plan Detail to save the floor plan.

SPECIAL SECTION:
CREATING FLOOR PLANS

Floor plans are a useful component of the WIN-PAK
control system because they give the operator a visual
map or cue associated with an alarm or reader area.
There are a wide variety of software packages available
to help you create floor plan images ranging from
simple inexpensive painting programs, such as Paint-
brush (included with Windows) to more elaborate
painting and drawing programs. Any program that can
save to an uncompressed Windows bitmap file (.BMP)
will work, but you may find that some programs are
easier to use or provide more flexibility. Following are
some tips to help you create useful floor plans.

Defining an area that will fit:

Floorplans can be created larger than the physical
viewing area in the Floor Plan View of the Alarm
Monitor because scroll bars allow the operator to
“scroll” to see areas of the floor plan that aren’t
immediately visible. While this may be suitable for
an entire facility floor plan view, it may be cumber-
some when the operator wants a quick view of an
alarm input area. In this is case, it is important to
design the floorplan to fit on the screen in the
floorplan view.

Monitors vary in size and resolution. Special driv-
ers installed in your computer can also give you
special flexibility by allowing you to change resolu-
tion and color capabilities. It is always best to
design your floorplan with the hardware and moni-
tor settings that are used for running WIN-PAK.
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What you see on the screen when designing the
graphic will then be what you get in WIN-PAK.

DELETING A FLOOR PLAN
1. With the mouse, select the floor plan to be deleted

and click the Delete button. If you are sure you
want to delete the floor plan, click OK in the
confirmation dialog box.

The record will continue to appear in the data list
although it will be “grayed”. New records will not be
able to use its name until the database is packed (see
Chapter 7).
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THE COMMAND FILE
DATABASE

Command Files are text files used to control hardware in
an access control system. They may be used in a panel
loop to instruct one or more panels to take a particular
action, or they can be used to send data to a camera
control or other (Unknown) loop. Command files can
either be automatically sent to a panel (or other loop)
upon receiving information or upon acknowledgment, as
defined in the System Setup option. Command files can
also be sent manually from the Panel Control Screen (or
Live Camera View).

WIN-PAK checks command file entries for correct
syntax when an area is defined as a Loop, so see your
panel’s programming manual for commands and their
syntax. Areas defined as Camera or Unknown won’t be
checked for syntax.

Selecting Command File... from the Database menu
opens the Command File Database.
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The Command File Data List shows the Command Files
that have been defined and the area (loop) that they are
defined for.

When sorted by Command File, you can search for a file
by entering its name in the search box and clicking the
Search button (  ).

ADDING OR EDITING A COMMAND FILE
Click Add... to enter a new command file or Edit... to
modify the currently selected command file. This brings
up the Command File Detail window.

COMMAND FILE

Enter a name for the command file. It can consist of up
to 20 characters including letters, numbers, and spaces.

AREA

Select the area in which the command file will be used
from the drop-down list. This list contains all of the areas
defined in the Area database.
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COMMANDS
Type in the commands you want to add to the command
file. When your Area defines a panel loop, be sure to
use the syntax required by your panel. If your area
defines a camera loop, use the appropriate syntax for
that manufacturer. Commands defining an “Unknown”
area type are sent as a text file regardless of syntax.
After entering one command line, press the down arrow
to add more. Make sure to press the down arrow after
the last command, so that none of the commands
appears in yellow. This ensures that all of the com-
mands are saved when you click OK.

When you have finished entering commands, click OK
to save your command file or Cancel to return to the
Command File Database screen without saving.

DELETING A COMMAND FILE
1. With the mouse, select the command file to be

deleted and click the Delete button. If you are sure
you want to delete the command file, click OK in
the confirmation dialog box.

The record will continue to appear in the data list
although it will be “grayed.” New records will not be
able to use it’s name until the database is packed (see
Chapter 7).
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4
CREATING BADGE

BACKDROPS
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Badge backdrop designs are created as templates that
can be merged with card user data to produce badges.
WIN-PAK has a component for building these templates
called the Badge Layout Utility. The operator can
choose the badge size, the background color (or pic-
ture), where the photos and fields will appear, etc.. The
operator can then save the badge backdrop design and
assign it to persons in the Card Database. This chapter
shows how to create a badge backdrops. Assigning
these badge backdrops to card holders is covered in the
Card Database section of Chapter 3.

ACCESSING & EXITING THE BADGE LAYOUT
UTILITY
The Badge Layout Utility can be accessed by selecting
Backdrop... from the Database menu. This will
launch the utility for customizing badge backdrop
designs.

To exit the Badge Layout Utility of WIN-PAK, select Exit
from the File Menu.

CREATING A NEW BADGE
To create a new badge select New Badge... from the
File menu or click on the New Badge button (  ). It
will open the Create New Badge dialog box for the
operator to specify the name and printable area of the
new badge. Fill in the fields outlined below.

NOTE  
The Badge Layout Utility can
be accessed independently
from WIN-PAK by double-
clicking it’s icon in the
Northern Access Control
Group in Windows.
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BADGE NAME
Enter a name for the badge design. You can use spaces
and special characters. The program will replace lower
case letters with capital letters automatically. You can
use up to 25 characters or until the field is full.

PRINTABLE AREA SIZE
Enter in the width and height of the printable area of the
badge in millimeters. The default size when creating a
new badge is 80mm W x 49mm H, which will work for
most badge printers. Flip the two numbers to create a
vertical badge.

Click OK to accept the new badge parameters or Cancel
to close the dialog box without creating a badge.

OPENING AN EXISTING BADGE
Selecting Open... from the File menu or clicking the
Open button (  ) on the tool bar displays a list of
previously created badges. Select a badge from the list
and click OK to open it, or click Cancel to leave this
option without opening a badge.

 NOTE
The printable area size of a
badge can be changed after
the new badge is created by
selecting Badge Layout...
from the File Menu.

 NOTE
To see measurements in
inches, edit the BADGER.INI
file in the WINDOWS
subdirectory. Add the
following line under
[Preferences]:

Inches=1
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CLOSING A BADGE
Selecting Close from the File menu closes the currently
selected badge design. Selecting Close All from the
Window menu will close all open badge designs. Both
methods will prompt you to save backdrops that have
not been saved.

SAVING A BADGE
Selecting Save from the File menu or clicking the Save
button (  ) on the tool bar saves all changes made to
the currently selected badge design. As with many
software programs, it is a good idea to save your work
often. It is necessary to save your changes before print-
ing the badge. A badge that has not been saved after
changes have been made is indicated by an asterisk in
the title as shown below:

RENAMING A BADGE
Selecting Rename from the File menu allows the
operator to change the name of the currently selected
badge. It opens a dialog box to type in a new name.
After typing in the name, click OK to keep the change or
Cancel to leave the name as it was.

COPYING A BADGE
Selecting Copy from the File menu allows the operator
to copy the currently selected badge to a new badge
name. This allows you to create several badges with the
same basic layout and perhaps one distinguishing
feature (such as the backdrop color). A dialog box will

 NOTE 
A badge will not copy until it
is saved.
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allow the operator to type in another badge name. Click
OK to create the new badge or Cancel without creating
it.

DELETING A BADGE
Selecting Delete from the File menu permanently
deletes the currently selected badge design.

IMPORTING A GRAPHIC
All graphics used in designing a badge must be located
in the DATA directory specified during WIN-PAK setup.
Selecting Import Graphic... from the File menu allows
you to copy a graphic file from anywhere on your hard
drive or a floppy disk to this graphic directory. Use the
steps below to copy the file.

1. Select the drive that your graphic is on from the
Drives dropdown list in the bottom right hand
corner. (A and B are usually floppy disk drives).
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2. Select the type of graphic that your file is from the
Files of Type dropdown list in the bottom left hand
corner. You can choose from BMP, JPG, TGA, or
TIF.

3. Use the directory tree to open the subdirectory
that your file is in by clicking on folders to open
them.

4. Select your file from the File Name list at the
upper left corner and click OK to import or Cancel
to exit this box without importing.

EDITING THE BADGE BACKGROUND
One basic feature of the Badge Layout Utility is the
ability to change the background of the badge. The
background is the entire printable area on the card in
which other elements are placed into. This area is
defined by the gray box that appears on a new badge.

There are three ways to provide a background for a
badge: select a single color, capture a live image using
your computer equipped with a video camera and
capture board, or import an existing bitmap image.
These three methods are explained below.

CREATING A SINGLE COLOR BACKGROUND

The simplest background is one that consists of a single
color. Badge colors can be used to represent different
clearance levels as they are easy to distinguish from a
distance.

To change the color of the background, click anywhere
on it with the RIGHT mouse button. A menu will pop
up displaying editing options. Select Background
Color.... Selecting this menu item will bring up a palette
of Basic Colors. If you see a color you like, select it with
the mouse, and click OK. If you don’t see a color you

 NOTE
Colors on the screen and
colors that are printed don’t
always match exactly
because of different monitor
& printer settings.

Lighter color backgrounds
will print better. White is
typically the best back-
ground color.
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like, you can create a custom color for your badge (See
Appendix F).

 NOTE
You must erase the captured
background from the badge
if you want to change it to a
solid color.
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CAPTURING A BACKGROUND

Another way to create a background is with your
computer equipped with a video camera and video
capture board. This involves setting up something that
you want to appear as your background and capturing it
on video. The instructions below assume that your
video equipment has been installed and tested.

To capture a new background, click anywhere on the
existing background with the RIGHT mouse button. A
menu will pop up displaying editing options. Select
Backdrop. This will open a submenu. Select Capture
from this menu. If you have a board installed, a win-
dow will appear with live action from your camera. Use
this image to properly frame your background.

The dialog box used for capturing the background will
appear differently depending upon the video capture
board selected during WIN-PAK setup. Options that
may differ for each board are covered in the Video
Capture Boards section that follows.

FREEZE/UNFREEZE

This button toggles between “freezing” and “unfreezing”
the viewed image. When the desired image is on
screen, click Freeze to keep it onscreen. Click Unfreeze
to switch back to the live camera view.

VIDEO CAPTURE BOARD TYPES
The options available for capturing a background
depends on the system’s video capture card. Following
is an explanation of the options available for different
hardware.
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COMPUTER EYES 1024

Selecting Capture from the Backdrop submenu opens a
dialog box with an Advanced button. Clicking Ad-
vanced expands the windows as shown:

You can adjust the slides at the right of the background
image to enhance it’s quality. The effect of each control
is described below:

BRIGHTNESS

This slider lightens or darkens the entire tonal range of
the background image.

CONTRAST

This slider expands or constricts the entire tonal range
of the background image. The difference in highlights
and shadows can be greatly increased or decreased.
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SATURATION
This slider controls the vibrancy, or amount of color, in
the background image.

HUE
This slider controls the value of color in the background
image. Adjusting this can correct images that seem to
have incorrect color.

COMPRESSION

The background image that is captured will be saved to
a JPEG file which uses a compression technology to
decrease the size of the file. If desired, use the arrow
keys to adjust the compression of the saved image. The
lower the number in this box, the more compressed this
file will be. However, images tend to loose some quality
in this process, so you will want to avoid over-compress-
ing. A setting of 100 applies the least amount of
compression and provides the best quality image. A
setting of 30 applies the most compression, but provides
a lesser quality image.

SAVE SETTINGS

This button saves the position of the sliders so that the
same settings can be used for all of your badges.

 NOTE
The lesser the compression
the better. An image com-
pressed at 100 is
approximately 80k. An
image compressed at 30 is
approximately 8k.
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INTEGRAL TECHNOLOGIES FLASHPOINT

Selecting Capture from the Backdrop submenu opens a
dialog box with an Advanced button. Clicking Ad-
vanced expands the windows as shown:

You can adjust the slides at the right of the backdrop to
enhance it’s quality. The effect of each control is de-
scribed below:

BRIGHTNESS

This slider lightens or darkens the entire tonal range of
the background image.
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CONTRAST
This slider expands or constricts the entire tonal range of
the background image. The difference in highlights and
shadows can be greatly increased or decreased.

SATURATION
This slider controls the vibrancy, or amount of color, in
the background image.

HUE

This slider controls the value of color in the background
image. Adjusting this can correct photos that seem to
have incorrect color.

SHARPEN

This slider sharpens blurry images by increasing the
contrast of adjacent pixels. The highest value is 7.

COMPRESSION
The background image that is captured will be saved to
a JPEG file which uses a compression technology to
decrease the size of the file. If desired, use the arrow
keys to adjust the compression of the saved image. The
lower the number in this box, the more compressed this
file will be. However, images tend to loose some quality
in this process, so you will want to avoid over-compress-
ing. A setting of 100 applies the least amount of
compression and provides the best quality image. A
setting of 30 applies the most compression, but provides
a lesser quality image.

SAVE SETTINGS
This button will save the position of the sliders so that
you can use the same settings for all of your badges.

 NOTE
The lesser the compression
the better. An image com-
pressed at 100 is
approximately 80k. An
image compressed at 30 is
approximately 8k.
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TWAIN COMPATIBLE BOARD

If your system is equipped with a TWAIN Compatible
Board, you will have the ability to capture background
images from other devices such as scanners. Selecting
Capture from the Backdrop submenu opens a dialog
box with an Acquire... and Source... button.

The FIRST time you capture an image, click the
Source... button. This shows the TWAIN drivers
present on your computer. Choose one and click Select.
The TWAIN interface will use this driver until you
select a different one.

To capture an image, click the Acquire button. This
opens a device dialog box based upon the previously
selected source. See your device manual for informa-
tion on how to use its TWAIN interface.
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LOADING A BITMAP GRAPHIC BACKGROUND
A third method of creating a background is to load an
existing bitmap graphic file. Creating this file takes
more work than the other two methods but allows an
infinite number of possibilities. Here are just a few
ways to obtain a file:

• Use a “paint” type software program to create a
background file from scratch

• Use a desktop scanner to scan a logo or
photograph and save it to a file

WHEN CREATING YOUR BACKGROUND FILE,
REMEMBER...

1. The file must be saved as a Windows Bitmap
(BMP), JPEG (JPG), Targa (TGA) or TIFF (TIF) file
and imported to the directory you specified as
your graphic subdirectory during WIN-PAK setup.
The file should be close to 300ppi (pixels per
inch).

2. Keep in mind the orientation and size of the badge.
Try to create your background image as closely as
possible to the printable area of your badge
because WIN-PAK will “stretch” the background
image to fill the printable area – check Badge
Layout in the File menu to see the printable area
size.

3. Keep in mind where photos, barcodes, and text
will be placed on the badge so important parts of
your background don’t get obscured.

LOADING THE FILE
To load the graphic file after it has been imported into
your WIN-PAK data directory, click anywhere on the
current background with the RIGHT mouse button.
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A menu will pop up displaying editing options. Select
Backdrop. This will open a submenu. Select Load...
from this menu. This opens a dialog box that allows
you to select a graphic image for your background from
your graphic subdirectory.

Choose what type of graphic file you wish to import as
your backdrop from the File Types list. Your choices
are:

 (*.BMP)
 (*.JPG)
 (*.TGA)
 (*.TIF)

Once you select what type of file you are importing,
you can then view those files in the image file list.
When you see the file that you want to use, select it and
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click OK. The graphic will be loaded and “stretched” to
fit your badge size.

MANIPULATING THE BACKGROUND
ORIENTATION
After you have either captured or loaded an existing
backdrop, you can rotate it within your badge. Click
anywhere on the current background with the RIGHT
mouse button. A menu will pop up displaying editing
options. Select Orientation. This will open up a
submenu with rotation options expressed in degrees.

Your options are:

0° Places your image upright.
90° Rotates your image 90° clockwise.
180° Places your image upside-down.
270° Rotates your image 90° counterclockwise.

ERASING THE BACKGROUND
To remove the loaded graphic as a background, click
anywhere on it with the RIGHT mouse button. A menu
will pop up displaying editing options. Select Back-
drop. A submenu will appear. Select Erase to remove
the background.
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ADDING ELEMENTS TO THE BADGE
Elements can be added to badges to conform to your
specific needs. The badge holder’s photo can be placed
on the badge. The badge can also contain his name,
card number, and other pertinent information. A bar-
code can be added to input information into computer
systems ranging from access control and payroll to
resource checkout. Bitmaps such as logos can be added.

ADDING ELEMENTS

The six elements that can be placed on a badge (text,
bitmap, photo, barcode, shape, and signature) are
accessible in three ways. Either select the element from
the Object menu, click the button on the toolbar that
corresponds to the element that you want to add, or
click the RIGHT mouse button on any open area of the
badge and select the element you want to add from the
menu. All methods will change the cursor (when over
the badge) to the styles shown here:

Text Tool

Bitmap Tool

Photo Tool

Barcode Tool

Shape Tool

Signature Tool

Click the badge where you want the upper left-hand
corner of the element to appear. All elements can be
moved and resized, so don’t be concerned if it doesn’t
appear in the right place. The instructions for moving
and resizing appear below.
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RESIZING ELEMENTS

One of the ways to modify a badge element is by
resizing it. All elements are resized by “stretching” its
edges. First click with the pointing cursor on the ele-
ment to select it  for modification. If it is difficult to
select the element because it is obscured by other
elements, use the TAB key to cycle through the ele-
ments until the one that you want to resize is selected.
When over an edge or corner of a selected object, the
cursor changes to a double-pointed arrow.

Click and drag an edge or corner until the sizing box is
the size and shape that you want the element.

MOVING ELEMENTS

All elements on the badge can be moved. First click on
the element to select it. If it is difficult to select the
element because it is obscured by other elements, use
the TAB key to cycle through the elements until the one
that you want to move is selected. When the cursor is
within the edges of a selected element and the left
mouse button is clicked, it changes to the move tool
(four-directional arrow).

Then just click and drag the element to where you want
it. The dotted outline shows the new placement.
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Badge elements can be modified in many other ways by
accessing the element’s menu. This is done by selecting
the element and clicking the RIGHT mouse button.

LAYERING ELEMENTS

Elements on the badge are layered as they are placed.
This will only be noticed when elements overlap each
other. It is possible to change the layering order by
selecting Layering... from the Object menu or by
clicking the layering button (  )from the tool bar.

Objects on the badge are listed in the order that they are
layered from top to bottom. Select the object to be
moved from the list shown. Click Move Up to move the
object one item closer to the front. Click Move Down to
move the object one item closer to the back. Click OK
when finished.

GRIDS
Grids are evenly spaced points to assist in sizing and
aligning elements. The grid can be used simply as a
visual help in placing elements, or you can have items
“snap” to the grid when moved.

SETTING UP A GRID

Select Grid Settings... from the Grid menu and modify
the grid as shown.
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SPACING

Use the edit fields in this section to define how far apart
the grid points are. The X Axis field is the distance
between points horizontally across the badge. The Y
Axis field is the distance between points vertically down
the badge. Both distances are measured in millimeters.

SNAPPING TO THE GRID

Selecting Snap to Grid from the Grid menu toggles on
and off the option of having items snap to the grid
when moved on the badge. For example, when an
element is moved close to a grid mark, it will be pulled
to it like a magnet. A check mark identifies this option
as enabled when you open the Grid menu.

SHOWING THE GRID

Selecting Show Grid from the Grid menu or clicking the
Show Grid button (  ) on the toolbar toggles on and
off the option of viewing the grid on the badge. (See
Grid Setup... above). A check mark identifies this
option as enabled when you open the Grid menu.

 NOTE
To see measurements in
inches, edit the BADGER.INI
file in the WINDOWS
subdirectory. Add the
following line under
[Preferences]:

Inches=1
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ADDING AND EDITING TEXT

ADDING TEXT

Adding text to a badge is as easy as clicking on the
badge with the text tool. The cursor can be changed to
the text tool in any of the following ways:

1. Select Insert Text from the Object menu,

2. click the text button (  ) on the toolbar,

3. or click anywhere on an empty part of the badge
with the RIGHT mouse button and select Text.

After the cursor has changed to the text tool, click on
the badge where you want the upper left-hand corner of
the text box to be. The text box can be resized and
moved as described earlier and edited as described
below.

EDITING TEXT CONTENTS

Click on the text box to make sure that it is selected.
Then click the RIGHT mouse button anywhere on the
text box to open up it’s option menu and select Text....

This menu item opens a dialog box for defining what
text is displayed. You can enter in the Text edit field
exactly what you want. Press Control and Enter to-
gether to start a new line.
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You can also include information specific to the badge
holder. To do this, place the cursor in the Text edit field
where you want this information to appear. Then find
which field you want to use from the list on the right.
Double-click the information field and it will appear in
the text edit field. Now when you assign a badge to an
individual, it will automatically fill in the appropriate
data for that person. Click OK when finished.

CHANGING THE FONT

This menu item allows you to change the font, style,
and size of the text. Options are reflected in the Sample
box.

 NOTE
“<TEXT>” identifies the
item as a text box. It should
be deleted or “written over”
when defining your text or it
will be displayed in your text
box.

 NOTE
If a barcode font or a True
Type font was installed in
Windows, it will appear in
the Font list and be available
for use.
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FONT
Select a Font type from the list. The fonts included in this
list depend upon the fonts installed in Windows. See your
Windows manual for information on installing fonts.

FONT STYLE
Select an appearance style for the font you have se-
lected. Choose either Regular, Italic, Bold , or Bold Italic .

SIZE

Select a size for the font. The number you select refers to
the number of points in the approximate height of a
capital letter. Use the following as a guideline:

72 point = 1.0 inch
36 point = 0.5 inch
18 point = 0.25 inch
9 point = 0.125 inch

You can also resize text by sizing the text box and the
“Size Font to Box” option below.

EFFECTS

It is also possible to apply simple effects to your text.
Click the Strikeout box to have a line going through your
text. Click the Underline box to add an underline to your
text.

COLOR
It is possible to change the color of your text from this
menu from the Color dropdown list. However, you have
more flexibility in choosing text color from the “Fore-
ground Color” menu item discussed below.

RESIZING TEXT

Click on the text to select it, then click anywhere on the
text with the right mouse button to open the options
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menu. Select Size Font to Box. Enabling this option
changes the text size to fit the text box when resized.
The text will grow or shrink proportionally when the
box is resized. This may not be desirable in fields
where the data is a variable such as a name.

EDITING THE TEXT FOREGROUND COLOR

Click on the text to select it, then click anywhere on the
text with the right mouse button to open the options
menu. Select Foreground Color. Selecting this menu
item brings up a palette of Basic Colors for changing the
text color.

Choose a color, select it with the mouse, and click OK.
If a custom color is needed for the text, it can be created
(See Appendix F).

EDITING THE TEXT BACKGROUND COLOR

Click on the text to select it, then click anywhere on the
text with the right mouse button to open the options
menu. Select Background Color. Selecting this menu
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item brings up a palette of Basic Colors for changing the
text background color (above). Choose a color, select it
with the mouse, and click OK. If a custom color is
needed for the text, it can be created (See Appendix F).

CREATING TEXT WITH A TRANSPARENT BACKGROUND

The background color of text can be set to transparent.
Click on the text to select it, then click anywhere on the
text with the right mouse button to open the options
menu. Select Transparent so that the elements behind it
show through.

EDITING TEXT HORIZONTAL JUSTIFICATION

To adjust text horizontal justification, click on the text
to select it, then click anywhere on the text with the
right mouse button to open the options menu. Select
Justification.

Selecting this menu item opens a submenu allowing the
operator to select the horizontal positioning of the text
in the text background. You can have it justify to the
Left, Center, or Right.

EDITING TEXT VERTICAL ALIGNMENT

To adjust text vertical alignment, click on the text to
select it, then click anywhere on the text with the right
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mouse button to open the options menu. Select Align-
ment.

Selecting this menu item opens a submenu allowing the
operator to select the vertical positioning of the text in
the text background. You can have it align to the Top,
Middle, or Bottom of the text box.

CHANGING TEXT ORIENTATION

To change the orientation of text, click on the text to
select it, then click anywhere on the text with the right
mouse button to open the options menu. Select Orienta-
tion and choose the angle for the text to appear on the
badge.
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Your options are:

0° Places your text upright.
90° Rotates your text 90° clockwise.
180° Places your text upside-down.
270° Rotates your text 90° counterclockwise.

DELETING A TEXT BLOCK

To delete a text block, click on the text to select it, then
click anywhere on the text with the right mouse button
to open the options menu. Click Delete. This menu
item removes the text from the badge.
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ADDING AND EDITING A PHOTO PLACEHOLDER
The Badge Layout Utility of WIN-PAK places a photo
placeholder on the badge, not an actual photo. Photos
are imported into the badge when a photo is captured
and the badge design is assigned to the card holder in
the card database.

ADDING A PHOTO PLACEHOLDER

Adding a photo placeholder to a badge is as easy as
clicking on the badge with the photo tool. The cursor
can be changed to the photo tool in any of the following
ways:

1. Select Insert Photo from the Object menu,

2. click the photo button (  ) on the toolbar,

3. or click anywhere on an empty part of the badge
with the RIGHT mouse button and select Photo.

After the cursor has changed to the photo tool, click on
the badge where you want the upper left-hand corner of
the photo to be. The place holder can be moved,
resized, or edited as described below.

EDITING A PHOTO PLACEHOLDER

Clicking the RIGHT mouse button anywhere on a photo
placeholder opens up it’s option menu. The menu items
are explained below.
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PRIMARY PHOTO

Enabling this option assigns the placeholder to the photo
designated as the “primary” photo for the badge holder
in WIN-PAK. This is the only photo that is displayed in
the card lookup, pop-up, and card databases.

SECONDARY PHOTO

Enabling this option assigns the placeholder to the
photo designated as the “secondary” photo for the
badge holder in WIN-PAK. The only way to view the
secondary photo is in a badge layout view.

KEEP ASPECT RATIO

Enabling this option keeps the photo in proportion as
you are resizing so that it isn’t irregularly shaped.

ORIENTATION

This menu item allows you to rotate your photo.

Your options are:

0° Places your photo upright.
90° Rotates your photo 90° clockwise.
180° Places your photo upside-down.
270° Rotates your photo 90° counterclockwise.

DELETING A PHOTO PLACEHOLDER

To delete a photo placeholder, click on it to select it,
then click anywhere on the photo placeholder with the
right mouse button to open the options menu. Click
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Delete. This menu item removes the photo placeholder
from the badge.

ADDING AND EDITING A BITMAP GRAPHIC
WIN-PAK allows you to place bitmap graphic images on
the badge such as a logo or symbol. Simply create or
scan in your image and save it as a Windows bitmap
(*.BMP), JPEG (*.JPG), Targa (*.TGA), or TIFF (*.TIF).
Then use the “Import a Graphic...” option to place the
graphic in the correct WIN-PAK subdirectory.

ADDING A GRAPHIC IMAGE

Adding a graphic image to a badge is as easy as clicking
on the badge with the graphic image tool. The cursor
can be changed to the graphic image tool in any of the
following ways:

1. Select Insert Bitmap from the Object menu,

2. click the graphic image button (  ) on the
toolbar,

3. or click anywhere on an empty part of the badge
with the RIGHT mouse button and select Bitmap.

After the cursor has changed to the graphic image tool,
click on the badge where you want the upper left-hand
corner of the graphic image to be. This opens a dialog
box that allows you to select a graphic image for your
backdrop from your graphic subdirectory.

 NOTE
The “Import a Graphic...”
option in the File menu may
need to be used if the
graphic is not located in the
WIN-PAK data directory.
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Choose what type of graphic file you wish to import as
your backdrop from the File Types list. Your choices
are:

 (*.BMP)
 (*.JPG)
 (*.TGA)
 (*.TIF)

Once you select what type of file you are opening, you
can then view those files in the file list. When you see
the file that you want to use, select it and click OK.

EDITING A GRAPHIC IMAGE

Clicking the RIGHT mouse button anywhere on a
placed bitmap element opens up it’s option menu. The
menu items are explained below.

KEEP ASPECT RATIO

Enabling this option keeps the bitmap in proportion as
you are resizing so that it isn’t irregularly shaped.
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ORIENTATION

Orientation allows you to rotate your bitmap.

Your options are:

0° Places your bitmap upright.
90° Rotates your bitmap 90° clockwise.
180° Places your bitmap upside-down.
270° Rotates your bitmap 90° counterclockwise.

DELETING A BITMAP

To delete a bitmap, click on it to select it, then click
anywhere on the bitmap with the right mouse button to
open the options menu. Click Delete. This menu item
removes the bitmap from the badge.

ADDING AND EDITING A BARCODE
WIN-PAK creates barcodes for badges in a number of
formats that can be used for a wide variety of reasons.
Barcodes can contain information specific to the badge
design or to the cardholder. For example, the barcode
can reflect the card number or the user’s social security
number.

ADDING A BARCODE

Adding a barcode to a badge is as easy as clicking on
the badge with the barcode tool. The cursor can be
changed to the barcode tool in any of the following
ways:

1. Select Insert Barcode from the Object menu,

2. click the barcode button (  ) on the toolbar,

 NOTE
Some "High Density"
applications may require a
bar code font. In this case,
use the text field to define
your barcode instead of a
barcode field.

Another advantage to using
a barcode font is the ability
to rotate the barcode (text
block).
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3. or click anywhere on an empty part of the badge
with the RIGHT mouse button and select Barcode.

After the cursor has changed to the barcode tool, click
on the badge where you want the upper left-hand
corner of the barcode to be. The barcode can be resized
and moved or edited as described below.

EDITING A BARCODE

Select the barcode by clicking on it. Then click the
RIGHT mouse button anywhere on the barcode to open
up it’s option menu.

Click Data... to define your barcode with the following
fields in the dialog box:

STYLE

Select a barcode style from this dropdown list. Your
choice includes:

5fo2• 39edoC• ISM• ACPU•

devaelretni5fo2• 821edoC• FTI• ECPU•

9fo3• 821NAE• 11edoC• A821edoC•

rabadoC• 31NAE• BedoC• B821edoC•

93edoC• 8NAE• nepeleT• C821edoC•
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RATIOS
Select a ratio from this dropdown list to determine the
width ratio of thick bars to thin bars. For example, a ratio
of 2.00 would mean that thick bars are twice the width of
thin bars.

DATA
Data can be entered directly into this edit box. Either
type in what you want encoded or enter a field that you
want coded from the card holder’s database. To do this,
simply double-click a field from the listing of fields and it
will appear in the data edit box.

Data can be combined in much the same way as it was
in the text fields mentioned above. You should highlight
and delete the sample data (1234567890) when defining
this field.

CHECK DIGIT

Provides error detection.

SPACER

Adds space before and after the barcode when show data
is enabled.

SHOW DATA
This option displays the data encoded underneath the
barcode in what is called “human readables”.

EDITING THE BARCODE BACKGROUND COLOR

Click on the barcode to select it, then click anywhere on
the barcode with the right mouse button to open the
options menu. Select Background Color. Selecting this
menu item brings up a palette of Basic Colors for chang-
ing the barcode background color.

 NOTE
Error detection is not a
feature with all barcode
readers.
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Choose a color, select it with the mouse, and click OK.
If a custom color is needed for the barcode background,
it can be created (See Appendix F).

DELETING A BARCODE

Select the barcode by clicking on it, then click on it
with the RIGHT mouse button to open it’s options
menu. Select Delete. This menu item removes the
barcode from the badge.

ADDING & EDITING A SHAPE
The Badge Layout Utility allows you to place a shape
on your badge.  Shapes consist of rectangles, rounded
rectangles, ellipses, and lines.  You can change the
border or line width, the border and background color,
or make them transparent to frame photos or text
blocks.

ADDING A SHAPE

Adding a shape to a badge is as easy as clicking on the
badge with the shape tool. The cursor can be changed
to the shape tool in any of the following ways:

1. Select Insert Shape from the Object menu,

2. click the shape button (  ) on the toolbar,

3. or click anywhere on an empty part of the badge
with the RIGHT mouse button and select Shape.

After the cursor has changed to the shape tool, click on
the badge where you want the upper left-hand corner of
the shape to be. A square will be placed which can be
changed to a different shape, moved, and resized.

Right-clicking anywhere on the shape opens up the
editing menu. The menu items are explained below.
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BORDER OR LINE WIDTH...

You can change the width of the shape border or line.

FOREGROUND COLOR...
This will allow you to change the color of the border or
line.
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BACKGROUND COLOR...
This will allow you to change the color of the center of
the shape.  Not applicable if you have selected transpar-
ent.

TRANSPARENT
This turns the shape transparent.  It is not applicable if
the shape is a line.  For all other shapes, the center
region becomes transparent and only the border is
visible.  You can use this option to create frames for
other elements on the badge.

LINE

This turns the shape into a line.  If you stretch this shape
so that it is longer horizontally, it will be drawn as a
horizontal line.  If you stretch this shape so that it is
longer vertically, it becomes a vertical line.

RECTANGLE

This turns the shape into a rectangle.

ROUNDED RECTANGLE
This turns the shape into a rectangle with rounded
corners.

ELLIPSE
This turns the shape into an ellipse.

DELETE
Select this to delete the object from the badge.
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ADDING & EDITING A SIGNATURE
PLACEHOLDER
The Badge Layout Utility allows you to place a signa-
ture placeholder to reserve an area that the signature
can be imported onto the badge.

A signature pad (Northern Computers’ PB-SIG-CAP)
can be connected to the computer to scan in signatures.
The signatures are saved in vector format.  They can be
placed on the badges and are proportionally stretched
to fill the area allotted for them.  The color and weight
of the signature is user configurable.  They can also be
made transparent to be placed on top of any other
object on the badge.

ADDING A SIGNATURE PLACEHOLDER

Adding a signature placeholder to a badge is as easy as
clicking on the badge with the signature placeholder
tool. The cursor can be changed to the signature place-
holder tool in any of the following ways:

1. Select Insert Signature from the Object menu,

2. click the signature placeholder button (  ) on
the toolbar,

3. or click anywhere on an empty part of the badge
with the RIGHT mouse button and select
Signature.

After the cursor has changed to the signature place-
holder tool, click on the badge where you want the
upper left-hand corner of the signature placeholder to
be. The signature placeholder can be moved and resized
or edited.

Right-clicking anywhere on the signature placeholder
opens up this menu. The menu items are explained
below.
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LINE WIDTH...

The following dialog box will appear prompting you to
enter width of the line used in the signature. The width is
measured in millimeters.

FOREGROUND COLOR...

This will allow you to change the “pen” color of the
signature.

BACKGROUND COLOR...
This will allow you to change the background color of the
signature block.

TRANSPARENT
This makes the background color of the signature block
transparent.  When the signature is put on the badge, it
will appear to be written over what is behind it.

DELETE
Select this to delete the signature block from the badge.

 NOTE
Signatures cannot be
oriented.
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MAGNETIC STRIPE ENCODING
The Badge Layout Utility allows you to setup magnetic
stripe encoding information for each badge that you
create.   If you are using a supported printer that does
magnetic stripe encoding, you will be able to encode
cards when they are printed.

Each badge layout can have magnetic stripe encoding
data defined for it.  Any combination of text and fields
can be encoded on the magnetic stripe provided it is
within the bounds of the format.  Individual fields can
be placed within any ordinal character range, justified
left, center, or right, and padded with any character.

To edit the magnetic stripe information for a badge,
select the window containing the badge design that you
want to print. Then select Mag Stripe Setup... from the
File menu. Selecting this option opens a dialog box
called Setup Mag Stripe that will allow you define the
magnetic stripe information for that badge.

 NOTE
The magnetic stripe setup
MUST be assigned to the
layout used for the back side
of the card when duplex
(2-sided) printing.
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HOW MAGNETIC STRIPE INFORMATION IS DEFINED

As you can see in the above dialog, magnetic stripe data
can be defined for all three tracks. For each track,
specify the magnetic stripe format that will be used:
IATA, ABA, or TTS.

Each track can have any number (limited by the amount
of data that will fit on a given track) of data items that
can be consecutively written to it.  The data that can be
used is limited to certain ASCII characters, depending
upon the format selected for that track.

IATA will allow you to enter the numerical characters
0-9, the alphanumeric characters A-Z, and various
punctuation characters (ASCII 32-95). If lowercase
letters are used, WIN-PAK converts them to uppercase
first, as IATA doesn't understand lowercase. If a field
separator is required, it is designated by the "^". See
your printer documentation for the number of charac-
ters that can be encoded using the IATA format.

ABA will only allow numeric characters 0-9 and vari-
ous punctuation characters (ASCII 48-63). See your
printer documentation for the number of characters that
can be encoded using the ABA format.

TTS will only allow numeric characters 0-9 and various
punctuation characters (ASCII 48-63). See your printer
documentation for the number of characters that can be
encoded using the TTS format.

Each data item is defined by four fields.  The first field
is the length.  This is the number of characters that is
written to the track for this data item.  If the data item
is longer than the length, it will be truncated.  If it is
shorter it will be padded with the Fill character.  The
data item can be defined as “Variable” length.  This
means the number of characters written to the track is
equal to the length of the data item.  The second field is
the Justification.  Justification is only valid for fixed
length data items.  If a data item is shorter than the

 NOTE
Some encoders may not
utilize Track 3. Check your
printer before using this
feature.

 NOTE
The following track/format
assignments are the
industry encoding
standards:

IATA=Track 1
ABA=Track 2
TTS=Track 3

 NOTE
Currently, Northern Comput-
ers' readers only read ABA
or Wiegand type encoding.
The NR-1 reader reads ABA
on Track 2, and the NR-2
reader reads ABA on
Track 1.

 NOTE
Some magnetic stripe cards
may not support track 3
encoding. Check with your
card supplier for further
information.
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number of characters allotted for it, it can be justified
left, center, or right, within those characters.  All other
characters will be set to the Fill character.  The third
field is the Fill character, which is used to pad the data
to fit a fixed length field.  The last field is the Expres-
sion.  This can be any combination of text or database
fields.

EDITING THE TRACKS

To edit a given track, push the Edit button next to that
track, or double-click on a data item line within the
track list box.  This will bring up the Edit Track dialog.

The Edit Track dialog allows you to modify the data
format of each of the tracks on the magnetic stripe.
This dialog is shown below, along with information
about the controls on it.

ADD
Add a new data item to this track.  It is initially set to
default values.  Once created, you can then edit it to
configure the item with the proper data.
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EDIT...
Edit the currently selected data item.  You can also
double-click on the desired line in the list box.  See
below for information on editing track data items.

DELETE
Deletes the currently selected data item from the list.

MOVE UP

Moves the currently selected item up one position in the
list.  Use Move Up and Move Down to change the order
of the items in the list.

MOVE DOWN

Moves the currently selected item down one position in
the list.

Press OK to exit and keep any changes that have been
made, or Cancel to exit without keeping any changes.

If you edit any of the items from the Edit Track Data
dialog, you will see the Edit Track Item dialog.  This is
the lowest level dialog that will allow you to configure
each data item.

DATA

This can be any combination of text and database fields.
Double-click on the database fields in the Fields list to
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insert them in the Data edit box.  You can also type any
text you desire.

JUSTIFY

Select the justification method you would like to use for
this item.  If Length is Variable, justification is not
applicable.

LENGTH
Enter the maximum length of this data item, or Variable
to create a variable length item.

FILL CHARACTER
Enter the character you wish to use to fill the blank
space in fixed length data items.  You can specify any
ASCII value by typing \n, where n is a number.  You can
also just type a character in.

FIELDS
These are the fields available to be used in the data.
Double click on a field to insert it in the Data edit box.

Press OK to exit and keep any changes that have been
made, or Cancel to exit without keeping any changes.

PRINTING A BADGE LAYOUT
This section demonstrates how to print a copy of your
badge DEFINITION. It is not used to print badges with
personnel fields, photos, and barcodes filled in – that is
done from the Card Database in the main WIN-PAK
component.

Select the window containing the badge design that you
want to print. Then select Print... from the File menu or
click the Print button (  ) on the toolbar. Selecting this
option opens a dialog box called Select Printer.

 NOTE
Printer Drivers are added in
the Control Panel of Win-
dows, located in the Main
Group. See your Window’s
manual for more informa-
tion.

 NOTE
To enter empty spaces for
your Fill character, either
type a space or “\32” in the
Fill Character field.
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Select your printer from the drop-down list and click
Print to print the card design, or Cancel to go back to
the database without printing.

WINDOWS OPTIONS
The Window menu is a standard menu for most
Window’s applications. It allows you to organize open
and minimized badge windows in a variety of ways.
This menu is useful when working on more than one
badge a time.

Below is an explanation of the Window menu items:

TILE

This menu item arranges all open badges so that they
can all be seen. It is also handy for enlarging one open
badge to its maximum size.

CASCADE
This menu item arranges the badges in a stacked
position with the title bars showing.

ARRANGE ICONS
This menu item arranges all minimized badge windows
along the bottom left corner of the main window.

 NOTE 
A badge will not print until it
is saved.
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CLOSE ALL
This menu item closes all open badges. A prompt to save
the badge will appear for each badge that has been
modified but not saved. Click Yes to save the changes or
No to ignore the changes.

LIST OF OPEN BADGES
This menu also lists all open badges. The currently
selected badge has a check mark next to it. Clicking on
a badge name will make it the selected badge and bring
it to the front.

 NOTE
To display more than one
layout at a time, your
computer must be set to a
value greater than 256
colors.

However, while you are
capturing images from the
Card Database, you will
have to set your monitor to
256 colors if using the
VideoBlaster capture card.
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ALARM MONITOR SCREEN
Monitoring alarms is done with WIN-PAK’s Alarm
Monitor Screen. This screen reports all alarm and
reader activity as it happens. The user has four options
regarding how information is viewed. The user can
view alarms and card reads as they come in (History
View) or in order of priority (Current View). The opera-
tor can also view defined alarm points and their current
status in a grid (Monitor View) or by graphic floor plans
(Floor Plan View). Each of these views is explained in
detail in the following sections.

HISTORY VIEW
The History View displays all alarm information and
system communication as they are received from the
panels in a list form with the most recent information
appearing at the top of the list. This list will display
information on alarms and readers including the date,
time, and status.
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The operator would use this view to monitor alarms “at
a glance.” This view is used for getting an overview of
system activity only – not for acknowledging or re-
sponding to activity.

BROWSING ON-LINE HISTORY

When alarm and reader information fills the screen, a
scroll bar will appear so the operator can browse
through past actions.

The Freeze button will halt the display of actions for a
maximum of 120 seconds to keep the display from
showing more alarms while browsing.
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When frozen, the button will say Live and begin a
countdown to return to live alarm monitoring. The
operator can use this button to toggle back to “Live”
before the end of the countdown.
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CURRENT VIEW
The current view displays information on incoming
alarms. The screen is divided into two sections, one for
incoming alarms and one for acknowledged alarms.

INCOMING ALARM SECTION

The upper section of the screen receives alarms based
on the priority threshold for acknowledgment (as set in
the Setup portion of the program).  All alarms with a
priority higher (the number being equal to or lower)
than the threshold are displayed.  All alarms with a
priority lower (the number being higher) than the
threshold are NOT displayed.

In the Incoming Alarm section of the screen, the colors
of the bars indicate the type of alarms. A red bar is for
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an alarm condition, a green bar is for a normal condi-
tion, and a yellow bar is for a trouble condition. When
you click on an alarm  or a group of alarms to select
them, the bar turns gray.

Once a point goes into alarm or trouble, the bar color
will not go back to a normal color (green). For example,
if the first message from that point or card is “normal,”
subsequent “alarm” or “trouble” conditions change the
alarm to red or yellow.  After that it will stay red (or
change between yellow and red) but will not go to green
on a normal state. The Count column shows the number
of times a point changes state while it is in the upper
screen.

Double-clicking on a transaction brings up the Alarm
Info screen showing the details of what has been indi-
cated by the counter, and allowing a “Note” to be
written for that alarm. See the Alarm Info Screen section
of this chapter.

Acknowledging a transaction moves it to the lower
portion of the screen.

ACKNOWLEDGED ALARM SECTION

When an alarm is acknowledged, it is moved to the
Acknowledged Alarm section of the screen. The back-
ground color of the transaction is black, and the color of
the type changes according to the convention used in
the Incoming Alarm section: green for normal, yellow
for trouble, and red for alarm. The color changes with
each new condition. Transactions remain in the Ac-
knowledged Alarm section until they are cleared.

The position of the transactions in both areas of the
screen is determined by priority level and time.  The
highest priority transactions are first, and transactions
with the same priority are shown with the most recent
being first.

 NOTE
A yellow alarm, representing
an input in "trouble" condi-
tion, will only appear with an
N-1000-II board when an
AEP-5 board is being used,
or with an N-1000-III or IV
board.
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ACKNOWLEDGING AN ALARM OR CARD READ

Acknowledging an alarm or card read is an action that
shows that the operator has seen the alarm/card read
status. All alarms received in the Incoming Alarm
Section have a priority high enough to require acknowl-
edgment. To acknowledge an alarm or card read in
Current View, it is first necessary to select it. Alarms
can be selected one at a time by simply clicking on
them once.

More than one alarm can be selected at a time by
clicking on them with the mouse while depressing the
Control key. If one alarm is selected, and you press
Shift while selecting another alarm, both the alarms
and all in between will be selected.

Once the alarms you want to acknowledge are selected,
acknowledge them by either:

1. Clicking the Acknowledge button (  ) on the
toolbar or

2. Clicking on the alarm(s) with the RIGHT mouse
button and selecting “Acknowledge” from the pop
up menu that appears.

The alarm(s) will move to the Acknowledged Alarm
section of the screen.

CLEARING AN ALARM OR CARD READ

Clearing an alarm or card read will delete it. As with
acknowledging, alarms must be selected to clear them
from the Current View. Select the alarm(s) in the man-
ner described above and clear them by either:

1. Clicking the Clear button (  )on the toolbar or

2. Clicking on the alarm(s) with the RIGHT mouse
button and selecting “Clear” from the pop up
menu that appears.

 NOTE
Clearing an alarm may
require that the alarm point
be in the Normal mode. The
Clear Alarm State setting is
found in the Setup menu
under Communications.
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The alarm(s) will then be deleted.

VIEWING AND RESPONDING TO ALARM AND CARD
READ INFORMATION

To view alarm and card read information, double-click
on the alarm. This will open the Alarm Info screen with
information on that alarm. See Alarm Info later in this
chapter for information on using this screen.

VIEWING CARD INFORMATION

Selecting a card read in the current view and clicking on
the Card Lookup tab will display the information and a
photograph (if existing) of the card user. See Card Info
later in this chapter for more information on using this
screen.

LOCATING A CARD HOLDER FROM A READ

Selecting a card read in the current view and selecting
Locate... from the View menu will open up the Locate
tool with the card information pre-entered in the fields.
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MONITOR VIEW
The Monitor View displays a screen of alarm input
points defined by the operator. Icons representing these
points show the status of the alarm point. Green alarms
represent a normal condition, red alarms represent an
alarm condition, and yellow alarms represent a trouble
condition.

A number may appear in the center of the alarm denot-
ing the number of times the input point has changed
status since the last time it was cleared. Input points
requiring acknowledgment as defined in the Setup
Options and Panel Database will be flashing when
received.

 NOTE
A yellow alarm representing
an input in a "trouble" status
will only appear with an N-
1000-II panel when an
AEP-5 board is being used,
or with an N-1000-III or IV
board.
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DEFINING ALARM INPUT POINTS

To define alarm points for your grid, select Monitor
Points... from the View menu or click the Monitor
Points button (  ) on the toolbar.

A dialog box will open to allow you to select input
points to monitor.

LOOP

Use this dropdown list to select the loop (area) that
contains the point(s) you want to monitor.

PANEL
Use this dropdown list to select the panel that contains
the point(s) you want to monitor.

Once the loop and panel are specified, the enabled
input points for that panel will be displayed under
Available Input Points. Simply click once on the point
you want to monitor and it will be added to the Se-
lected Input Points list. Clicking points in the Selected
Input Points list will remove them.

 NOTE
System Alarms are not used
as Available Input Points.
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Click OK to add the input points in the Selected Input
Points list.

To identify an alarm, select it, and its name will appear
in the status bar. The number displayed in an alarm
icon is the number of times the alarm has changed state
since it was last cleared. Double-clicking the alarm will
open the Alarm Info screen to display alarm informa-
tion and allow the operator to enter a note.

ACKNOWLEDGING AN ALARM

As in the Current View, acknowledging an alarm is an
action that shows that the operator has seen the alarm.
An alarm in Monitor View will blink and beep until it is
acknowledged. To acknowledge an alarm in Alarm
Monitor, it is first necessary to select it. Alarms can be
selected one at a time by simply clicking on them once.

More than one alarm can be selected at a time by
clicking them while depressing the Control key. If one
alarm is selected, and you press Shift while clicking on
another alarm, both the alarms and all alarms in be-
tween will be selected.

Once the alarm you want to acknowledge is selected,
acknowledge it by either:

1. Clicking the Acknowledge button (  ) on the
toolbar, or by

2. Clicking on the alarm(s) with the RIGHT mouse
button and selecting “Acknowledge” from the pop
up menu that appears.

The alarm will stay on the screen but will not flash.

CLEARING AN ALARM

Clearing an alarm will not delete it from Monitor View,
but it will clear the Alarm Count in the alarm. As with
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acknowledging, alarms must be selected to clear them.
Select the alarm and clear it by either:

1. Clicking the Clear button (  ) on the toolbar or

2. Clicking on the alarm(s) with the RIGHT mouse
button and selecting “Clear” from the pop up
menu that appears.

The alarm count will then be cleared on the monitor.

POLLING AN ALARM

A panel doesn’t report when a point is shunted. Polling
is valuable when points are shunted and you want to
know whether a point is “open” or “closed”. To poll an
alarm: (1) Select the alarm, (2) right click on it to bring
up a menu, and (3) select Poll. Only points associated
with that panel will report.

VIEWING ALARM INFORMATION AND RESPONDING TO
ALARMS

To view alarm information, double-click on the icon.
This will open the Alarm Info screen with the message
defined for the alarm status in the Panel Database. See
Alarm Info later in this chapter for more information on
using this screen.

 NOTE
Use of the polling feature
requires that the control
panel has version 7.46 or
higher firmware.
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FLOOR PLAN VIEW
This view gives the operator the option of monitoring
alarms by floor plans and/or digital photos. Floor plans
can be representations of a building created in a “paint-
ing” program and saved as a bitmap file. Photos can be
taken with a digital camera or scanned in and saved as
a bitmap file. The bitmap is referenced and given a
descriptive name in the Floor Plan Database. See Floor
Plan Database in Chapter 3 for more information on
defining floor plans.

Floor Plans are accessed by clicking on the dropdown
list at the bottom of this screen, and selecting the floor
plan that you want. This list consists of floor plans
defined in the Floor Plan Database.
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USING FLOOR PLAN HOT SPOTS

The Floor Plan Database allows the operator to create
“hot spots” on the floor plan, which can represent
another floor plan, an input point, or both. Hot spots
will appear as dashed rectangles when linked to an-
other floor plan or as an alarm when linked to an input
point. When the cursor is over the hot spot, a message
pertaining to it appears in the status bar.

Clicking the floor plan hot spots on the floor plan can
bring up a floor plan or other graphic. This makes it
possible to build detailed graphic maps where the
operator could click on a portion of a floor plan to get a
more detailed look at a specific area.

   

While clicking on a floor plan hot spot will bring you to
another floor plan, clicking on the new plan with the
RIGHT mouse button will bring up a pop-up menu.
This menu will be a list of the floor plans that you have
“travelled through” to get to the current graphic. Click
on any of these to get back to those floor plans.

MONITORING ALARM POINTS

Hot spots can also be defined in the Floor Plan Database
as alarm input points.  These will appear on the floor
plan as alarm icons. This gives the operator the option
to monitor alarm points like in the Monitor View but
with points placed on a floor plan. This makes it easy to
recognize where a particular alarm is in a facility.
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ALARM INFO
The Alarm Info screen is used to view alarm and card
read information and allow the operator to enter a
response. When an alarm is triggered or a card is read
(with the appropriate threshold settings), it will appear
in the Alarm Monitor Screen in the Current View and, if
defined, in the Monitor and Floor Plan views. Double-
click the alarm in one of these views or select it and
click on the Alarm Info tab to view alarm information
and the message associated with it. These messages are
defined in the panel and card databases.

Each change of state of the alarm is displayed until the
point is cleared.

 NOTE
A note must be entered into
the Notes field BEFORE the
alarm is acknowledged.
After the alarm is acknowl-
edged, the notes field
cannot be edited.
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This screen also provides a field for entering response
notes. To enter a response note to an alarm state, simply
select the state in the Alarm Info field, click within the
Notes field and type your note. If “Log Actions” is
enabled in the Operator Options screen (Located in the
Setup Menu), then these notes will be saved and can be
printed in a history report.

 NOTE
It is necessary to press
Enter at the end of each line
when creating a comment.
Words will not automatically
wrap to the next line when
typing.
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PANEL CONTROL
This screen gives the user direct control over the panels
and the active input and output points connected to
them. This is where panels are buffered, unbuffered,
and initialized and where individual input points can
be shunted and output points can be energized. Com-
mand files can be sent to individual panels and remote
areas can be dialed up from this screen.

All commands sent to area panels are shown in the
Progress Window. This will display a list of every
command and it’s current status. When the window
fills up, a scroll bar will appear allowing you to browse
through all your actions.
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Under the Progress Window is the Transaction Status
bar. This bar shows the progress of the currently sent
commands.

AREA

Select the area that you want to communicate through
from this drop down list. All remote and local areas
defined as Loops in the Area Database will appear in
this list. Selecting a remote area will add a Connect
button to the screen for further options explained later in
this chapter.

CONTROLLING PANELS

PANEL

Select the panel you want to control from this list. All
Panels defined for the Area that you selected will appear
in this list.

BUFFER PANELS
This button buffers the panel selected in the Panel field.
Clicking this button stops all panel information from
being sent to WIN-PAK, and instead stores it in it's own
memory. This is useful when WIN-PAK is exited or when
troubleshooting panels.

UNBUFFER PANELS
This button unbuffers the panel selected in the Panel
field. Clicking this button prompts the panel to send all
buffered transactions to WIN-PAK. Alarms that were
buffered will be presented in the alarm monitor with the
time that the alarm occurred at the panel. WIN-PAK will
act on the alarms per WIN-PAK’s program options
(buffer, floorplan, command files, messages, etc...).
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PANEL INITIALIZATION

The Initialize button opens a dialog box allowing you
to send programmed information to the panel(s) se-
lected in the Panel field. Specify which information you
want sent by enabling the options below.

All panel inputs will report in twice when the Initialize
option is selected.

INITIALIZE
Enabling this option will include information contained in
the panel definition (anti-passback, free egress, etc..)
and site codes and will also delete all cards in the panel
when the OK button is pushed.

TIME & DATE

Enabling this option will include the current time and
date (as defined by the system clock on your PC) when
the OK button is pushed.

CARDS

Enabling this option will include card information when
the OK button is pushed. Cards are automatically
updated when using the Card Database. Therefore, it is
not always necessary to send cards to the panel from
this screen.

 NOTE
If sending only cards, it is
recommended to completely
re-initialize the panel with all
options. This is to delete old
cards still located at the
panel.

 NOTE
When selected, Initialize will
reset the panel’s program-
ming. Therefore, all options
should be selected when
Initialize is enabled.
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COMMAND FILE
Enabling this option will send the command file that is
assigned to the panel when the OK button is pushed. A
command file is assigned to a panel in the Panel Screen
in the Panel Database.

HOLIDAYS
Enabling this option will include the Holidays database
when the OK button is pushed.

TIMEZONES

Enabling this option will include panel timezone informa-
tion when the OK button is pushed.

INPUT POINTS

Enabling this option will include input point information
(shunt times, timezone assignments, interlocks, etc..)
when the OK button is pushed.

OUTPUT POINTS
Enabling this option will include output point information
(pulse times, timezone assignments, interlocks, etc..)
when the OK button is pushed.

GROUPS
Enabling this option will include group information (pulse
times, timezone assignments, interlocks, etc..) when the
OK button is pushed.

Clicking OK uploads all the information enabled in the
Panel Initialization section to the panel specified in the
Panel field.

SENDING A COMMAND FILE

Any command file defined in the Command File Data-
base can be manually sent to a panel. To send a

 NOTE
The command file will be
sent to the “Area” defined in
the command file.
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command file, (1) select it from the dropdown list and
(2) Click the Send button.

CONTROLLING REMOTE PANELS

If the area that you select in the Area dropdown box is
defined as a remote area, and has panels assigned to it,
a button labeled Connect will be visible. Clicking this
button opens a dialog box allowing the operator  to
send commands via modem to a remote area. The
commands appear in the order that they will be per-
formed.

CONNECT
Enable the Connect option to dial the remote site. This
option will be “grayed” if the current area is already on-
line. The option will be selected and "grayed" if it is not
connected and you click on Connect .

SEND DATE & TIME
This option is recommended to maintain time sync with
the system.

UNBUFFER

Enable this option to unbuffer the panels at the remote
location. It is recommended that this option be selected
if the Send Commands option is selected. When send-
ing commands, information at the panel may be lost if
not unbuffered.

 NOTE
Panel control of the remote
loop will be grayed out until
a connection is made with
the remote site and if
unbuffer is selected. The
control options will remain
grayed out until the panel is
unbuffered.
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SEND COMMANDS
Enable this option to send the card database updates to
the remote site. It is recommended that if buffered
information is needed, to unbuffer the panel as well. If
Send Commands is enabled, and Unbuffer is not, then
buffered events may be lost.

BUFFER
Enable this option to buffer information at the remote
panels after unbuffering and sending commands.

DISCONNECT

Enabling this option will disconnect the remote area from
WIN-PAK when completed. If you do not disconnect
automatically, you will remain on-line until you select the
“Area” and click the Disconnect button.

Clicking OK will perform all enabled commands in the
order they appear for the remote area selected. If all
commands are enabled, the following will happen:

1. WIN-PAK will connect to the remote site.

2. WIN-PAK will update the remote site's date
and time.

3. WIN-PAK will unbuffer information from the
remote panels and download them to the
Alarm Monitoring views.

4. WIN-PAK will send the card updates.

5. WIN-PAK will re-buffer the panels at the
remote site.

6. WIN-PAK will disconnect from the remote site.

If the Disconnect option is not selected in the Remote
Dial-up, a Disconnect box will appear where the Con-
nect box was. Clicking on the Disconnect box will
provide similar options. The Remote Dial-up box will
show the Buffer option marked (suggesting to buffer



258 Win PAK 1.15 User Manual

remote panels) and the Disconnect option marked and
“grayed”, to allow disconnect.

CONTROLLING INPUT POINTS

SHUNT

Click this button to shunt the currently selected input
point.

UNSHUNT

Click this button to unshunt the currently selected input
point.

RESTORE TO TZ (TIMEZONE)

When a point has been shunted or unshunted during a
timezone, it should be returned to the timezone when
the “override” is done. Click this button to restore the
selected input to the programmed timezone.

CONTROLLING OUTPUT POINTS

ENERGIZE

Click this button to energize the currently selected output
point.

DE-ENERGIZE
Click this button to de-energize the currently selected
output point.

PULSE
Click this button to pulse the currently selected output
point.
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RESTORE TO TZ (TIMEZONE)
When a point has been energized or de-energized
during a timezone, it should be returned to the timezone
when the “override” is done. Click this button to restore
the selected output to the programmed timezone.
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MUSTER SCREEN
Muster reporting allows an operator to track where card
holders are in the event of an emergency. Tracking
depends upon the setup of tracking areas in the Track-
ing Areas database. These areas are based on the readers
used to enter areas of a facility. See Tracking Areas
Database in Chapter 3 for more information.

Once tracking areas have been defined, a new screen
will be added to the operations screens.  Clicking the
Muster Report Tab opens up this screen.

The upper section is the Muster Area Card Transac-
tions section.  Normally this section will be empty. If a
muster is declared, people will go to the muster readers
to present their cards, and this section will show those
card reads.  If people go back into the tracking areas, or
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use an exit reader (to go home, for example) their card
read record is removed from this area.

The updating of this view is done automatically, but can
be “frozen” to view the muster area list. To do this,
disable the Refresh Muster Report option by clicking
on the box in the lower left hand corner.  When you
click on this box the check mark disappears, and the
card read records coming in from then on are stored in
a buffer rather than written to the screen.  This allows
you to work with an unchanging screen.  When you
click on the box again to enable the option, the card
reads stored in the buffer are written to the screen and
all card reads from then on are recorded until you
disable the option again.

You can delete card read records from the Muster Area
Card Transactions screen by selecting a card and
clicking the Delete button under the right corner of the
list. The Refresh Muster Report option MUST be
disabled (unchecked) to delete a card.

The lower section of the screen is the Non-Muster Area
Card Transactions section.  This section functions
generally in the same manner as the Muster Area Card
Transaction section except that it is dealing with card
reads from the tracking readers.  This section will have
a lot of activity going on most of the time.  During a
muster call, some or all of the activity would switch to
the Muster Area Card Transaction screen.  The Refresh
Muster Report box affects this section of the screen in
the same manner that it affects the upper section.

SORT ORDER
The Sort Order selections for both the upper and lower
sections work in the same manner as the sort order
selectors in other areas of the Database structure.
Options include sorting by card number (if the operator
has the View privilege), card holder name, tracking area,
and date/time.
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FILTER
The Filter selections allow you to view reads from all
areas at one time, or only the reads from a particular
area.

REPORTS
Print Reports will print a report based upon the sort order
and filters you have selected.  It gives you the option of
reporting on the muster area only, the non-muster area
only, or both areas.

MUSTER SYSTEM PRECAUTIONS
When designing a muster system for use with WIN-PAK,
it is important to keep the following precautions in
mind:

1. Use a separate dropline (COM port) to isolate the
muster readers from the tracking units. A special
line should be run to provide a unique data path
that will still be intact should the wiring from the
main facility get damaged.

2. A “cold restart” of the access control panel could
occur from a serious surge on the power or
communication lines. This can cause corruption of
the panel’s database and time functions. Version
8.01.10 and higher firmware address the time
problem by generating a system alarm 99 (Panel
Database, System Alarms, Panel Reset Alarm) when
the panel experiences a cold restart. WIN-PAK will
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then send the current Time and Date to the panel
within 60 seconds of receiving this alarm. The
default time and date after a cold restart is January
1st, Monday at 12:00am. You will be able to see
this time stamp on activities in the History view.
Panel Time is critical to the proper operation of the
Muster function as the most recent event is used to
determine the Tracking/Muster status of a Card
holder. If a card is presented to the Muster reader
and the time and date stamp is earlier than from
another reader location, there will not be a change
of status to the Muster (safe) location.

3. In the event that the card database is lost or
corrupted at the muster reader, WIN-PAK will
recognize all reader types (Not Found, Time Zone,
Normal, Trace, Pin Violation, and Expired) as
“valid” muster reads (provided that the time is later
than the previous card read as described above).
This function will prevent the need to reload the
cards to a muster panel during a muster event.
Only Valid and Trace card reads will count at a
Tracking reader.

4. The communication loops should be RS-485. WIN-
PAK should have corresponding Areas defined as
RS-485 with ACK-NAK enabled. If using N-485-
API-2s, they must be powered by a battery backed
up power supply (not required for N-1000-III or N-
1000-IV where the 485 is built into the control
panel and is already using the battery backup of
the control panel).

5. An UPS or other backup power source should power
the WIN-PAK computer, N-485-PCI-2 and other
associated communication devices. Installation of the
equipment should be in a location that is considered
“safe” from known hazards.
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6. The muster system should be on-line (not buffered)
to ensure timely and complete information.
Regular checks to insure that the muster system is
functioning properly should be performed as part
of the security routine and should be rigorously
enforced.

7. As mentioned above, it is critical that the time and
date be correct on card reads at the Muster readers.
If the time and/or date are earlier than that of other
reads in the system they will be ignored. For this
reason, regular checks should be made to see that
all panels are maintaining the correct time and
date. The checklist for actions to be performed at
the computer during the time of the muster should
include several checks to be sure that the muster
reads are coming in from the panel with the correct
time and date. If it is observed that they are not,
officials should order the swiping of cards stopped,
and the time and date should be sent to the panel.
A quick test should then be run and all people who
might have swiped their card during a time when
the time and/or date were incorrect should be
directed to repeat their swipe. Multiple swiping of
the same card at the Muster reader will not
adversely affect the result of the Muster as the
most recent time/date stamp is the one that is
“displayed” in the Muster section. This procedure
should be practiced regularly, so personnel have a
clear familiarity with it. The Scheduler should also
be programmed to update time and date at least
once a day.
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CONTROLLING CAMERAS
The Camera Control Screen is used to assign cameras to
monitors and to make adjustments to cameras in a
CCTV monitoring system.

ASSIGNING CAMERAS AND MONITORS

To assign a monitor to a camera view, select the monitor
name from the left column, the camera name from the
right column, and click Select. The camera view selected
will then appear on the selected monitor.

To view the titles of the camera views on the appropri-
ate monitors, click Send Titles. This will display titles
on all camera views being monitored. See your CCTV
equipment manual to see if the title feature is sup-
ported.
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CONTROLLING A CAMERA
Adjustments can be made to cameras remotely from
within WIN-PAK. Select the camera that you want to
control from the Camera to View drop-down list. Once
you have a camera selected, you can adjust it in any
number of the following ways.

TO ADJUST FOCUS

 FOCUS ON CLOSER OBJECTS

Clicking and holding down this button slowly brings
objects closer into focus.

 FOCUS ON FARTHER OBJECTS

Clicking and holding down this button slowly brings
objects farther away into focus.

TO ADJUST APERTURE

 INCREASE APERTURE

Clicking and holding down this [top] button slowly
increases the aperture of the camera iris, letting in more
light. The icon will change showing the center more
open when “pushed”.

 NOTE
This function of WIN-PAK is
for facilities with CCTV
systems. Setting up
WIN-PAK for these systems
requires that the Camera
and Monitor Databases
contain records and that an
area is defined as a CCTV
network.

 NOTE
Your camera must support
focus, aperture adjustment,
zoom, pan and tilt, homing
presets, and titling to take
advantage of these features.
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 DECREASE APERTURE

Clicking and holding down this [bottom] button slowly
decreases the aperture of the camera iris, letting in less
light. The icon will change showing the center closed
when “pushed”.

TO ADJUST ZOOM

 ZOOM IN

Clicking and holding down this button slowly zooms the
camera in closer.

 ZOOM OUT

Clicking and holding down this button slowly zooms the
camera out farther.

CAMERA PAN AND TILT CONTROL

 CONTROL ARROWS

Clicking and holding down the camera control arrows
move the camera. Clicking and holding down the Left
Arrow pans to the left, while clicking and holding down
the Right Arrow pans to the right. Clicking and holding
down the Up Arrow tilts the camera up, while clicking
and holding down the Down Arrow tilts the camera
down.
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SETTING PAN AND TILT LIMITS

Limits should be set on each camera’s panning and tilting
actions. Limits are used to keep a camera from tilting and
panning to a point that is stressful on the hardware and to
limit a camera’s view to that which is useful. The follow-
ing steps demonstrate how to set the upward tilt limit for
a camera. Repeat these steps for downward tilt, left pan,
and right pan on each camera.

1. Use the up and down arrows to tilt the camera to
the highest point needed.

2. Right-click on the up arrow with the mouse.

3. Click Set Limit from the pop-up menu.

To clear a limit that has been set:

1. Right-click on the arrow with the limit you want to
clear.

2. Click Clear Limit from the pop-up menu.

SETTING HOME POSITION

A Home Position is the most utilized view of a camera.
It can be set for each camera so that it will return to it’s
home position with the correct focus, aperture, and
zoom settings when the Home button is pushed. The
following steps outline setting a home position:

1. Adjust the pan, tilt, and adjustment settings for the
view that you want to make your home position.

 NOTE
Your CCTV equipment must
support preset limits to use
this feature.

 NOTE
Your CCTV equipment must
support the home position
to use this feature.
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2. Right-click the Home button and click Set Home
from the pop-up menu.

Now your camera will return to this view when you
click the Home button.
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LIVE CAMERA VIEW
Monitoring of cameras can be done without using the
Camera Control Screen if a video capture board is
installed. Simply select Live Camera from the View
menu to bring up the live camera dialog box. This
screen is adjustable in size and can be located any-
where on the WIN-PAK screen.

 NOTE
Live Camera View is not an
option if TWAIN interface
was chosen instead of a
video capture card during
WIN-PAK installation. It will
only display video when the
Flashpoint or SE100 board
is installed.
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Select the CCTV Area that contains the camera that you
want to view from the Area drop-down list. If you
would like to see the camera view on a monitor as well
as live on your screen, select the monitor you want to
view it on from the Monitor drop-down list. Select the
Camera that you want to view from the Camera drop-
down list.

Adjustments made to Iris, Zoom and Focus are done the
same way as outlined in the Camera Control screen
section.

Panning is done differently in the Live Camera dialog
box. As you move the cursor over the live camera view
portion of the screen you will notice that the cursor
turns into an arrow. The arrow will point in the direc-
tion of the closest edge of the view. Depressing the left
mouse button will pan in the direction the arrow is
pointing.

A command file can also be sent from this dialog box.
Select the command file that you want to send from the
drop-down list, and click Send.

 NOTE
Displayed areas and
command files are only
those associated with an
area defined as camera.
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THE CARD LOOKUP SCREEN
The Card Lookup screen is designed to be a quick way
for the operator to access card information without
having to enter the card database. It’s screen offers the
operator the card number, name, card status, PIN
number, access level, expiration date, and user-defined
note fields for the card holder. It also displays the card
holder’s badge photo.

The records in the database can be browsed using the
navigation buttons at the bottom of the screen. Each
button will take you to a record based upon the record
you are currently viewing and the index used in the last
search. The buttons are as follows:
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FIRST RECORD
Click this button to bring up the first record in the card
database.

PREVIOUS RECORD
Click this button to bring up the record preceding the
currently viewed record in the card database.

NEXT RECORD
Click this button to bring up the record following the
currently viewed record in the card database.

LAST RECORD
Click this button to bring up the last record in the card
database.

CARD SEARCH

Besides browsing records one at a time, it is also pos-
sible to search for a card record using the search tool.
To find a particular card holder, simply click in the
information space next to a key field name, type in the
criteria, and click the Search button (  ). The key
fields that can be searched by are:

CARD NUMBER

Click next to this label and type in the card user’s card
number. If the full card number is not known, type in
the beginning digit(s) of the number. Clicking the search
button (  ) will bring up the first occurrence of that
number and the records will be indexed by the Card
Number field. Click the next button (  ) for successive
occurrences of that number (if available).

 NOTE
You cannot search on any of
the following fields from this
screen: Status, PIN, Access
Level, or Card Limit.

You also cannot search on
the Card Number if the
operator doesn’t have
access to view the number.
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NAME

Click next to this label and type in the card user’s name
using the Lastname, Firstname format. You can also
type in the beginning characters of the last name.
Clicking the search button (  ) will bring up the first
occurrence of a record with a last name beginning with
those letters. The records will be indexed by last name
so that clicking the next button (  ) will bring up
successive alphabetical records.

ANY USER-DEFINED FIELD

Click next to any of the user-defined fields and enter
the information for that field. Enter as much of the
beginning characters that you want. Clicking the search
button (  ) will bring up the first occurrence of those
characters indexed by the user-defined field. Clicking
the next button (  ) will bring up successive alpha-
betical records.

PHOTO VIEW OPTIONS

Grayscale: This option shows the photo as a black
& white picture and is the quickest
method of viewing a photo.

Color: This option shows the photo as a color
picture, taking advantage of the
number of colors your screen is
capable of displaying. It is the second
quickest method of viewing a photo,
but may have a striped or blotchy
effect when running with a monitor
setup of 256 colors or less.

 NOTE
You cannot locate by using
the first name only.
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Dithered Color: This option displays the photo as a
higher quality color picture by
appearing to “increase” the number of
colors your monitor can display. It
does this by alternating different color
pixels to simulate one color. This
provides a smoother color transition
within a photo with a less striped or
blotchy effect. This option takes the
longest time to display and provides a
higher quality than “Color” only when
the monitor is set to display 256 colors
or less.

AUTOMATIC CARD LOOKUP
WIN-PAK can be set to automatically look up cards that
come from readers or cards with status priorities higher
than a particular threshold. The operator can determine
this priority threshold by selecting Options from the
Setup menu and clicking the Communications tab to
open the Communications Screen.

In the Alarm Monitoring section, note the number box
labeled “Auto card lookup priorities less than:” and
adjust the number by typing it in the box or by using the
arrow keys to increment/decrement the number. All read
statuses that are a higher priority (lower number) than
this threshold will pop up a card lookup screen.

This screen will show the card holder’s photo and card
number (if operator has View privilege), the reader
name, transaction status, and the message associated
with the card or reader status (card status will appear
first). Clicking the Alarm Info... button will bring up the
Alarm Info Screen so that a comment may be entered.
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This dialog box is re-sizable and can be placed anywhere
on the screen. A gray box will appear where the photo
would be when a card that is not in the database is read
or if there is no photo attached to the card holder.

LOCATE TOOL

WIN-PAK includes a function to help identify the
whereabouts of a particular card holder. This is called
the Locate tool. Use the following steps to find the last
place and time that a card holder presented their card.

1. Select Locate... from the View menu. The locate
dialog box will appear.

2. Fill in the card number or last and first name of
the person you are trying to locate. Card numbers
MUST be entered in entirely, but you only need to
type in the first part of the last name to do a
search. All card holders whose last names begin
with those letters will be reported on.
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If the last name and card number aren’t known, it
will be easier to use the Cards... button to fill in
those fields for you. Clicking the Cards... button
opens the Card Database.

Select a sort order and use the scroll bar (if needed)
to find the person you want to locate and select
that record. Click Close to return to the Locate tool
and the information of the selected record will
automatically be filled in the fields.

3. Click Locate. A report will be generated providing
you with information on the last time the card
holder presented the card at a reader. The
information includes the date and time of the
event, the reader name, the card number and name
of the card holder, the area and panel name, the
card and read statuses, and the tracking area.
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When the Locate tool is accessed while browsing cards in
the Card Lookup screen, the information of the currently
viewed card record will automatically be filled in the
Locate fields.
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THE MAIL SCREEN
The Mail screen is used to communicate from the server
to the network stations. Although labeled mail, it is
actually a chat function with the ability to broadcast a
message to all WIN-PAK stations currently networked
and on-line in WIN-PAK.

IN BOX

This box is used by network clients to display messages
sent from the server.

OUT BOX

This box is used by the network server to send mes-
sages to one or more on-line operators at client stations
in the network.



280 Win PAK 1.15 User Manual

TO SEND A MESSAGE FROM THE SERVER

1. Type a message in the Message box that you want to
send to another operator at a client station.

2. Click on the operator(s) that you want to send the
message to in the Users box. The Refresh List
button will update the display of all operators
currently on the network and logged into
WIN-PAK. When sending a message to more than
one operator, it is a good idea to refresh the list
before you send a message, so that you can select
recently logged on operators. Clicking the Select
All button is a quick way to select every operator
listed in the Users box.

3. Click Send to send your message to the operators
you selected. The Mail Screen will automatically
be opened on the monitors of those operators and
your message will appear in their In Box.

 NOTE
The Mail function currently
only allows one way
information from the server
to the clients. Future
versions will allow two way
chat between any network
stations.
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VIEWING REPORTS
WIN-PAK allows you to generate a wide range of reports
that you can view on the screen and print out. To
generate a report, select the Reports menu to view
reports.

Available reports include History Reports... and Data-
base Reports and Attendance Reports.

The report viewer, as shown below, is used to browse
reports on screen.

The Report Viewer

Page Navigation Tools Number of Records Reported

Report displayed as it will print

Current
Page

Report Name

Scroll Bar
Cancel currently generating report
3-view zoom tool
Print report
Export report to file

The report will display in the viewer as it will appear
when it is printed. The name of the report and date
generated are at the top left of the page. Reports are in a
column format with the headings for each column at the
top of each page.

 NOTE
In order to preview a page,
the report printer must be
defined. If Windows does
not have a print driver
loaded, no preview will be
given.
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VIEWER TOOLS

The Report Viewer has several tools to assist in viewing
reports.

 SCROLL BAR

The scroll bar can be used to browse the entire length of
a page. Click on the arrows to browse slowly or on the
bar itself to move up or down a screen at a time.

 FIRST PAGE
Use this button to view the first page of the report

 PREVIOUS PAGE
Use this button to view the page before the one currently
displayed.

 NEXT PAGE
Use this button to view the page after the one currently
displayed.

 LAST PAGE
Use this button to view the last page of the report.

 CANCEL
Use this button to cancel a report before or while it is
updating the preview.

 3-VIEW ZOOM TOOL
Use this button to move between three different views.
One view shows the page at 100%, another view fits the
entire page in the viewing window, and the last view fits
the page in the window from side to side.
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 PRINT
Use this button to print the report.

EXPORTING THE REPORT

WIN-PAK allows the export of report information to a
number of various file types. Click either of the two
buttons shown to bring up the Export dialog box.

FORMAT

Select the type of file you want to export to from the drop-
down list. A number of data, word processing, and
spreadsheet formats are available. Some selections may
request additional information before exporting the data.

DESTINATION

In most cases you will probably want to export the data
to a file on your own computer. If so, select Disk File
from the Destination drop-down list, and you will be
prompted to navigate to the directory you want the file put
in. If you want the exported data to be sent directly to
someone else, you can select a mail system from the
drop-down list. If you have the mail system installed, you
will be prompted for a person to send it to, otherwise
nothing will be exported.
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STATUS INFORMATION

PAGE 
This information shows you the current page and the
number of pages total.

RECORDS 
This information shows you how many transactions  are
included in the report. You can see this number increase
as the report is being generated.
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GENERATING HISTORY REPORTS
A history report is a log of transactions that occur
between two points in time. The report can include card,
input point, operator, guard, and system transactions.
An operator with report generating privileges (see
Operator Database) can generate reports for any time
period for any or all areas and panels. The report, shown
below, includes transaction date and time, type of
transaction, status (activity), card name, reader, tracking
area, acknowledge time and date (if enabled), and
operator (if enabled).

HOW TO GENERATE A HISTORY REPORT

Select History Reports... from the Reports menu. The
following dialog box will allow the operator to enter
selection criteria.
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To narrow your search and determine the information
reported, type criteria in the spaces provided.

DATE RANGE
The Date Range is defaulted as today and yesterday.
Enter the start date of the range that you want reported
on by clicking on the   button next to the From box.
Scroll to the desired year and month, then highlight the
day you want on the calendar.

To enter the end date of your desired range click on the
button next to the To box and choose the desired date
from the calendar. The dates will be formatted “MM/DD/

 NOTE
Purged information cannot
be displayed. Archived
information (beyond date/
time range) may be retrieved
by selecting the "From
Archives Option" shown
below.
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YY,” where MM is the month, DD is the date and YY is
the year.

TIME RANGE

Enter the time range that you want reported on, typing
the starting time in the first text entry space and the
ending time in the second text entry space. Follow the
format “HHMMSS” for both of these two times with “HH”
being the hour, “MM” being the minutes and “SS” being
the seconds. For example: 133000 would be 1:30 pm.
Leaving these spaces blank will generate a report on all
times for the dates specified above.

If both the date and time ranges are left blank, a report
will be generated on all dates and times currently in
unpurged history files. This process could take some
time depending on how much history has been gener-
ated.

If the date range is specified, but the time range is left
blank, then history for the specified dates (that are not
purged) are reported.

If both the date range and time range are specified, then
history that is between the defined hours and not purged
will be reported for the dates specified. The hours
cannot cross midnight.

The “Daily” option allows two ways of using the date
and time ranges:

DAILY ENABLED
If “Daily” is enabled (box checked), then history is
reported on the specified time range for each day in the
date range. See the chart below.

DAILY DISABLED
If “Daily” is disabled (box NOT checked), then history is
reported from the starting time of the starting date

 NOTE
Seconds are currently not
monitored at the panel.
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6/23

6/23

8 am

8 am

9 am

9 am

10 am

10 am

11 am

11 am

12 pm

12 pm

1 pm

1 pm

2 pm

2 pm

3 pm

3 pm

4 pm

4 pm

5 pm

5 pm

6/24

6/24

6/25

6/25

6/26

6/26

6/27

6/27

6/28

6/28

“Daily” Enabled

“Daily” Disabled

Enabling the “Daily” Option
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continuously to the ending time of the ending date. See
the chart on the opposite page.

AREA

Choose an Area from the drop-down list if you want only
the history for a specific area generated or choose the
“ALL” option for a full system history report.

PANEL
Choose a name from the Panel drop-down list if you want
only the history for a specific panel generated, or choose
the “ALL” option  for a full system history report.

TRANSACTION TYPES

All transaction types are included by default. The
operator has the ability to enable or disable Card, Point,
Guard, Operator, and System Transactions for inclusion
in the history report.

The three buttons at the lower right hand corner of the
dialog box (Card..., Point..., & Operator...) are for speci-
fying transaction criteria (where transaction types have
been enabled).

The operator’s alarm acknowledgment information is
automatically included when either the Card Transaction
or the Point Transaction options are enabled.

FROM ARCHIVES
History reports can be generated from archived history.
By enabling the “From Archives” option in the History
Selection Criteria box, another dialog box will appear
when you click OK, prompting you to select which
archive file you would like to run the report on.

 NOTE
Remember that the date of
the archived file does NOT
include transactions for that
particular day. For example,
the file 19981101.DBF does
not include or contain
transactions for November 1,
1998. See Chapter 7 for
more information.
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Archive files are named by the date that they are
archived from. For example, if the date selected in
the archive procedure was November 1, 1998, then
the file would be called 19981101.DBF. Select
which archive file you want to run the report on
and click OK.

Remember that the date range must reflect dates
included in the archived file, otherwise you will
not get the results desired. Leave the date range
empty to report on all dates in the archived file.
Further, the “Daily” option can be used to report on
a time range for each of those days.
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CARD...

Clicking this button will bring up a dialog box to enter
selection criteria pertaining to card information. The
first four fields allow you to narrow your search by first
name, last name, card number, or reader.

FIRST NAME
Enter a first name to narrow your search. For example,
entering “Jim” would report on all card holders with the
first name Jim. This field is case sensitive and must be
typed in as it appears in the card database.

LAST NAME

Enter a last name to narrow your search. For example,
entering “Smith” would report on all card holders with the
last name Smith. This field is case sensitive and must be
typed in as it appears in the card database.

CARD NUMBER

Enter a specific card number that you want to report on.

 NOTE
ALL criteria must be met for
data to appear on the report.
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READER
Enter a specific reader that you want to report on. This
field is case sensitive and must be typed in as it appears
in the Reader Screen of the Panel Database.

NOTE RANGES
WIN-PAK lets you specify reports using criteria for up to
three of the 25 note fields. Select a note field from the
drop-down list. Then select the beginning and ending
(alphabetically) criteria for the range. Beginning partial
criteria is acceptable for these fields. For example, if you
wanted to generate a report for departments that begin
with letters A through F, you would:

1. Select the note number that you redefined as
“Department” from the drop-down list. (See Note
Fields... under the Setup menu)

2. Type the letter “A” in the first text entry space and
an “F” in the second text entry space.

The report will be generated for all departments from “A”
through  “F” including Accounting, Distribution, Financing,
etc... This can be done for up to three note fields.

CARD CODES

Enable the card read statuses that you want reported on
for cards or leave them all disabled to report on them all.

POINT...

Clicking this button will bring up a dialog box to enter
selection criteria pertaining to alarm point information.

 NOTE
When enabling the Actioned

Only option in the Card
Codes section, only card
transactions that have
operator notes assigned to
them will be printed.
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ALARM POINT

Enter a specific alarm point that you want to report
history on. This field is case sensitive and must be typed
in as it appears in the Input Point Screen of the Panel
Database. Leaving this blank reports on all alarm points.

ALARM STATES

Enable the alarm states that you want reported on for
alarms or leave them all disabled to report on them all.

OPERATOR...

Clicking this button will bring up a dialog box to enter
selection criteria pertaining to a particular operator.

OPERATOR
Enter an operator that you want to view transactions for.
This field is case sensitive and must be typed in as it
appears in the operator database. Leaving this blank will
include transactions from all operators.
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OPERATOR TRANSACTIONS
Enable the operator transactions that you want included
in the report or leave them all disabled to report them all.

Acknowledged Transactions shows transactions that
have been acknowledged and the time.

Database Record Modifications shows any editing of
databases.

Other Operator Activities includes login, logout, alarm
acknowledgment and clearing.

GENERATING DATABASE REPORTS
WIN-PAK can generate a report for any of its databases.
Select Database Reports from the Reports menu to
see a list of databases. Selecting a database from this list
will either generate a report automatically or prompt
you for selection criteria, depending upon the database.
Databases that prompt you for more than one set of
criteria will report only those records that meet all of
your selection requirements.

GENERATING A TIMEZONE REPORT
Select Timezones... from the list to generate a report of
time zones. The dialog box below will prompt you for
selection criteria.
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TIMEZONE NAME RANGE
Enter a range to report on by entering starting and ending
criteria for an alphabetical list of time zones. Enter the
time zone name in these two boxes or a partial name
(such as the first letter). Leave these fields empty to
report on all timezones.

The report below will be generated. It includes the time
zone name, start time, end time, days of the week
included, and whether holidays are included.

GENERATING AN AREA REPORT
Select Areas from the list to generate a report of areas.
The report below will be generated. It includes the area
name, port, baud rate, and area type.
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Ports in the Area Report are numbered as follows:

1 = Com Port 1 (Multiport or COM1)
2 = Com Port 2 (Multiport or COM2)
3 = Com Port 3 (Multiport only)
and so on...

GENERATING A PANEL REPORT
Select Panels... from the list to generate a report of
panels. The dialog box below will prompt you for
selection criteria.

PANEL ID RANGE

Enter a range to report on by entering starting and ending
panel IDs for a numerical list of panels. Panel ID’s in this
field should be entered as 10-digit numbers. For example,
enter From:  0000000001 to  0000000001 to get a report

 NOTE
Port 1 indicates Boca or
Digiport 1, Port 2 indicates
Boca or Digiport 2, etc...



REPORTS
Generating Reports 301

on Panel 1. Panels with the same Panel ID from other
areas would also be included in the report.

PANEL NAME RANGE

Enter a range to report on by entering starting and ending
panel names for an alphabetical list of panels. Partial
names, such as the first letter, are also accepted.

AREA RANGE
Enter a range to report on by entering starting and ending
area names for an alphabetical list of panels for certain
areas. Partial names, such as the first letter, are also
accepted.

The report below will be generated. It includes the panel
ID, panel name, area name, panel type, version, number
of card digits, hardware and programming options
enabled, readers enabled, time zones included, and
inputs, outputs, and groups defined. It also shows
information on interlocks, pulse time, and shunt time.
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GENERATING A SCHEDULES REPORT
Select Schedules from the list to generate a report of
schedules. The report below will be generated. It in-
cludes the schedule name, type, frequency and the next
scheduled date and time.
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GENERATING A GUARD TOURS REPORT
Select Guard Tours from the list to generate a report of
Guard Tours. The dialog box below will prompt you for
selection criteria.

GUARD TOURS SELECTION CRITERIA
Enter a range to report on by entering starting and ending
names for an alphabetical list of Guard Tours. Partial
names, such as the first letter, are also accepted. Or you
can leave the dialogue box empty to generate a list of all
Guard Tours defined in the database.

The report below will be generated. It includes the
Guard Tour name(s), stop number (s), check point
name(s), and time(s). It also gives a tolerance value for
the check in times.
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GENERATING A TRACKING AREAS REPORT
Select Tracking Areas...  from the list to generate a
report of tracking areas. The dialog box below will
prompt you for selection criteria.
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TRACKING AREAS... RANGE
Enter a range to report on by entering starting and ending
Tracking Area names for an alphabetical list of tracking
areas. Partial names, such as the first letter, are also
accepted. If you want a list of all tracking areas, then
leave the dialogue box blank. Use the drop down list to
choose the type of area you want listed or choose ALL.

The report information can be sorted either by the name
of the tracking area or by type of area. Use the drop down
box to choose the sorting order.

The report below will be generated. It includes the
tracking area name(s), area type(s), and reader name(s).

GENERATING AN ACCESS LEVEL REPORT
Select Access Levels from the list to generate a report
of access levels. The dialog box below will prompt you
for selection criteria.
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ACCESS LEVEL RANGE
Enter a range to report on by entering starting and ending
access level names for an alphabetical list of access
levels. Partial names, such as the first letter, are also
accepted.

The report below will be generated. It includes the
access level name(s), reader name(s), time zone name(s),
and group name(s).

GENERATING A CARD REPORT
Two types of card reports can be generated, one with
card notes and one without. When Cards is selected
from the database list, a submenu opens showing these
two options as shown below.
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Select Cards... from the list to generate a report of cards
without notes. The dialog box below will prompt you
for selection criteria.

NAME RANGE

Enter a range to report on by entering starting and ending
last names for an alphabetical list of cards. Partial
names, such as the first letter, are also accepted.

CARD NUMBER RANGE

Enter a range to report on by entering starting and ending
card numbers for a list of cards. The list will be alphabeti-

 NOTE
Using Name Range from “A”
to “C” will include all the card
holders with last names that
begin with “A” and “B.”
Names that begin with “C”
will not be included.
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cal by name for those cards that are alphabetically
between the starting and ending number in the range.

ACCESS LEVEL

A list of all access levels in the Access Level Database
are displayed in the drop-down list. Select the access
levels to report on or choose All.

SORT ORDER
Select the preferred sort order. Card reports can be
sorted by either the card number or the card holder's
name.

The report below will be generated. It includes last
name, first name, card number, expiration date, access
level, if the card uses a PIN and indicates if there is a
photo on the card.

Select Cards & Notes... from the list to generate a report
of cards with notes. The dialog box below will prompt
you for selection criteria.
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NAME RANGE
Enter a range to report on by entering starting and ending
last names for an alphabetical list of cards. Partial
names, such as the first letter, are also accepted.

CARD NUMBER RANGE
Enter a range to report on by entering starting and ending
card numbers for a numerical list of cards.

ACCESS LEVEL

A list of all access levels in the Access Level Database
are displayed in the drop-down list. Select the access
levels to report on or choose All.
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NOTE RANGE
Enter a range to report on by entering the starting and
ending criteria for up to three note fields. Partial criteria,
such as the first letter, are also accepted.

SORT ORDER
Select the preferred sort order. Card reports can be
sorted by either the card number or the card holder's
name.

PRINT VALID AND INVALID DETAIL

Enabling this option will include the valid and invalid card
detail including the type of read (normal, timezone error,
not found, etc...), priority, and message.

The report below will be generated. It includes last
name, first name, card number, access level, all note
fields, and valid/invalid read details (if selected).

GENERATING A CAMERA REPORT
Select Cameras from the list to generate a report of
cameras. The report below will be generated. It includes
the camera ID, name, and title.
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GENERATING A HOLIDAY REPORT
Select Holidays from the list to generate a report of
holidays. The report below will be generated. It includes
the holiday name and date.

GENERATING A MONITOR REPORT
Select Monitors from the list to generate a report of
monitors. The report below will be generated. It includes
the monitor ID and name.
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 NOTE
A card presented at a reader
outside of a Tracking Area,
removes it from that Tracking
Area and prohibits it from
being reported in the
Attendance Report.
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GENERATING A COMMAND FILE REPORT
Select Command File from the list to generate a report
of command files. The dialog box below will prompt
you for selection criteria.

COMMAND FILE NAME RANGE
Enter a range to report on by entering starting and ending
command file names for an alphabetical list of command
files. Partial names, such as the first letter, are also
accepted.

The report below will be generated. It includes the
command file name, area name, and the commands in
the file.
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GENERATING AN ATTENDANCE REPORT
The purpose of the attendance report is to answer the
following two questions:

• How long was a card holder in an area of the
building?

• How long was a group of card holders in an area
of the building?

To generate these reports, the user should select Atten-
dance… from the Reports menu, which will bring up
the Enter Attendance Selection Criteria Window:

TO DETERMINE HOW LONG A PARTICULAR CARD
HOLDER WAS IN AN AREA:

Select a specific Tracking Area or use the default value
of “ALL” Tracking areas in the building.
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Enter the specific card holder information. This can be
done by entering the card number or last and first name
in the text entry spaces provided. Alternately, the
Cards… button can be used to browse the card database
to find the card to use.

Optionally, enter the time interval. If not specified, the
entire time span of the history database will be used.

Click OK for a report on the time range.

TO DETERMINE HOW LONG A GROUP OF CARD HOLD-
ERS WERE IN AN AREA:

Method 1:

Select the Tracking Area as above. Select an “Access
Level” for which all of the card holders belong.

Optionally, enter the time interval as above.

Method 2:

Select the Tracking Area as above. Select a “Note Field”
and enter the exact value for which all of the card
holders belong.

Optionally, enter the time interval as above.

As mentioned above, the report uses the current history
database records to extrapolate the attendance informa-
tion requested.

The report displays how long a card holder was in an
area via the “Elapsed Time” field.  This value represents
the number of hours and minutes. If no “Exit Time”
found, the elapsed time is based on the current date and
time.
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In the process of maintaining your access control
system, your data should be carefully and systemati-
cally managed to prevent loss of information. WIN-PAK
provides tools for keeping your data clean and safe. The
following sections cover how to maintain your files
using Archive, Purge, Backup, Restore, and the Rebuild
functions.

ARCHIVE
Archiving refers to moving a range of history records to
a separate file. Normally, this would be done with
history that doesn't need to be viewed regularly. Al-
though these records will still be accessible, they will
not be searched when running a History Report unless
specified. This speeds up the history report process by
eliminating old transactions.

Archiving is done by selecting Archive... from the File
menu. This will open a calendar dialog prompting you
to enter a date.

Click the arrow buttons to move forward or back one
month at a time, then click the exact date that you want
WIN-PAK to archive PRIOR TO (not including the date).
Then click Archive to continue or Cancel to abort the
operation.

Serial communications must be halted, so you will be
prompted to buffer your panels. If you choose not to

 NOTE
Maintenance functions in a
WIN-PAK network can only
be performed from the
WIN-PAK server.

 NOTE
It is up to the user to
determine how often to do
the archive process. It
depends on how much data
the user needs immediate
access to – a week, a
month?
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buffer your panels, then any incoming transactions will
be lost. If you choose to buffer the panels and if some
panels are already buffered, WIN-PAK will unbuffer all
connected panels. You will have to rebuffer these
panels manually. If you are using N-485 with ACK/
NAK, you will not need to buffer the panels, as the
ACK/NAK will make sure that transactions are not lost.

EXAMPLE

If history was archived through January 1, 1998 as
shown above, then an archive file containing history
PRIOR TO January 1st would be created named
19980101.DBF. All history information PREVIOUS to
January 1st would then be purged (deleted) from the
main history file. The archived information would then
only be retrievable by enabling From archive in the
History Selection Criteria dialog when generating a
history report, and selecting the 19980101.DBF file.

 NOTE
In this example, the transac-
tions from 01/01/98 WILL
NOT be in the archived file.
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PURGE
Purging refers to removing records from the active
WIN-PAK history (not archived). This is for deleting
history that will never need to be accessed again.

To delete records, select Purge... from the File menu.
This will open a calendar dialog prompting you to enter
a date.

Click the arrow buttons to move forward and back one
month at a time, then click the exact date that you want
WIN-PAK to purge PRIOR TO (not including the date).
Click Purge to continue or Cancel to abort the opera-
tion.

Serial communications must be halted, so you will be
prompted to buffer your panels.

When completed, your history records prior to the date
you selected will be removed.
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BACKING UP WIN-PAK FILES
An important part of keeping data safe is backing up
files on a regular basis. WIN-PAK allows you to do a
backup of your databases (and indexes) to a separate
sub-directory.

A backup will save your WIN-PAK database (and index)
files to a separate subdirectory. This is useful if one or
more of your databases becomes corrupt. It will not
protect your data or system, however, from hardware
failures, so it is important to conduct regularly sched-
uled complete backups to some form of removable
media (floppy disks, tapes, etc..) in addition to
WIN-PAK backups. To conduct a backup:

1. Select Backup from the File Menu. The backup
will verify that all clients are logged out and
disables new client logins (Backup requires
exclusive use of the databases).

2. You will be prompted to buffer panels. Click Yes if
you want to buffer panels or No if you do not. If
you choose not to buffer your panels, then any
incoming transactions will be lost. If you choose to
buffer the panels and if some panels are already
buffered, WIN-PAK will unbuffer all connected
panels. You will have to rebuffer these panels
manually. If you are using N-485 with ACK/NAK,
you will not need to buffer the panels, as the ACK/
NAK will make sure that transactions are not lost.

 CAUTION
NEVER DO A BACKUP
WHEN YOU THINK A
DATABASE IS CORRUPTED!
First copy the databases to
another backup subdirectory.
Then rebuild the databases
using the Repair function.
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Backup shuts down communications (closes
databases) and copies all database files (PK*.DBF
and PK*.MDX) and archived history files from the
WIN-PAK database directory (usually
C:\WINPAK\DATABASE) to the BACKUP
subdirectory (usually
C:\WINPAK\DATABASE\BACKUP). If the BACKUP
sub directory doesn’t exist, WIN-PAK creates it. It
finishes by restarting communications,
unbuffering panels, and enabling client logins.
Databases can now be copied from BACKUP
subdirectory to tape or other backup media.

RESTORING FROM A BACKUP
If you are experiencing database difficulties or data loss
in WIN-PAK that rebuilding will not correct, you can
restore your databases from the last backup. Any data
entered since the last backup will need to be re-entered.
To restore from a backup:

1. Restore your most recently backed up files from
your backup media to the
C:\WINPAK\DATABASE\BACKUP directory.
Images, badges, and signatures should be copied
to the C:\WINPAK\DATA directory.

2. Select Restore from the File menu.

3. The restore will verify that all clients are logged
out and disables new client logins (Restore
requires exclusive use of the databases).

 NOTE
History transactions are also
stored in a database file.
Therefore, a restore will
overwrite the "current"
history.

 NOTE
Images, badges, and
signatures are not backed
up through the backup
procedure. These files are
found in the
C:\WINPAK\DATA
subdirectory and should be
backed up to a tape or other
storage media.

 IMPORTANT
To keep images and the
Card Database in sync, the
backup and restore func-
tions should be done for
both sets of information at
the same time.
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4. You will be prompted to buffer panels. Click Yes if
you want to buffer panels or No if you do not. If
you choose not to buffer your panels, then any
incoming transactions will be lost. If you choose to
buffer the panels and if some panels are already
buffered, WIN-PAK will unbuffer all connected
panels. You will have to rebuffer these panels
manually. If you are using N-485 with ACK/NAK,
you will not need to buffer the panels, as the ACK/
NAK will make sure that transactions are not lost.

It then shuts down communications (closes
databases) and copies all database files (PK*.DBF
and PK*.MDX) and archived history files from the
BACKUP subdirectory (usually
C:\WINPAK\DATABASE\BACKUP) to the WIN-PAK
database directory (usually
C:\WINPAK\DATABASE). It finishes by restarting
communications, unbuffering panels, and enabling
client logins.
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REBUILDING DATABASES
Databases can become corrupt when there is a power
outage or if WIN-PAK is exited improperly. This corrup-
tion can cause databases to lose data or act irregularly.
It is important that operators know the correct proce-
dure for exiting both WIN-PAK and Windows!

WIN-PAK provides the ability to maintain and repair
databases using the Create, Pack, Reindex, and Repair
functions. All of these can be accessed by selecting
Rebuild... from the File menu. A large dialog box will
open with a matrix that contains Databases on the side
and functions along the top.

Select the functions that you want to perform in the
row of the database you want them performed on.

CREATE THE DATABASE
Select this option if you want to recreate the database
from scratch. This will overwrite the existing files for
the database with new files. DO NOT USE THIS FUNC-
TION IF DATA CURRENTLY EXISTS IN THE
DATABASE, BECAUSE IT WILL BE LOST! In addition,
other databases that rely upon it may not open.

 NOTE
Clients MUST be logged off
to use any rebuilding
functions.

 NOTE
Limiting access to this
function should also be
taken in consideration when
creating operators, etc...
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Databases that relate to others can cause programming
problems if deleted. For example, if the Timezone
Database was recreated, all timezones used in the Panel
and Access Level databases would be out of sync.
Caution should be exercised when Create is used!!!

PACK THE DATABASE
Databases keep track of records even when they have
been deleted. This is why records continue to appear
“grayed” in the Data List. Packing the database will
purge these deleted records and make your system run
more efficiently.

REINDEX
This function deletes the indexes of the database and
rebuilds them.

REPAIR
This function looks for records that are corrupt and
strips them out of the database. It then reindexes and
rebuilds the integrity table. This can take a while
depending upon the size of the databases.
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APPENDIX A:
PRE-INSTALLATION

SYSTEM SETUP
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Two files that are located in the root directory of your
PC are responsible for it’s configuration. The
AUTOEXEC.BAT file contains commands and programs
that you want executed each time you start your com-
puter. The CONFIG.SYS file instructs the PC on how to
handle different operations. Both of these files can be
edited with a simple text editor such as Edit (DOS-
based) or Sysedit (Windows-based). Below are some
examples of statements that may appear in these two
files. The examples shown are for a typical Windows
3.11 system using a Videoblaster capture card. Win-
dows ‘95 will normally not require statements like those
required for Windows 3.11.

AUTOEXEC.BAT (WIN-PAK S TAND-ALONE SYSTEM

WITH BADGING)
These statements are just a part of the AUTOEXEC.BAT
file and may differ depending upon your individual
hardware and software setup.

@ECHOFF
PROMPT $P$G
PATH=C:\DOS;C:\;C:\WINDOWS;C:\VBSE100

SET VIDEOBLST_SE100=C:\VBSE100 A:718 I:11 M:D000 T:5

LH SE100DRV

C:\WINDOWS\SMARTDRV.EXE /X 1024 512

SET TEMP=C:\DOS\TEMP

ECHO Y|DEL C:\DOS\TEMP\*.*

May be present if a Videoblaster

video capture board is being used.

Video capture driver statement.

Helps allocate memory for

Windows and WIN-PAK to

operate efficiently.

EXPLANATIONS

Make sure the TEMP sub-directory
exists in the DOS directory when
using this statement.

Cleans up the TEMP files by

deleting them during power up.
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CONFIG.SYS (WIN-PAK S TANDALONE SYSTEM

WITH BADGING)
These statements are just a part of the CONFIG.SYS file
and may differ depending upon your individual hard-
ware and software setup.

DEVICE=C:\WINDOWS\HIMEM.SYS
DEVICE=C:\WINDOWS\EMM386.EXE NOEMS X=D000-D3FF

DOS=HIGH
FILES=150

STACKS=9,256

Aside from the AUTOEXEC.BAT and CONFIG.SYS files,
Windows has two files that determine how it works
with your hardware and software configuration. The
WIN.INI file contains information on individual pro-
grams, fonts, and Windows’ system settings. The
SYSTEM.INI file contains information on how Win-
dows works with your hardware.

When using a video capture board, the Extended
Memory Manager (EMM) statement in the CONFIG.SYS
may have an “X=” statement included within it:

Example:
DEVICE=C:\WINDOWS\EMM386.EXE NOEMS X=D000-D3FF

If it does, an “exclude” statement must be included in
your SYSTEM.INI file that matches it:

Example: EMMExclude=D000-D3FF

May have an exclude statement

added after “NOEMS” to

accommodate a range of

memory for the video capture

board. If EMM386.EXE is used,

NOEMS must be present.

Files must be set to 150 for a

WIN-PAK standalone system. If

running WIN-PAK as a server,

250 files should be made

available.

EXPLANATIONS
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APPENDIX B:
INTERLOCKING
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The interlocking feature allows an input point or output
point to take a specified action based upon another
input point or output point changing state.  In an
interlock sequence, an action on one point causes a
reaction from a second point.

Interlocks initiated with an input point change of state
are defined in the Input screen of the Panel Database.

Interlocks initiated with an output point change of state
are defined in the Output screen of the Panel Database.

In either screen, click the box labeled Interlocking to
enable the interlocking section.

Select Input to Output or Input to Input from the Input
Point screen to define the interlock type when initiating
from an input point change of state.

Input to Output When an input is interlocked to
an output, a change of state on
the input causes the output to
react.

Input to Input When input A is interlocked to
input B, a change of state on
input A causes input B to react.

 NOTE
A group is considered an
output. Input to Output

could be an input interlocked
to an output group. Output

to Output could be an output
interlocked to a group or one
group interlocked to another.
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OR

Select Output to Output or Output to Input from the
Output Point screen to define the interlock type when
initiating from an output point change of state.

Output to Input When an output is interlocked to
an input, a change of state on the
output causes the input to react.

Output to Output When output A is interlocked to
output B, a change of state on
output A causes output B to react.

The parameters that must be specified in an interlock
sequence are shown below:

Component A: Specify an input or output to
initiate the interlock sequence.  A
change of state on Component A
causes a reaction from Compo-
nent B.

Component B: Specify an input or output to
react upon a change of state on
Component A.

Action 1: Specify the action for Component
B to take when Component A
goes into an alarm state (input) or
energized state (output).

Action 2: Specify the action for Component
B to take when Component A
returns to a normal state (input)
or de-energized state (output).

A diagram of where these parameters are found in the
Panel database is shown below. The screen on the top
illustrates an interlocking scheme for a free egress
situation for door address 1.
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Component A
Specify an input or
output to initiate the
interlock sequence. A
change of state on
Component A causes
a reaction from Com-
ponent B.

Component B
Specify an input or
output to react upon a
change of state on
Component A.

Action 1
Specify the action for
Component B to take
when Component A goes
into an alarm state (input)
or energized state
(output).

Action 2
Specify the action for
Component B to take
when Component A
returns to normal
state (input) or de-
energized state
(output).

O
U

T
P

U
T

IN
T

E
R

LO
C

K
S

IN
P

U
T

IN
T

E
R

LO
C

K
S



Appendices 335

The actions available for the Action 1 and Action 2
parameters are as follow:

Energize Applicable only when Component B is
an output point, this action turns the
point on.

De-Energize Applicable only when Component B is
an output point, this action turns the
point off.

Shunt Applicable only when Component B is
an input point, this action shuts off
the point.

Un-Shunt Applicable only when Component B
is an input point, this action reacti-
vates the point.

Pulse Energizes the output point (or mo-
mentarily shunts an input point) for a
set amount of time.

Pulse Off Turns off a point currently being
pulsed. When relay is energized, it
will Pulse Off and then return to
Energized state. (This is rarely used
and must be used in addition to a
command file.)

No Action No change of state.

Follow Take the state of Component A.

Invert Follow Take the opposite state of
Component A.

When a Follow action is specified for Action 1, No
Action must be specified for Action 2.  A Follow/No
Action specification causes Component B to follow any
change of state on Component A.
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EXAMPLE 1
Component A: Input #5 (motion detector)

Component B: Output #3 (siren)

Action 1: Energize

Action 2: De-energize

When input #5 goes into alarm state (motion detector
triggered), output #3 energizes (sounding the alarm).
When input #5 returns to normal state, output #3 de-
energizes (turning off the siren).

EXAMPLE 2
Component A: Input #6 (door status switch)

Component B: Output #4 (bell)

Action 1: Pulse

Action 2: No Action

When input #6 goes into alarm state (door status switch
open illegally), output #4 pulses for its predetermined
pulse time.  The pulse time is set in the Output Point
screen in the Panel Data section of WIN-PAK.

EXAMPLE 3
Component A: Output #1 (door strike relay)

Component B: Input #1 (door status switch)

Action 1: Follow

Action 2: No action

When output #1 energizes (upon a valid card read or
egress), input #1 is shunted for the defined shunt time
specified in the panel database.  Input #1 follows the
state of output #1.
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EXAMPLE 4
Component A: Input #7 (push button)

Component B: Input #8 (motion detector)

Action 1: Pulse

Action 2: No Action

When input #7 goes into alarm state (push button acti-
vated), input #8 pulses (shunts) for its set shunt time,
deactivating the motion detector.

For more information on interlocking, see Northern
Computer’s Interlocking Guide (TD3001).
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APPENDIX C:
ELEVATOR
CONTROL

Elevator control is accomplished through the use of the
Group Option, which allows activation of a combina-
tion of output points upon a valid card read. The
N-1000-II/N-800 output points are used to enable the
operation of the floor select buttons of the elevator
controller. Normally-open floor select buttons should be
wired in series through the normally-open side of the
N-1000-II/ N-800 relays. This configuration is shown is
shown below.
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Each floor selection button is
wired in series with an output
relay on the control panel.

In normal operation, when a valid card is read, the group
of output points assigned to the card change state,
enabling the appropriate floor select buttons. The user
then makes a floor selection.
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Group definitions and pulse times are programmed in
the Panel Database. The groups are then assigned to
access levels in the Access Level Database. The access
levels are then assigned to cards in the Card Database.

EXAMPLE
Given: We want to give Jim Johnson (card #22435)
access to all eight floors. We want to give Jane Doe (card
#17732) access to floors 1-4 only.

1: Create a panel in the Panel Database where the
Group Option is enabled.  

The Groups tab will now be accessible.

2: In the Output Points Screen make all output points
that you want to include in your group “Active”. In
this example, activate outputs 1 through 8 to
represent the 8 floors.

 NOTE
Addresses indicated by 1xx
are groups.
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3: From the Groups Screen, make Group #1 “Active”
and select output points 1-8 to include all 8 floors.
Make Group #2 “Active” and select as output
points 1-4 to include only the first 4 floors.

          

4: Return to the Output Points Screen and scroll
down to the bottom of the Output Points list to
view groups. Groups have  a “G” in the name and
have an address greater than 100. Select Group #1
and assign it a pulse time of 10 seconds. The pulse
time is the amount of time that the card holder
will have to select a floor after presenting the card.
Do the same for Group #2.

5: Define Access Levels for Jim Johnson (All Eight
Level) and Jane Doe (Only Four Level), in the
Access Level Database, as shown:
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6: Assign the access levels to the cards, in the Card
Database, as shown:

            

When Jim Johnson presents card #22435, output points
#1-8 pulse for 10 seconds, allowing selection of floors
1-8. When Jane Doe presents card #17732, output
points #1-4 pulse for 10 seconds, allowing selection of
floors 1-4.
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APPENDIX D:
TECHNICAL

INFORMATION
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THE WIN-PAK DATABASES

The WIN-PAK System is made up of 35 databases found
in the WINPAK\DATABASE subdirectory. Below is a
description of each database.

FBD.SNOITCA snoitcAkcolretnI .xirtamsnoitcAkcolretnIehtsniatnoC

FBD.NIAMLAKP niaMleveLsseccA
eliF

DIdnasemaNleveLsseccAehtsniatnoC
srebmun

FBD.KLDRLAKP redaeRleveLsseccA
pukooL

sseccAneewtebpihsnoitalerM:1ehtsniatnoC
LA1eblliwerehT(sredaeRlenaPdnaDIleveL

)sredaeRMotDI

FBD.PUKLMAKP egasseMnoitcA
pukooLredaeR

lenaPneewtebpihsnoitalerehtsniatnoC
sdraCdna,segasseMnoitcA,stupnI/sredaeR

FBD.NIAMRAKP eliFniaMaerA aeranasenifedtahtnoitamrofniehtsniatnoC
DIAERAdnaEMANAERA,troPsahcus

FBD.NIAMACKP eliFniaMaremaC sdIdnasemanaremaCsniatnoC

FBD.NIAMDCKP esabataDniaMdraC DILAsallewsaataddracehtsniatnoC

FBD.KLTNDCKP eliFsetoNdraC sdleifetondracsniatnoC

FBD.KLMCFCKP pukoolelifdnammoC ahtiwdetaicossasdnammocehtsniatnoC
elifdnammoc

FBD.NIAMFCKP eliFniaMdnammoC &aerA,emandnammocehtsniatnoC
DIeliFdnammoC

FBD.CFERKFKP ytirgetnIlaitnerefeR seicnednepedyfingistahtstnuocsniatnoC
eboteraselifnehwdesueratahtselifneewteb

deteled

FBD.TPSHPFKP topStoHnalProolF nalproolfottnenitrepnoitamrofnisniatnoC
stopstoh

FBD.KLSHPFKP topStoHnalProolF
pukooL

stopstohrofnoitamrofnidetaicossasniatnoC

FBD.NIAMPFKP eliFniaMnialProolF elifpamtiBdnaemaN,DInalproolfehtsniatnoC
eman

FBD.NIAMTGKP eliFniaMruoTdrauG noitamrofniDIruoTdrauGsniatnoC

FBD.KLTSTGKP pukoolruoTdrauG pukoolredaerrofevitceridsniatnoC
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FBD.NIAMLHKP eliFniaMyadiloH DIybdecnerefersyadilohfotsilasniatnoC

FBD.NIAMOIKP niaMaerAgnikcarT
esabataD

noitamrofniaeragnikcartniamehtsniatnoC

FBD.KLDROIKP aerAgnikcarT
pukooLredaeR

gnikcartehtrofnoitamrofniredaerehtsniatnoC
esabatadaera

FBD.NIAMSHKP eliFniaMyrotsiH atadelifyortsihtnerrucehtsniatnoC

FBD.NIAMNMKP eliFniaMrotinoM dnaDIfonoitamrofnirotinoMehtsniatnoC
EMAN

FBD.NIAMPOKP eliFniaMrotarepO ,emaN,DI,noitamrofnirotarepOehtsniatnoC
drowssaP

FBD.1LPGNPKP 1spuorGlenaP yrtne1-elifsihtnidedrocereraspuorGniaM
puorgrep

FBD.2LPGNPKP stnioPpuorGlenaP puorgrepyrtne1-spuorgrofelifpukoolstnioP
tniop

FBD.KLAHNPKP erawdraHlenaP
smralA

1-stupnimralaerawdrahlenaprofstnuoccA
tniopmralarepyrtne

FBD.KLNINPKP stnioPtupnIlenaP tupnirepyrtne1-esabatadpukooltnioptupnI

FBD.NIAMNPKP eliFniaMlenaP 1-ofninoitarugifnoclenapniamehtsniatnoC
lenaprepyrtne

FBD.KLTONPKP stnioPtuptuOlenaP repyrtne1-esabatadpukooltnioPtuptuO
tuptuo

FBD.KLDRNPKP redaeRlenaP
pukooL

redaerrepyrtne1-noitamrofniredaeR

FBD.KLCSNPKP edoCetiSlenaP lenaprepyrtne1-sedocetislenapsniatnoC
edocetis

FBD.KLSTNPKP stolSenozemiTlenaP lenaprofsenozemiTotsecnerefersniatnoC
stols

FBD.10000TKP .KAP-NIWYBYLLANRETNIDESUELIFYRAROPMETASISIHT

FBD.NIAMCSKP eliFniaMreludehcS eliFreludehcS

FBD.NIAMZTKP eliFniaMenozemiT DIdnaemanenozemitsniatnoC

FBD.KLGRZTKP segnaRenozemiT repyrtne1-senozemitrofsegnarsniatnoC
egnarenozemit
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THE WINPAK1.INI FILE
(found in the WINDOWS directory)

REGISTRATION SECTION
The Registration Section contains registration informa-
tion as well as the operator that last logged in
successfully.

[Registration]
Administrator=John Doe
Organization=ABC, Inc.
Operator=Vinnie

NETWORK SECTION
The Network Section details important network infor-
mation.

[Network]
NodeType=0

NodeType=
0 describes a standalone system,
1 describes a network server,
2 or any other integer describes a network client

Node ID=
Server Name=

The server name can equal the actual machine name of the server or the TCP/
IP address of the server. Only used on client machines.

CONTROL PANEL SECTION
The Control Panel Section contains information on the
Main Control Panel.

[Control Panel]

OPTIONS SECTION
[Options]
Shutdown Buffer=0

Shutdown Buffer=
0 means default is NOT to put panels into a buffer mode
1 means default IS to put panels into a buffer mode
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Database Directory=C:\WINPAK\DATABASE
The directory where WIN-PAK looks for databases. In a network configuration,
this may change depending on what directory or drive the server is sharing. For
example, if the server is sharing the root drive (C:\), then the database directory
on the client would be C:\WINPAK\DATABASE. If the server is only sharing the
WINPAK directory, it would be C:\DATABASE.

Transaction Buffer Size=1000
The number of uncleared transactions allowed before old data is deleted.

BadgePhoto=1
CardPhoto=2

NOTE FIELDS SECTION
The Note Fields section contains the labels that note
fields are identified by in WIN-PAK. These are set in the
Note Fields section of the Setup menu.

[Note Fields]
Note 1 Desc=Department
Note 2 Desc=Title
Note 3 Desc=Phone #
Note 4 Desc=License Plate #
Note 5 Desc=Note 5
Note 6 Desc=Note 6
Note 7 Desc=Note 7
Note 8 Desc=Note 8
Note 9 Desc=Note 9
Note 10 Desc=Note 10
Note 11 Desc=Note 11
Note 12 Desc=Note 12
Note 13 Desc=Note 13
Note 14 Desc=Note 14
Note 15 Desc=Note 15
Note 16 Desc=Note 16
Note 17 Desc=Note 17
Note 18 Desc=Note 18
Note 19 Desc=Note 19
Note 20 Desc=Note 20
Note 21 Desc=Note 21
Note 22 Desc=Note 22
Note 23 Desc=Note 23
Note 24 Desc=Note 24
Note 25 Desc=Note 25
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SERIAL PORTS SECTION
The Serial Ports Section contains information that
defines the number of COM ports and their settings.

[Serial Ports]
Type=0

Type =0 COM1 & COM2
=1 DigiBoard PC/4
=2 DigiBoard PC/8
=3 DigiBoard PC/16
=4 BOCA BB 1004
=5 BOCA BB 1008
=6 BOCA BB 2016
=7 DualDigiBoard PC/16

First Port=4
P1Modem=0
P2Modem=0
IRQ=0
P1Use=1
P1BaudRate=1200
P1Init=
P1Phone=
P1Address=0

In general: 0=NO 1=YES

P2Use=1
P2BaudRate=1200
P2Init=
P2Phone=
P2Address=0
Status Port Address=0
retries=10

When a command is sent to N-4702 panels and no acknowledgement is
received, it will be retried. The maximum number of retries is defined here.

timeout=120
The maximum number of seconds between retries. (See “retries” above.)

PRINTERS SECTION
The Printers section determines the operation of printers
in WIN-PAK.

[Printers]
Print Alarms=1

Print Alarms=
0 DISABLES the printing of system responses
1 ENABLES the printing of system responses

Report Printer=

 NOTE
If the line:
Beep Alarm=0
is added to the Printers
section, you will not hear the
alarms when they come in.

 NOTE
The statement:
Debug Dump=1
can be added to the Serial
Ports section for trouble-
shooting what WIN-PAK is
sending and how the panel
responds. When entering
WIN-PAK it will create a
dump file in C:\WINPAK
called RSDUMP01.TXT that
can be viewed with a text
editor after exiting WIN-PAK.

A new text file is generated
every time you enter WIN-
PAK (RSDUMP02.TXT,
etc...). Delete the statement,
or change the variable to
“Ø” to turn it off when you
are done troubleshooting.

 NOTE
The N-4702 (with version
2.21 firmware or higher)
requires longer delays
between retries and a greater
number of retries.
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SERVER OPTIONS SECTION

The Server Options Section contains information
specific to the server.

[Server Options]
Card Digits=5

Card Digits=
5 means 5-digit programming has been chosen. This allows card numbers
between 1 and 65534 in the card database.

12 means 12-digit programming has been chosen. This allows card numbers
between 1 and 999999999999 in the card database.

Card Limiting=1
Clear Alarm OK=1

Clear Alarm OK=
0 means Normal only
1 means Alarm OR Normal

Command File Send=1
Alarm Priorities=50

Priority Threshold

Auto Card Lookup=50
Card Lookup Threshold

Security=13,70,30,90,27,133,117,26,85,25
Log Operator Actions=1
Muster History Init=0

Hours to “Prime”

[Recent File List]
File1=C:\WINPAK\CONTROL.MTR

THE BADGER.INI FILE
(found in the WINPAK\DATA directory)

PREFERENCES SECTION
[Preferences]
DataPath=C:\Winpak\DATA

Where images are stored.

JPEG Compression=100
Compression setting for images

100= least compression, best quality
30= most compression, least quality
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VideoDLL=Flashpnt.dll
Video capture device

PrintDLL=DATACARD.DLL
Printer used (may not be present if “Other” was chosen during installation or a
different printer is used).

Inches=1
Default (blank) is in mm

ShowGrid=0
SnapGrid=1
SigPad=PenWare100

Present if Signature Pad was checked during installation
[Misc]
Parent=WINPAK

[DataCard]
Encode=0
EncodeOnly=0
Duplex=0
RotateBack=1
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APPENDIX E:
PCPAK TO WIN-PAK
CONVERSION STEPS
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CONVERT.EXE is a PC-PAK to WIN-PAK conversion
utility that converts PC-PAK databases to the format of
WIN-PAK databases (xBase). This allows the user to
make an upgrade from an existing PC-PAK system to
WIN-PAK without having to re-enter all database
information.

The conversion of PC-PAK files is not complete, how-
ever. This is because the WIN-PAK database is very
different from the PC-PAK database in structure. The
conversion utility has been designed to take the
WIN-PAK database to a point where the user can
quickly make modifications.

The utility converts all necessary databases except for
those listed below:

• Operators will not be converted.

• Backdrop data (badge backgrounds) will not be
converted.

• Timezones will not be converted. A timezone
named timezone1 defining 24-hour, 7-day access
will be created. This timezone will be substituted
for timezones used in WIN-PAK access levels. All
timezone assignments to input points or output
points will not be kept.

• More access levels than were originally in PC-PAK
may be created.
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CONVERSION PROCEDURE

The following steps demonstrate how to convert PC-
PAK databases to WIN-PAK databases using the Convert
Utility. It is a good idea to print out complete database
reports from PC-PAK before converting, to reference
what modifications need to be made to the WIN-PAK
databases.

1. MAKE A BACKUP of the files within the PC-PAK
directory. See the PC-PAK manual for more
information on backing up these files.

2. Install WIN-PAK (refer to the installation section
of this manual). After creating databases and
logging in, select Exit from the File menu to close
WIN-PAK.

3. From the Program Manager, select Run from the
File menu.

4. Type “C:\WINPAK\CONVERT.EXE” in the
command line and click OK. This will open the
conversion utility.

 NOTE
Before converting, rename
the PC-PAK panel and
reader names to be unique.
This is necessary in WIN-
PAK programming.
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5. Select Convert from the File menu. This will bring
up an “Open” dialog box.

6. Select the directory of  PC-PAK or the directory you
have PC-PAK files stored and double-click on it. The
CDATA.DB file will highlight as it is the main file
from which the conversion takes place. Click OK.

The program will begin converting the databases.
This process may take some time depending on
the number of panels and cards programmed into
the system. A very large database with video
images could take several hours.

7. A message will appear indicating that it is about to
rebuild the “Referential Integrity Table.” Click OK.

8. A “conversion complete” box will appear. Click
OK.

9. Select Exit from the File menu to close the
Convert Utility.
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The Convert Utility copies all photos into the
WINPAK/DATABASE subdirectory. These need to be
copied into the WINPAK/DATA subdirectory. Copy
all .JPG files from the DATABASE subdirectory to
the DATA subdirectory using File Manager or using
the following command from the DOS prompt:

C:\ COPY C:\WINPAK\DATABASE\*.JPG C:\WINPAK\DATA

CHECKING THE CONVERSION

Refer to the  database chapter of this manual for in-
structions on how to view and edit databases. Use the
steps below to check the conversion and make any
necessary modifications to your databases.

1. Open WIN-PAK and login using WIN-PAK’s default
user & password. Create/edit the operator database
to allow all privileges. Then re-login and make
sure that your COM Ports are enabled in the Serial
Ports... section of the Setup menu.

2. Select Timezones from the Database menu. Add
all necessary timezones for inputs, outputs, and
cards as described in the Database chapter. These
timezones will be used and available for panels
and access levels.

3. Select Areas from the Database menu and check
all information for each area, editing if necessary.

4. Select Panels from the Database menu. Edit
each panel by selecting the appropriate timezones
created for particular inputs and outputs. Check
that the correct shunt times and pulse times
converted properly along with the interlocks for
inputs and outputs.

5. Select Access Levels from the Database menu.
Edit each Access Level by reassigning readers to
the appropriate Timezones just created.

 NOTE
DOS commands can be
entered from within Windows
by double-clicking the Exit to

DOS icon in the Main Group.
Return to Windows by typing
“EXIT” at the prompt and
hitting [ENTER].
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6. Select Cards from the Database menu. Check
each card to assure that information is correct and
edit access levels as necessary.
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APPENDIX F:
CUSTOM BADGE COLORS
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If the colors on the palette don’t meet your specifi-
cations for a background color or for a text color, it
is possible to define a custom color. Clicking Define
Custom Colors... from the Color dialog box extends
the box to include a spectrum map.

    

A color can be entered in one of two ways. The first
is by clicking on an area in the large square spectrum
map. This map measures hue horizontally and
saturation vertically. Hue is color. Saturation is the
amount of gray in the color.

After a color is chosen here, we can then adjust the
luminosity of the color by moving the slider along
the bar at the right of the map. Luminosity is the
amount of black or white that we add to a color to
darken or lighten it.
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HUE/SATURATION/LUMINOSITY
This process can also be done by entering specific
numbers for hue, saturation, and luminosity in the text entry
spaces provided. Hue can contain the values 0 through
239, starting with red and running through the spectrum of
colors and ending with red. Saturation can contain the
values 0 (gray with no trace of color) through 240 (the full
value of the color). Luminosity can contain the values 0
(black) through 240 (white) with the untinted color at about
120.

RED/GREEN/BLUE
Color can also be measured by the three hues used to
create color on the monitor - red, green, and blue. Simply
enter in the values for each of these colors to produce a
combined color.

COLOR | SOLID
The Color  swatch will show you how your color will appear
on the monitor and is a representation of how your color will
appear when printed. Because monitors can only show a
certain number of colors at a time, the colors may be
dithered. This dithering will be on your monitor only - when
printed, it will appear as a solid color.

The Solid swatch shows the closest solid color your monitor
would pick with its current settings. If your monitor is set to
display 16 colors, the monitor would pick the closest match
to the Color swatch from 16 colors. If your monitor is set to
display 256 colors, the closest match to the Color swatch
from those colors would be picked. If your monitor can
display more colors, the Solid swatch may match the Color
swatch exactly.

If you double-click on the Solid swatch, your color will
automatically be changed to that color.

Click OK to change the color of your backdrop or
text or click Cancel to return to the badge without
changing the color.

 NOTE
Monitors use red, green, and
blue light to create the colors
that you see. Most color
printing devices use cyan,
magenta, yellow, and black
to create colors. You may
need to experiment with
printing if you are trying to
match a color exactly. Keep
track of either the red/green/
blue values or the hue/
saturation/luminosity values
when testing because you
cannot save your custom
color to the palette.
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APPENDIX G:
SETTING UP A NETWORK

SERVER
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Following the steps in the sections below will assist you
in setting up a WIN-PAK network server. This guide is
based on running WIN-PAK with Windows for
Workgroups 3.11 using diskettes instead of a CD-ROM.
Special instructions for Windows ‘95 are provided as
notes and in the Windows ‘95 Network Setup section
(2b).

This guide assumes that the network card and network
card configurations are complete and functional to the
manufacturer’s specifications. It is also based on a first
time installation of WIN-PAK (no existing databases).

WIN-PAK requires the TCP/IP protocol to function
properly. Protocol version 3.11b used with Windows for
Workgroups 3.11 is supplied with WIN-PAK. Windows
’95 already has the TCP/IP protocol.

1. MODIFYING A UTOEXEC.BAT &
CONFIG.SYS FOR WINDOWS FOR WORKGROUPS

3.11 S YSTEMS

1. From the C:\ prompt type  EDIT AUTOEXEC.BAT
and press ENTER.

2. If the statement below does not exist, then add it
below the “SET PATH=” statement.

C:\WINDOWS\SMARTDRV.EXE_/X_1024_512

Note: The underscore ( _ ) in all statement examples
represent a space.

4. Now press the ALT key and then ENTER to
activate the drop down list. Press the letter “X”
then press the ENTER key. A message will appear
stating that the file is not saved – save it now.
Press ENTER and you will be at the C:\ prompt.

5. Type EDIT CONFIG.SYS and then press ENTER.

Window’s 95 Information is
given in the margin under
the above icon.

Window’s 95 users need
only to perform step 7.



Appendices 365

6. Locate the line DEVICE=C:\WINDOWS\HIMEM.SYS
If not present, add as the first line by placing the
cursor at the top and pressing ENTER to add a
new line.  Arrow up one line and type the
statement in.

7. Locate the line beginning with “Files=” and
update the command to allow for 250 files. The
line should read Files=250.

8. Locate the line
DEVICE=C:\WINDOWS\EMM386.EXE_NOEMS _X=D000-D3FF

may be  added in badging systems

If not present add this line just under
DEVICE=C:\WINDOWS\HIMEM.SYS by placing the
cursor at the line just under it and pressing
ENTER to add a new line.  Arrow up one line and
type the statement in.

9. Now press the ALT key and then ENTER to
activate the dropdown list. Press the letter “X”
then press the ENTER key. A message will appear
stating that the file is not saved – save it now.
Press ENTER and you will be at the C:\ prompt.

10. Turn off the computer for 5 seconds and then turn
it back on.

2.a.WINDOWS FOR WORKGROUPS 3.11
NETWORK SETUP

1. At the C:\ prompt type in WIN .

2. Open the Windows Setup by double-clicking it’s
icon located in the “Main” group.

3. Select Change Network Settings from the
Options menu.
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4. Click on the Networks button.  Verify that “Install
Microsoft Windows Network” and “No additional
network” options are selected.  If they are not,
select them.

5. Press OK to return to the “Network Setup” dialog
box.

6. Click on the Sharing button.

7. Select both file and printer sharing (mandatory on
the server, optional on the client ).

8. Click OK to return to the “Network Setup” dialog
box.

9. Click on the Drivers button.

10. Click Add Adapter.

11. Select the adapter card that is installed in your
computer and click OK.

12. Use “Interrupt Value” of 10 and click OK.

13. Base “I/O” is “280”. If so, click OK.

14. Base “Memory Address”  is “0xD400”. If so, click
OK.

15. Click the Add Protocol button and select Unlisted
or Updated Protocol.  Click OK.

16. Insert the WIN-PAK 1.12 Utility Disk into the A:
drive and click OK.

17. Select Microsoft TCP/IP-32 3.11b and press OK.
Windows now copies files and returns to the
“Network Drivers” window.

18. Select Microsoft TCP/IP-32 3.11b and click Setup.

19. ENTER a unique IP address on each of the
machines (i.e.  Server 1: 192.168.1.1, Client
192.168.1.2).  Use your arrow keys to move the
cursor to position.

 NOTE
The Interrupt value, Base I/O
and Base Memory Address
settings may vary with your
computer and the type of
card you have. Set them the
same as your adapter card.
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20. The Subnet Mask will default as 255.255.255.0.
Click OK.

21. Select Microsoft TCP/IP-32 3.11b and click Set as
Default Protocol.

22. Click Close.

23. Press OK button to continue to “Microsoft
Windows Network Names” dialog.

24. User name is NORTHERN COMPUTERS 1

25. Workgroup name is WINPAK

26. Computer name is WINPAKSERVER

27. Click OK.

28. You are now prompted to insert Microsoft
Windows for Workgroups Disk#5.

 2.b.WINDOWS ‘95 NETWORK
SETUP

1. After Windows ’95 is started click on the Start
button. Within the Windows ’95 main menu,
navigate to Settings }}}}} Control Panel. When you
are in the Control Panel, double click on the
Network icon.

2. Click on Add, Protocol, Add. Then select Microsoft
as the Manufacturer and TCP/IP as the network
protocol and click Ok.

3. Click on File and  Printer Sharing.

4. Enable both access options to allow access to both
your files, and your printer, and click Ok.

 NOTE
If a previous or other network
is already in use, you may
not be prompted for the
disks.
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5. Highlight TCP/IP.

6. Click the Properties button.

7. In the IP Address tab, enable the Specify IP address
option.

8. Enter a unique IP address on each of the computers
in your network (i.e.  Server 1: 192.168.1.1,
Client 1: 192.168.1.2).  Use your arrow keys to
move cursor to position.

9. Set the Subnet Mask at 255.255.255.0 and click
Ok.

10. Click on the “Identification” tab.

11. For Computer Name type in WINPAKSERVER.

12. For Workgroup type in WINPAK.

13. For Computer Description type in NORTHERN
COMPUTERS 1.

14. Click Ok.

15. Insert disk(s) for Windows ’95 as prompted.

16. Click Yes to restart the computer.

17. After Windows ’95 is restarted, click on the Start
button. Within the Windows ’95 main menu,
navigate to Settings }}}}} Control Panel. When you
are in the Control Panel, double click on the
Network icon.

18. Select the IPX/SPX protocol and click Remove.

19. Select the Client for Netware Networks protocol
and click Remove.  (if not listed go to next step)

20. Click on Ok.

21. Click Yes to restart the computer.
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3. SWAP FILE SETTING
1. Open the Control Panel by double-clicking it’s icon

in the Program Manager’s “Main” group.

2. Double-click the 386 Enhanced icon.

3. Click Virtual Memory.

4. Click Change.

5. In the “New Swapfile Settings” area, change the
“New Size” to  4096KB.

6. Select Permanent from the “Type” dropdown list if
possible.

7. Click OK. Click on the Restart Windows button so
the changes will take affect.

8. Once Windows starts up, it will ask you for a
password. You can either enter a password for
your use or click OK without entering a password.
Refer to your Windows manual for password
information.

4. WIN-PAK SERVER INSTALLATION
1. From the Program Manager, select Run from the

File menu.

2. Insert WIN-PAK installation disk #1 in A: (3 1/2”
drive).

3. In the “Command Line” box type A:SETUP.

4. Click OK.

5. Click OK to the “Northern Computers WIN-PAK
Setup” window.

6. Select “Server” and click OK.

 WINDOWS 3.11 NOTE
Northern requires that you
do not exceed a swap file
setting of 4096KB. If more
“memory” is needed, install
additional RAM modules.

Exceeding the swap file
setting may cause the
computer to lock up.

This is not a requirement
for Windows ‘95.
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7. Select appropriate answer to “Multiport Board”
option.

8. Select appropriate answer to “485 ACK/NAK Dial-
In” loops.

9. Select appropriate answer to video capture card
option.

10. Select appropriate answer to badge printer if used.

11. Select appropriate answer to “Signature Capture”
option.

12. Click OK to “Select WIN-PAK Directory”.

13. Enter registration information for the user and
company.

14. Select “No” to “Alarm Printing” and click OK.
Installation will begin and several files will be
copied.

15. You will be prompted to “Insert New Disk” as
required for the balance of the installation.

16. Click OK to the final “Northern Computers WIN-
PAK Setup”.

17. Click on OK to restart the computer in the “Install”
window. WIN-PAK will restart Windows for you.

 NOTE
WIN-PAK may require the
computer to be rebooted
(exit Windows, turn the
computer off for a few
seconds, turn it back on,
and re-enter Windows).
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 NOTE
You may wish to register
WIN-PAK at a later time. You
will have full functionality of
the program, but until you
register you will continue to
see the registration prompt
and will not be notified of
future upgrades in the
software.

5. SETTING WIN-PAK SERVER FOR
SHARING

1. Open File Manager by double-clicking its icon in
the Main group window.

2. In File Manager, select Share As from the Disk
menu.

3. The Share As directory box appears. In the path
box type C:\WINPAK  then click in the circle for
“FULL” to allow full access type.

4. Click OK. You should see a hand under the shared
directory in File Manager.

5. Close File Manager and select Exit Windows from
the File menu in the Program Manager.

6. Click OK to “...end your Windows session”.

7. When the C:\ appears, type “WIN” to restart
Windows.

14. Click on the Setup bar to change the 4 keys below
it to open keys allowing access.

Continue programming your system as explained in
the Quick Start and Database sections of the manual.

6. CONNECTING WIN-PAK CLIENTS TO
THE WIN-PAK SERVER

1. After the WIN-PAK client is configured (see
Appendix H), connect the LAN cable between the
server and the client.  If more than one client is
being used, connect those clients as well.  One
LAN-TERM should be used at each end of the
network (terminating the “T” connector).

Right-click on the Start
button and click Explorer in
Windows ’95. When
Explorer is open, right-click
on your C:\WINPAK
subdirectory and select
Sharing... from the menu.
Enable the Shared As option
and change the Access Type
to Full.
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2. While WIN-PAK is running at the server, start
WIN-PAK at the client.

3. When the client comes online, the client’s name will
appear in the “Alarm Monitor” History View as a
logon and in the Mail Screen as a “User.”

7. SHUTTING OFF WIN-PAK SERVER AND
THE COMPUTER

1. Verify that the WIN-PAK client is logged off.  Then
proceed with the following steps at the server.

2. Select Exit from the File menu.

3. Select the Shutdown option with or without
buffering as needed.

4. Click Shut Down.

5. From the Windows Program Manager, select Exit
Windows in the File menu.

6. Click OK to the prompt to “...end your Windows
session”.

7. When the DOS screen appears (C:\), you may
power down the computer and monitor.
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APPENDIX H:
SETTING UP A NETWORK

CLIENT
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Following the steps in the sections below will assist you in
setting up a WIN-PAK network client. This guide is based
on running WIN-PAK with Windows for Workgroups 3.11
using diskettes instead of CD-ROM. Special instructions
for Windows ‘95 are provided as notes and in the
Windows ‘95 Network Setup section (2b).

This guide assumes that the network card and network
card configurations are complete and functional to the
manufacturer’s specifications and that the WIN-PAK
Server is on the D:\ drive.

WIN-PAK requires the TCP/IP protocol to function
properly. Protocol version 3.11b used with Windows for
Workgroups 3.11 is supplied with WIN-PAK. Windows
’95 already has the TCP/IP protocol.

1. MODIFYING A UTOEXEC.BAT &
CONFIG.SYS FOR A WINDOWS FOR WORKGROUPS

3.11 S YSTEM

1. From the C:\ prompt type  EDIT AUTOEXEC.BAT
then press ENTER.

2. If the statement below does not exist, add it below
the statement that says SET PATH=etc... :

C:\WINDOWS\SMARTDRV.EXE_/X_1024_512

Note: The underscore ( _ ) in all statement examples
represent a space.

4. Now press the ALT key and then ENTER to
activate the dropdown list. Press the letter “X” and
then ENTER. A message will appear stating that
the file is not saved – save it now.  Press ENTER
and you will be at the C:\ prompt.

5. Type EDIT CONFIG.SYS and then press ENTER.

Window’s 95 Information is
given in the margin under
the above icon.

Section 1 is not required for
Windows ’95.
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6. Locate the line DEVICE=C:\WINDOWS\HIMEM.SYS.
If not present, add it as the first line by placing the
cursor at the top and pressing ENTER to add a
new line.  Arrow up one line and type the
statement in.

7. Next locate the line
DEVICE=C:\WINDOWS\EMM386.EXE NOEMS _X=D000-D3FF

may be  added in
badging systems

If not present add this line just under
DEVICE=C:\WINDOWS\HIMEM.SYS by placing the
cursor at the line just under it and press ENTER to
add a new line.  Arrow up one line and type the
statement in.

8. Now press the ALT key and then ENTER to
activate the drop down list. Press the letter “X”
and the ENTER key. A message will appear stating
that the file is not saved – save it now.  Press
ENTER and you will be at the C:\ prompt.

9. Turn off the computer for 5 seconds and then turn
it back on.

2.a.WINDOWS FOR WORKGROUPS 3.11
NETWORK SETUP

1. At the C:\ prompt type WIN to start Windows.

2. Open the Windows Setup by double-clicking on its
icon located in the “Main” group.

3. Select Change Network Settings from the
Options menu.

4. Click Networks button.  Verify that “Install
Microsoft Windows Network” and “No additional
network” options are both selected.  If not, select
them.
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5. Click OK to return to “Network Setup” dialog box.

6. Click Sharing button.

7. Select both file and printer sharing (mandatory on
the server, optional on the client ).

8. Click OK to return to the “Network Setup” dialog
box.

9. Click Drivers button.

10. Click Add Adapter.

11. Select the adapter card for your computer and
click OK.

12. Enter an Interrupt Value of “10” and click OK.

13. The Base I/O should be “280”. If so click OK.

14. The Base Memory Address should be “0xD400”. If
so click OK.

15. Click the Add Protocol button and select Unlisted
or Updated Protocol.  Click OK.

16. Insert TCP/IP floppy (utility disk of WIN-PAK) into
the A: drive and click OK.

17. Select Microsoft TCP/IP-32 3.11b and press OK.
Windows now copies files and returns to the
“Network Drivers” window.

18. Select Microsoft TCP/IP-32 3.11b and click Setup.

19. ENTER a unique IP address on each of the
machines (i.e.  Server 1: 192.168.1.1, Client
192.168.1.2).  Use your arrow keys to move cursor
to position.

20. The Subnet Mask will default as 255.255.255.0.
Click OK.

21. Select Microsoft TCP/IP-32 3.11b and click Set as
Default Protocol.

 NOTE
The Interrupt value, Base I/O
and Base Memory Address
settings may vary with your
computer and the type of
card you have. Set them the
same as your adapter card.
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22. Click Close.

23. Click OK button to continue to “Microsoft
Windows Network Names” dialog.

24. The User name is NORTHERN COMPUTERS 2 (if
more than one client is being used, increment
from 2 to 3 etc...).

25. The Workgroup name is WINPAK.

26. Computer name is WINPAKCLIENT1 (if more than
one client is being used, increment from 2 to 3
etc...).

27. Click OK.

28. You will now be prompted to insert Microsoft
Windows for Workgroups Disk#5.

 2.b.WINDOWS ‘95 NETWORK
SETUP

1. After Windows ’95 is started click on the Start
button. Within the Windows ’95 main menu,
navigate to Settings }}}}} Control Panel. When you
are in the Control Panel, double click on the
Network icon.

2. Click on Add, Protocol, Add. Then select Microsoft
as the Manufacturer and TCP/IP as the network
protocol and click Ok.

3. Click on File and  Printer Sharing.

4. Enable both access options to allow access to both
your files, and your printer, and click Ok.

5. Select TCP/IP.
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6. Click the Properties button.

7. In the IP Address tab, enable the Specify IP address
option.

8. Enter a unique IP address on each of the computers
in your network (i.e.  Server 1: 192.168.1.1,
Client 1: 192.168.1.2).  Use your arrow keys to
move cursor to position.

9. Set the Subnet Mask at 255.255.255.0 and click
Ok.

10. Click on the “Identification” tab.

11. For Computer Name type in WINPAKCLIENT1 (if
more than one client is being used, increment the
name number starting with WINPAKCLIENT2).

12. For Workgroup type in WINPAK.

13. For Computer Description type in NORTHERN
COMPUTERS 2 (if more than one client is being
used, increment the description number starting
with NORTHERN COMPUTERS 3).

14. Click Ok.

15. Insert disk(s) for Windows ’95 as prompted.

16. Click Yes to restart the computer.

17. After Windows ’95 is restarted, click on the Start
button. Within the Windows ’95 main menu,
navigate to Settings }}}}} Control Panel. When you
are in the Control Panel, double click on the
Network icon.

18. Select the IPX/SPX protocol and click Remove.

19. Select the Client for Netware Networks protocol
and click Remove.  (if not listed go to next step)

20. Click on Ok.

21. Click Yes to restart the computer.
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3. SWAP FILE SETTING
1. Open the Control Panel by double-clicking its icon

in the “Main” group in the Program Manager.

2. Double-click the “Enhanced” icon.

3. Click the Virtual Memory button.

4. Click the Change button.

5. In the “New Swapfile Settings” area, change the
“New Size” to  4096.

6. Select Permanent in the “Type” dropdown list.

7. Click OK, and then click on the Restart Windows
button so the changes will take effect.

8. Once Windows starts up, it will ask you for a
password. You can either enter a password for
your use or click OK without entering a password.
Refer to your Windows manual for password
information.

4. WIN-PAK INSTALLATION (CLIENT)
1. From the Program Manager, select Run from the

File menu.

2. Insert WIN-PAK installation disk #1 in A: (3 1/2”
drive).

3. In the “Command Line” box type A:SETUP.

4. Click OK.

5. Click OK to the “Northern Computers WIN-PAK
Setup” window.

6. Select “Client” and click OK.

 WINDOWS 3.11 NOTE
Northern requires that you
do not exceed a swap file
setting of 4096KB. If more
“memory” is needed, install
additional RAM modules.

Exceeding the swap file
setting may cause the
computer to lock up.

This is not a requirement
for Windows ‘95.
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7. Select appropriate answer to video capture card
option.

8. Select appropriate answer to badge printer if used.

9. Select appropriate answer to “Signature Capture”
option.

10. Click OK to “Select WIN-PAK Directory”.

11. Select the D: drive from the drop-down list.

12. In the “Database Directory” box, type
D:\DATABASE and click OK.

13. Enter registration information for the user and
company.

14. For “Server Name:” type in WINPAKSERVER
(name of server machine) and click OK or IP
address (used mostly for dial-up networks).

15. Enter 2 (3,4,5... if more than 1 client is used) for
the “Client ID:” and click OK. This must be
numeric (no alphabetical characters).

16. Click and drag across the “C:\” in the “ Select
Image Directory” box and type D:\DATA (path to
where the images are located) and click OK.

17. Select No to Alarm printing and click OK.
Installation will begin and several files will be
copied.

18. You will be prompted to “Insert New Disk.”

19. Click OK to the final “Northern Computers WIN-
PAK Setup.”

20. Click on OK to restart the computer in the “Install”
window. WIN-PAK may restart Windows for you.
If so, remember to log in using the SYSTEM
operator and “startup” for the password.



Appendices 381

APPENDIX I:
SYSTEM WORKSHEETS
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SETUP WORKSHEET

Card Digits:

Send Command File & Switch Cameras Clear Alarm State

Operator Actions

Muster Report Options

Card Limiting

5 digits

on Acknowledge Normal Only

Log Actions

Initialize with History Data

Activation & Deactivation by Scheduler

12 digits

on Receive Alarm or Normal

Lockout Operator after invalid login

Number of Hours to Retrieve: _____

Invalid Attempts Allowed:

# of Min. to Lock Out:

Expiration by Panel Hardware

Limited Use

Alarm Monitoring

Alarm Acknowledge

Ack. Priorities Less Than or Equal to: _____

Auto Card Lookup Priorities Less Than: _____

1 PER SYSTEM (Setup Worksheet 1 of 3)(Options)
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Enable Modem Baud Rate Modem Init. Modem Phone #Port Name

SETUP WORKSHEET 1 PER SYSTEM (Setup Worksheet 2 of 3)(Serial Ports)

XX1

DigiPort 17

XX2

DigiPort 18

XX3

DigiPort 19

XX4

DigiPort 20

XX5

DigiPort 21

XX6

DigiPort 22

XX7

DigiPort 23

XX8

DigiPort 24

XX9

DigiPort 25

XX10

DigiPort 26

XX11

DigiPort 27

XX12

DigiPort 28

XX13

DigiPort 29

XX14

DigiPort 30
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DigiPort 31

XX16

DigiPort 32
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SETUP WORKSHEET

Field # Field #

Note 1 Note 14

Note 2 Note 15

Note 3 Note 16

Note 4 Note 17

Note 5 Note 18

Note 6 Note 19

Note 7 Note 20

Note 8 Note 21

Note 9 Note 22

Note 10 Note 23

Note 11 Note 24

Note 12 Note 25

Note 13

Field Name Label Field Name Label

(Note Fields) 1 PER SYSTEM (Setup Worksheet 3 of 3)
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TIMEZONE WORKSHEET 1 TIMEZONE GROUP PER PAGE

Timezone Name:

HoSuSaFrThWeTuMoEnd TimeStart Time

DENOTING TIME IN WIN-PAK
Time in WIN-PAK is always displayed in what we consider a “normal” time format (i.e. 1:30pm,
7:00am, etc...). However, time can be ENTERED in two ways, normal time format or 24-hour time
format. To enter a time in normal format, simply type in the time:

(it is important that you remember to include a space between the time and
am/pm).

Because WIN-PAK also accepts 24-hour time input, if you fail to include an am/pm distinction, the
program will assume am. To enter a time in 24-hour format, simply type in the time:

(it is important that you use a colon to separate hours and minutes).

Your entry will be displayed in normal time when you hit .

1:35 am

13:15

Enter

Note:
Remember that you cannot cross midnight.
One line should be used to define the P.M.
ending time, and the next line should
define the A.M. time.
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AREAS WORKSHEET

Area Name:

Loop

Local

C-100
485
485 ACK-NAK

Other

TYPE:

STYLE:

COMMUNICATIONS:

Camera Control

Parity:COM Port:

Data Bits:Baud Rate:

Stop Bits:

Phone:

Remote

CCTV Brand

Unknown

HUB SETUP

Number of Redial Attempts: ____

Pause Between Calls: ____ sec

Wait Time Before Disconnect: ____ sec

Modem Initialize: ____________

Dial Command Prefix: ____________

Call In Option: On invalid transaction Never

Verify Communications

1 AREA PER PAGE
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PANEL WORKSHEET

Panel Name:

Loop (Area):

Command File:

Site Codes

System Hardware Alarms (all versions)

Hardware Options

Antipassback

Forgiveness

Free Egress

Split Timezones
(version 8.xx firmware only)

Keypads

PIN Numbers

Reverse Reader LEDs

AEP-5

ERB

AEP-3

AEP-3

Continuous Card Reads

Groups

Type: Version:

Panel Address:

1 PANEL PER PAGE (1 of 7 Panel Worksheets)

Panel Communications

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

AUX Port

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

Panel Primary Power

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.
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PANEL WORKSHEET 1 PANEL PER PAGE (2 of 7 Panel Worksheets)

System Hardware Alarms (cont.)

Tamper Switch (N-1000-III & N-1000-IV only)

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

Ground Fault (N-1000-III & N-1000-IV only)

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

Low Voltage (N-1000-III & N-1000-IV only)

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

External 5 Volt (N-1000-III & N-1000-IV only)

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

Panel Reset (Available with version 8.2 firmware)(and later)

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.

Poll Response

Alarm State Priority

Alarm

Normal

Message Command File Print Hist.
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PANEL WORKSHEET 1 PANEL PER PAGE (3 of 7 Panel Worksheets)

Timezones (names from Timezone worksheets)
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READER WORKSHEET

Valid Reads

Invalid Reads

Panel Name: (not a database requirement)

Reader Name:

Monitor:

Priority

Priority

Normal

Timezone

Trace

Not Found

PIN

Site Code

Expired

Anti-Passbk

Message

Message

Command File

Command File

Print

Print

Hist.

Hist.

Camera:

Address:

1 READER PER PAGE (4 of 7 Panel Worksheets)

2 READERS PER N-1000 PANEL
(4 READERS PER N-1000-IV PANEL)
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INPUT POINT WORKSHEET

Alarm State

Panel Name:

Input Point Name:

Silence Alarms

Supervised
(Only on the N-1000-III
and N-1000-IV panels)

Interlocking

Monitor:

Priority

Alarm

Normal

Door Ajar

Trouble

Message Command File Print Hist.

Debounce Time: Shunt Time:sec. sec.

Camera:

Address:

Alarm Action Normal Action

Timezone:

1 INPUT POINT PER PAGE 5 of 7 Panel Worksheets)

Normally: Open Closed

Energize Energizeonly when Component B is an output only when Component B is an output

only when Component B is an output only when Component B is an output

only when Component B is an input only when Component B is an input

only when Component B is an input only when Component B is an input

De-Energize De-Energize

Shunt Shunt

Un-Shunt Un-Shunt

Pulse Pulse

Pulse Off Pulse Off

No Action No Action

Follow Follow

Invert Follow Invert Follow

Point:
(Component B)

Input to OUTPUT Input to INPUT

(not a database requirement)

16 INPUTS PER PANEL

Displays only if AEP-5 is selected or when using the N-1000-III or N-1000-IV panel.
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OUTPUT POINT WORKSHEET

Panel Name:

Output Point Name:

Interlocking

Pulse Time: sec.

Address:

Alarm Action Normal Action

1 OUTPUT POINT PER PAGE (6 of 7 Panel Worksheets)

Energize Energizeonly when Component B is an output only when Component B is an output

only when Component B is an output only when Component B is an output

only when Component B is an input only when Component B is an input

only when Component B is an input only when Component B is an input

De-Energize De-Energize

Shunt Shunt

Un-Shunt Un-Shunt

Pulse Pulse

Pulse Off Pulse Off

No Action No Action

Follow Follow

Invert Follow Invert Follow

Point:
(Component B)

Output to OUTPUT Output to INPUT

Timezone:

(not a database requirement)
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GROUP WORKSHEET

Panel Name:

Group Name:

Interlocking

Pulse Time: sec.

Address: 1_ _

Alarm Action Normal Action

1 GROUP PER PAGE (7 of 7 Panel Worksheets)

Energize Energizeonly when Component B is an output only when Component B is an output

only when Component B is an output only when Component B is an output

only when Component B is an input only when Component B is an input

only when Component B is an input only when Component B is an input

De-Energize De-Energize

Shunt Shunt

Un-Shunt Un-Shunt

Pulse Pulse

Pulse Off Pulse Off

No Action No Action

Follow Follow

Invert Follow Invert Follow

Point:
(Component B)

Output to OUTPUT Output to INPUT

Timezone:

Output Points

(not a database requirement)
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SCHEDULES WORKSHEET 1 SCHEDULE PER PAGE (1 of 1 Schedule Worksheet)

Schedule Name:

Remote Area Name:

Time of Day:

Panel Time & Date Update

Once

Every Hour

Every Day

Unbuffer

Send Commands

Auto Dial-Up

Every Week

Send Time & Date

Backup Reminder

Every Two Weeks

Every Month

Never

Card Activation & Deactivation

Type:

Frequency: Next Date/Time:
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GUARD TOURS WORKSHEET 1 GUARD TOUR PER PAGE (1 of 1 Guard Tour Worksheet)

Check Point Alarms

Priority

Early Arrival

Late Arrival

Message Command File Print Hist.

# Reader Name Time + –
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ACCESS LEVEL WORKSHEET

Access Level Name:

TimezoneReader Group

1 ACCESS LEVEL PER PAGE
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CARD WORKSHEET

Last Name:

Number: PIN:

Access Level:

Backdrop (front): _____________________________

Backdrop (back): _____________________________

First Name:

Activation Date: ___/___/___

Deactivation Date: ___/___/___

Expiration by

Hardware Date: ___/___/___ Number of Uses: ___
OROR

1 CARD PER PAGE

Valid Reads

Limited Use

Status

Invalid Reads

Priority

Priority

Normal

Timezone

Trace

Not Found

PIN

Site Code

Expired

Anti-Passbk

Message

Message

Command File

Command File

Print

Print

Hist.

Hist.

Note Fields

1 9 17

2 10 18

3 11 19

4 12 20

5 13 21

6 14 22

7 15 23

8 16 24

25

Active Lost or Stolen

Trace Inactive
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CAMERA WORKSHEET

Camera Name
Camera
Address Camera Title

19 CAMERAS PER PAGE
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HOLIDAY WORKSHEET

Holiday Name Holiday Date

19 HOLIDAYS PER PAGE
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MONITOR WORKSHEET

Monitor Name

19 MONITORS PER PAGE

Monitor
Address
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OPERATOR WORKSHEET

Operator Name:
Password:

Edit Edit

Edit

None None

None

File

Backup

Restore

Archive

Purge

Rebuild

Print Setup

Exit

Report

History Reports

Database Reports

Attendance

Setup

Options

Note Fields

Serial Ports

Edit None

Alarm Monitor

Alarm Info

Panel Cntl

Camera Cntl

Card Lookup

Mail

Muster Card
Deletion

Non-muster Card
Deletion

Display Card
Numbers

Display PIN
Numbers

Guard Tour View

Edit View None

Database

Timezones

Areas

Panels

Schedules

Guard Tours

Tracking Areas

Access Levels

Cards

Cameras

Holidays

Monitors

Operators

Floor Plans

Command Files

1 OPERATOR PER PAGE
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FLOOR PLAN WORKSHEET

Floor Plan Name:

Floor Plan File:

Attach Drawing
or Print Out
of Floor Plan

This floorplan is
attached as a hot
spot to:

Parent Floor Plan Name

Floor Plans

HOT
SPOTS

Input Points

1 FLOOR PLAN PER PAGE
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COMMAND FILE WORKSHEET
Command File Name:

Area:

1 COMMAND FILE PER PAGE

Commands

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18



Appendices 405

BACKDROP WORKSHEET

Backdrop Name:

1 BACKDROP PER PAGE

Sketch your badge backdrop ideas.

Elements that can be added are:
1. Photo(1) and Photo(2)
2. Bitmap
3. Text
4. Barcode
5. Shapes
6. Signature

Backdrops can be:
Single Color
Imported Bitmap
Captured Bitmap

o
o
o

m

m

m

IATA

ABA

TTS

m

m

m

IATA

ABA

TTS

m

m

m

IATA

ABA

TTS

Vertical

Height=

______

Width= ______

Width= ______ Horizontal

Print Area Margins
Width Height Left Right Top Bottom

LengthMagnetic Stripe

Track 1

Track 2

Track 3

Justify Fill Expression
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Index 411

Index
Symbols

12-digit cards  26
20 mA current loop  13
3-View Zoom Tool  286
485 ACK-NAK  59

password  61

A

Access Control
definition  7

Access Level  166
adding & editing  120–122
assigned to a card  126
defined  43, 119
deleting  122
report  305–306
Save As...  122

Access Level Database  119–122
defined  43
operator access to  166

Acknowledge  242, 246
button  242

Acknowledged Alarm Section  241
Activation & Deactivation by

Scheduler  26
Activation & Deactivation Date

127
Active Status  126
Add Button  50
AEP-3  73
AEP-5  73
Alarm

acknowledging  246
clearing  246–247
hot spot  249–250
polling  247
printing option  23

Alarm Acknowledge option  28
Alarm Info  169, 170

operator access to  169
Alarm Info Screen  250–252
Alarm Information

viewing  247
Alarm Input Point

defining  245–246
monitoring from floor plan  249–

250
Alarm Monitor Screen

31, 169, 237
operator access to  169

Anti-passback  70
Aperture (Camera)  266–267
Archive  319–320

operator access to  163
reporting history  293–294

Area
adding & editing  58–60
advanced commands  61–63
assigning panel to  68
defined  57
deleting  63
modem settings  60–61
remote phone  60
report  299–300
style  59
type  59

Area Database  57–63
defined  43
operator access to  165

Attendance Report  314–315
operator access to  168

Auto Card Lookup  28
Auto Dial-Up  99
Auto-answer/Auto-dial Modems

14

AUTOEXEC.BAT
example of  328

AUX Port Failure (Alarm)  75

B

Backdrop  167
Backup  322–323

operator access to  163
Backup Reminder  99
Badge

printing  147–152
Badge Backdrop. See Badge

Layout Utility
Badge Background

bitmap graphic  201–203
creating tips  201
erasing  203
orientation  203

capturing  195
creating single color  193–194

Badge Elements
adding  204
layering  206
moving  205–206
resizing  205

Badge Layout
assigning to card  146–147
closing  191
copying  191–192
creating new  189–190
deleting  192
opening  190
printing  232–233
renaming  191
saving  191

Badge Layout Utility
accessing  23, 189
description  189

Index
The page numbers listed in this Index match the page numbers in this document. Use  the GO TO feature in the VIEW menu to move quickly to the desired page. 
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Badge Photo  134
capturing  135
compression  136, 197, 199
importing  141–143
Primary/Secondary  135

Badge Text
adding  208
alignment  213
background color  212
changing the font  209–210
deleting  214
editing contents  208–209
foreground color  211
justification  212
orientation  213–214
resizing  211
transparent background  212

Barcode (Badge)
adding  219–220
background color  221–222
deleting  222
editing  220–221

Baud Rate  35
setting area  60

Buffer  33
panels  253
remote panels  257

C

C-100-A  13
Call In Option  62
Camera  166

adding & editing  153–154
control arrows  267
controlling  265
deleting  154
home position  268–269
pan & tilt  267
pan & tilt limits  268
report  310–311

switching option  27
title  154

Camera Control  170, 171
operator access to  170

Camera Database  153–154
defined  44
operator access to  166

Capture Image  135–140
Capture Signature  144–145
Card

adding & editing  124–126
Badge Screen  134
Cards Screen  125–128
Notes Screen  132–134

command file  130
deleting  152
digits  68–69
invalid reads  129
locate  276–278
message  130
number  126

operator access to  170–171
priority  130
report  306–310

with notes  308–310
without notes  307–315

search  273–274
status  126
valid reads  129

Card Activation & Deactivation  99
Card Database  123–152

defined  44
operator access to  166

Card Information
viewing  243

Card Limiting  26
Card Lookup  171

automatic  275–276
operator access to  170

Card Lookup Screen  272–275
Cards  166

initialize option  254

Check Digit (Barcode)  221
Check Points  105

alarms  106
Clearing  246–247

alarm or card read  242–243
Client

setting up  373–380
Close Button  51
Color

custom for badges  359–361
Command File  167

adding & editing  184–185
assigned to a card status  130
assigning to a panel  69
deleting  185
initialize option  255
input point  90, 107–118
reader  84
report  313–315
sending  255–256
sending option  27
system alarms  77

Command File Database
183, 183–185

defined  45
operator access to  167

Communications (area)  63
Computer Eyes 1024  136–

138, 196–197
Computer requirements  11–12
CONFIG.SYS

example of  329
Connect (Remote Panel)  256
Continuous Card Reads Option

72–73
Controlling Cameras  265
Controlling Panels  253
Convert Utility  353–358
Converters  13
Create (Databases)  325–326
Current View  240–243
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D

Daily Option  291
Data List  48
Database

create  325–326
pack  326
rebuild  325
reindex  326
repair  326
system  346

Database Control Window  48–55
Database Reports  168, 298–315

operator access to  167
DataCard  151–152
DataCard ImageCard  147
Date & Time

remote panel  256
De-Energize  258

interlock option  335
Debounce Time  87
Delete Button  50
Dial Command Prefix  62
Disconnect (Remote Panel)  257
Disk Drives  12
Door Ajar status  89

E

Edit Button  50
Edit Privilege  162
Elevator Control  339
Energize  258

interlock option  335
ERB  73
Exit

operator access to  164
Exit Area  114–115
Expiration by Panel Hardware  26
Expiration Date  127
External 5 Volt (Alarm)  76

F

Fargo  147, 151–152
Floor Plan  175, 179, 181

adding & editing  174–181
deleting  182
hot spot  249

Floor Plan Database  173, 173–
182

defined  45
operator access to  167

Floor Plan Graphic
selecting  175–176
tips on creating  181–182

Floor Plan View  248–250
Focus (Camera)  266
Folders  49
Follow

interlock option  335
Font (Badge)  210
Font Style (Badge)  210
Forgiveness  70
Free Egress  70–71
Freeze

badge photos  135, 195
history view  238

G

Graphic (Badge)
adding  217–218
deleting  219
editing  218–219
importing for badge layouts

192–193
orientation  219

Grid (Badging)  206–207
Ground Fault (Alarm)  76
Group

assigning to a panel  95–96
assigning to an access level

121–122

enabling  73
initialize option  255

Guard Tour
adding & editing  104–107
deleting  107

Guard Tour View
operator access to  171

Guard Tours Database  103–107
operator access to  165

H

Hardware Alarms  75–78
Help  24
History

card status in  131
History Files

input point status  90, 107–118
reader status  84
system alarms  77–78

History Report  167, 289–298
archived history  293–294
by card criteria  295–296
by operator criteria  297–298
by point criteria  296–297
operator access to  167

History View  237–239
Holiday  166

adding & editing  156
deleting  156–157
initialize option  255
report  311
selecting in a timezone  54

Holiday Database  155–157
operator access to  166

Holidays Database
defined  45

Home Position (Camera)  268–269
Hot Spot  176, 179

creating  176–179
defined  176
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defining for alarm points  176–
179

deleting  179
floorplan  179–181, 249

Hot Spot Detail Window  177

I

Icons  23
Import Photo  141–143
Import Signature  145–146
Importing a Graphic  192–193
In Box (Mail)  279
Inactive Status  126
Incoming Alarm Section  240–241
Initialize Option  254–280
Input Point  173

address  86
alarm states  89
assigning CCTV equipment  87–

88
controlling  258
initialize option  255
interlocking  88
supervised  86

Installing  19–24
type of  19–20

Integral Technologies Flashpoint
138–140, 198–199

Interlocking  331–337
examples  336–337
input point  88
output point  94–95

Intialization (Panel)  254–255
Invalid Reads

assigned to a card  129
Invert Follow

interlock option  335
IRQ

multi-port hardware  37

K

Keep Aspect Ratio  216, 218
Keypads

enabling matrix style  72

L

Layering (Badge)  206
Leased-line Modems  14
Limited Use  26, 126–128, 128
Live Camera View  270–271
Locate Tool  243, 276–278
Lock Out Operator  29
Log Actions option  29
Login  31, 32
Lost or Stolen Status  126
Low Voltage (Alarm)  76

M

M-200  14
M-300  14
M-9600-2  14
Magnetic Stripe

editing  230–232
how defined  229–230
printing  150

Magnetic Stripe Encoding  228–
232

Mail
operator access to  170
send a message  280

Mail Screen  279–280
Main Screen Privileges

169, 169–171
Maintenance  317–326
Message

assigned to a card status  130
input point  89, 107–118
reader  83
system alarms  77

Microsoft Windows  13

MIP. See Multiple Interlock
Protection

Modem Initialize  62
Modems  14
Monitor  12, 166

adding & editing  159
deleting  159
report  311–312

Monitor Database  158–159
defined  45
operator access to  166

Monitor View  244–247
Mouse  12
Multi-port hardware

setup  35
Multiple Interlock Protection  74
Muster

system precautions  110–
113, 116–118

Muster Area  115–116
Muster Area Report  262
Muster Card Deletion

operator access to  170
Muster Report

operator access to  169
options  29

Muster Screen  260–264

N

N-485-PCI-2  13–14
Nesting  Areas  116–118
Network  169
Network Client. See Client
Network Server. See Server
No Action

interlock option  335
Non-Muster Card Deletion  170
None Privilege  162
Note Field  168

assigning data to  132–134
setup  38
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Note Field Setup
operator access to  168

O

Operator  166
adding & editing  160–162
deleting  171
password  161–162

Operator Database  160–171
defined  45
operator access to  166

Operator Privileges  162–
171, 163–164, 164–167

changing SYSTEM  31
Options Setup  25–29

operator access to  168
Orientation

badge background  203
badge graphic  219
badge photo placeholder  216

Out Box (Mail)  279
Output Point

address  93
assigning to a panel  91–95
controlling  258–259
initialize option  255
interlocking  94–95
pulse time  92

P

Pack (Database)  326
Pan (Camera)  267
Pan Limit  268
Panel

adding & editing  66–67
Groups Screen  95–96
Input Points Screen  85–88
Output Points Screen  91–95
Panel Screen  67–70
Readers Screen  80–85
Timezone Screen  78–80

address  68
buffer & unbuffer  253
command file  69
controlling  253
deleting  96
enabling options  70–73
Hardware Options  73
initializing  254–255
report  300–302
status  69–70
system alarms  75–78
type  68
version  69

Panel Communications (Alarm)
75

Panel Control
operator access to  169

Panel Control Screen  252–259
Panel Database  65–97

defined  43
operator access to  165

Panel Primary Power (Alarm)  75
Panel Reset (Alarm)  76
Panel Time & Date Update  99
Parallel Printer  13
Password  31, 32

assigning to an operator  161–
162

Pause Between Calls  62
PC-PAK

to WIN-PAK conversion
24, 353–358

Photo. See Badge Photo
Photo Placeholder (Badge)

adding  215
deleting  216–217
editing  215–216
orientation  216

Photo View Options  274–275
PIN  72, 83, 126

operator access to  171
Poll Response (Alarm)  76

Polling  247
Port address

multiport hardware  37
Power Fail Reroute  74
Pre-Installation System Setup

327–329
Print

alarms  23
badge  147–152
badge layout  232–233
card status  131
input point status  90, 107
reader status  84
reports  287
system alarms  77

Print Setup
operator access to  164

Printable Area Size (Badge)  190
Printer

setup  39
Printer Layouts  148–150
Priority

assigned to a card status  130
input point  89, 106–118
reader  83
system alarms  76–77

Privileges  51
Pulse  92, 258

interlock option  335
Pulse Off

interlock option  335
Purge  321

operator access to  163

R

Ratios (Barcode)  221
Re-Index  326
Reader

address  81
assigning CCTV equipment  81–

82
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assigning to an access level
120

assigning to panel  80–85
Invalid Reads  82–83
Valid Reads  82

Rebuild  325
operator access to  164

Redial Attempts  61
Registration  30–31
Remote

setting area as  59
Remote Panels

controlling  256–258
Repair (Database)  326
Report

exporting  287
viewing  285–288

Report Privileges  167, 167–168
Reports  167
Restore  323–324

operator access to  163
Restore to TZ (Timezone)

258, 259
Reverse reader LEDs option  72
RS-232  13

S

Schedules Database  99–102
defined  44
operator access to  165

Search Tool  49
Send Commands  257
Serial Communication Boards  12–

13
Serial Port

defining area for  59
setup  34–37, 35

Serial Port Setup
operator access to  168–169

Server
setting up  363–372

Setup
communications  27–28
muster reporting  29
note fields  38
operator  29
printer  39
serial ports  34–37

Setup Menu
operator access to  168

Setup Privileges  168, 168–169
Shape (Badge)

adding  222–225
deleting  225
editing  223–225

Shunt  87, 258
interlock option  335

Signature
capture  144–145
importing  145–146

Signature Placeholder (Badge)
adding  225–226
deleting  227
editing  226–227

Silence Alarms option  87
Site Codes  73
Site ID (Remote)  60
Sort Order  49
Spacer (Barcode)  221
Split Timezones  72
Status Line  51
System Alarms  75–78
System Setup

Pre-Installation  18
System Worksheets  381
SYSTEM.INI  329

T

Tamper Switch (Alarm)  76
Technical Information  345–346
Text

adding to badge  208

Tilt (Camera)  267
Tilt Limit  268
Time & Date

initialize option  254
Time Block

deleting  55
Timezone  165

adding & editing  53–55
assigning to an access level

121
assigning to panel  78–80
defined  43, 52
defining a shunt time  87
deleting  55
energizing an output  92
initialize option  255
report  298–299

Timezone Database  52–55
defined  43
operator access to  165

Trace Status  126
Tracking Area  115

adding & editing  113–116
Tracking Areas Database  109–118

defined  44
operator access to  165

Trouble Status  89
TWAIN Compatible Board  200
TWAIN Compatible Interface  140–

141

U

Un-Install  24
Un-Shunt  258

interlock option  335
Unbuffer  33

remote panel  256
Unbuffer Panels  253
Unknown

defining area as  59
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V

Valid Reads
assigned to a card  129

Verify  32
Verify Communication  62
VideoBlaster  136
View Button  51
View Privilege  162–163

W

Wait Time Before Disconnect  61
WIN-PAK  8
WIN.INI  329
Windows Options (Badging)  233
WINPAK1.INI

example of  348–352, 351–352

Z

Zoom (Camera)  267
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